IE Web Site Script: Technology Literacy Curriculum: Explain with Technology 
(Script 2 of 4)
Make Decisions with Data
Rev. 1.0
September, 2008
Table of Contents

4Stakeholder/Approval (prior to CMS)


4Script Creation, Review and Approval Process


4Stakeholders


5Information Design


9Explain with Technology


11Make Decisions with Data


13Decision Making


14Checklist


16Rubric


19Thinking Skills


20Vocabulary


21Exploration


Information

Task

25Quiz


27Survey Data


28Vocabulary


Exploration

Information

Survey Data and Percentages

34Task


Quiz

37Decision Definition


38Vocabulary


Exploration

40Information


42Types of Questions


Task

Quiz

47Information Gathering


48Vocabulary


49Exploration


50Information


52Keyword Search Strategies


53Note-Taking Strategies


Task

Quiz

57Decision Alternatives


58Vocabulary


59Exploration


60Information


Task

Quiz

64Look Back


64Checklist


66Rubric


68Reflection


69Data Collection


70Checklist


72Rubric


75Survey Questions


76Vocabulary


77Exploration


78Information


79Task


81Quiz


83Survey Administration


84Vocabulary


85Exploration


86Information


88Task


89Quiz


91Database Basics


92Vocabulary


93Exploration


94Information


96Review Spreadsheet Basics


98Task


99Quiz


101Database Planning


102Vocabulary


103Exploration


103Information


105Task


107Quiz


108Database Tables


109Vocabulary


110Exploration


111Information


113Task


114Quiz


115Look Back


115Checklist


117Rubric


119Reflection


120Data Analysis


121Checklist


123Rubric


126Database Forms


127Vocabulary


128Exploration


129Information


131Task


132Quiz


134Database Queries


135Vocabulary


136Exploration


137Information


138Task


140Quiz


142Decision Possibilities


143Vocabulary


144Exploration


145Information


146Using Formulas and Functions


148Task


149Quiz


151Data Visualization


152Vocabulary


153Exploration


154Information


156Types of Charts


158Task


159Quiz


161Decision Choice


162Vocabulary


163Exploration


163Information


165Format a Spreadsheet


166Task


168Quiz


170Look Back


170Checklist


172Rubric


174Reflection


176Expository Presentation


177Checklist


179Rubric


182Expository Nonfiction


183Vocabulary


184Exploration


184Information


186Expository Types


187Task


189Quiz


191Presentation Outline


192Vocabulary


193Exploration


194Information


195Task


196Quiz


198Presentation Design


199Vocabulary


200Exploration


201Information


203Presentation Application Basics


204Task


206Quiz


208Multimedia Management


209Vocabulary


210Exploration


211Information


213Multimedia File Formats


214Task


216Quiz


218Presentation Delivery


219Vocabulary


220Exploration


220Information


222Task


223Quiz


225Look Back


225Checklist


227Rubric


229Reflection




Stakeholder/Approval (prior to CMS)
Script Creation, Review and Approval Process

	Activity
	Date

	1. Initial revision (Rev 0.5) published on SharePoint

Add other notes in red.
	2/22/07

	2. Peer review completed


	2/22/07

	3. Other stakeholders review completed (agency)

	3/08/07

	4. Rev. 1.0 published and approved


	3/12/07

	5. Script moves into document change control
	10/07

	6. Revisions made and TLC re-released
	1/08


Stakeholders

[Capture all stakeholders and roles for the requirements document if available. These are the people who provided input into the content, but not necessarily the ones who make trade-off decisions.]

	Name
	Role
	Reviewed/Approved

	Jim Sweet, Stefanie Hausman
	Project Managers
	Reviewed

	Jim Sweet, ICT
	Lead Content Writer
	Reviewed

	CPS, Stefanie Hausman, Kristen Merrill, 
	Peer Reviewer
	Reviewed

	Mary Millhollon
	Editor
	Reviewed

	Laurye, Clampitt, Stefanie Hausman
	Final Reviewer in CMS
	Reviewed

	Anne Batey
	Intel Approver
	Approved

	
	Release and QA Manager
	Approved


Information Design

[Include a flowchart that shows the hierarchy of information and how it ties in to the existing site. Every page that’s new or changing should be represented on the flowchart.]

Level 1

Level 2


Level 3



Level 4
I. Explain with Technology

II. Make Decisions with Data (Level 1 Tab)
A Decision Making (Level 2 Tab)

Look Ahead (Related-link highlight box 1)

(1) Checklist (Leaf)

(2) Rubric (Leaf)

1. Thinking Skills (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)
Survey Data and Percentages (Related-link highlight box 1)

(1) Survey Data and Percentages (Leaf)

d. Task (Left-hand nav)
e. Quiz (Left hand-nav)
2. Survey Data (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)
d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
3. Decision Definition (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)

Types of Questions (Related-link highlight box 1)

(1) Types of Questions (Leaf)

d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
4. Information Gathering (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)

Keyword Search Strategies (Related-link highlight box 1)

(1) Keyword Search Strategies (Leaf)


Note-Taking Strategies (Related-link highlight box 1)

(2) Note-Taking Strategies (Leaf)

d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
5. Decision Alternatives (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)
d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
6. Look Back (Level 3 Tab, Left-hand nav)
a. Checklist(Left-hand nav)
b. Rubric (Left-hand nav)
c. Reflection (Left-hand nav)
B Data Collection (Level 2 Tab)

Look Ahead (Related-link highlight box 1)

(1) Checklist (Leaf)

(2) Rubric (Leaf)

1. Survey Questions (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)
d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
2. Survey Administration (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left hand-nav)
c. Information (Left-hand nav)
d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
3. Database Basics (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)

Review Spreadsheet Basics (Related-link highlight box 1)

(1) Review Spreadsheet Basics (Leaf)

d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
4. Database Planning (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)
d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
5. Database Tables (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)
d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
6. Look Back (Level 3 Tab, Left-hand nav)
a. Rubric (Left-hand nav)
b. Reflection (Left-hand nav)
C Data Analysis (Level 2 Tab)

Look Ahead (Related-link highlight box 1)

(1) Checklist (Leaf)

(2) Rubric (Leaf)

1. Database Forms (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)
d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
2. Database Queries (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)
d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
3. Decision Possibilities (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)

Using Formulas and Functions (Related-link highlight box 1)

(1) Using Formulas and Functions (Leaf)

d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
4. Data Visualization (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)

Types of Charts (Related-link highlight box 1)

(1) Types of Charts (Leaf)

d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
5. Decision Choice (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)

Format a Spreadsheet (Related-link highlight box 1)

(1) Format a Spreadsheet (Leaf)

d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
6. Look Back (Level 3 Tab, Left-hand nav)
a. Rubric (Left-hand nav)
b. Reflection (Left-hand nav)
D Expository Presentation (Level 2 Tab)

Look Ahead (Related-link highlight box 1)

(1) Checklist (Leaf)

(2) Rubric (Leaf)

1. Expository Nonfiction (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)

Expository Types (Related-link highlight box 1)

(1) Expository Types (Leaf)

d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
2. Presentation Outline (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)
d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
3. Presentation Design (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)

Presentation Application Basics (Related-link highlight box 1)

(1) Presentation Application Basics (Leaf)

d. Task (Left-hand nav)
e. Quiz(Left-hand nav)
4. Multimedia Management (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)

Multimedia File Formats (Related-link highlight box 1)

(1) Multimedia File Formats (Leaf)

d. Task (Left-hand nav)
e. Quiz (Left-hand nav)
5. Presentation Delivery (Level 3 Tab, Left-hand nav)
a. Vocabulary (Left-hand nav)
b. Exploration (Left-hand nav)
c. Information (Left-hand nav)
d. Task (Left hand-nav)
e. Quiz (Left-hand nav)
6. Look Back (Level 3 Tab, Left-hand nav)
a. Checklist (Left-hand nav)
b. Rubric (Left-hand nav)
c. Reflection (Left-hand nav)
	Title
	Explain with Technology

	Subtitle
	Expository Writing and Decision Making

	Type of Page 
	Table of Contents


[1st Level Tab names]

Tab 1: [Research, Write, Present]
Tab 2: [Make Decisions with Data]
Tab 3: [Teacher Guide]

Tab 4: [Parent Guide]
 [TOC QUOTE]

[“We live in a society exquisitely dependent on science and technology, in which hardly anyone knows anything about science and technology.” Carl Sagan]
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Title for Portal 4: [Parent Guide]
Explanation is description with understanding. Explain with Technology creates opportunities to engage students in learning with technology in any subject. Students research complex topics, write expository essays explaining their topics, and deliver multimedia presentations based on their expositions. Explain with Technology is designed to increase technology literacy and cultivate responsible digital citizenship as students learn the power of explanation.

Explain with Technology includes two projects designed to support sustained inquiry into big ideas in the core curriculum. Research, Write, Present enhances creativity and develops research and communication skills. Make Decisions with Data encourages collaboration and decision making while improving data analysis skills. Students may explore independently, but most students benefit more when they are guided by teachers and supported by parents.

Research, Write, Present >

Students research complex topics and write expository essays explaining their topics as objective observers. Then, students identify an audience for whom they design and deliver a multimedia presentation based on their expositions.

Make Decisions with Data >

Students research decisions about complex topics before collecting and analyzing opinion data on their topics. Then, students evaluate alternatives, make choices, and explain their decisions by designing and delivering multimedia presentations.

Teacher Guide >

Teachers plan innovative learning experiences in which students acquire technology literacy while exploring big ideas in the core curriculum. Teachers use research-based instructional strategies to facilitate student research, expository writing, decision making, and presentation.

Parent Guide >

Parents become familiar with the research, expository writing, decision making, and presentation skills that students learn in school. Parents encourage technology literacy by providing opportunities for students to share their learning and apply their new skills at home and in community.  
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Tab 1: [Decision Making]

Tab 2: [Data Collection]
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Project Overview

This project is about using technology for learning. It helps you develop the skills you need to use technology effectively. You can use these skills for the rest of your life. In this project, you first research a decision about a complex topic that interests you. Then, you collect and analyze data about the decision. Finally, you create and deliver a multimedia presentation to explain your decision to an audience.

In this project:

· Use critical thinking to define a decision about a complex topic

· Administer a survey and design a database for the results

· Use a spreadsheet application to analyze and represent data

· Deliver an interesting, informative, and entertaining multimedia presentation

Decision Making >

Do you know how to make decisions? Critical thinking can help you make important decisions about complex topics. Critical thinking requires the ability to look at a decision from multiple points of view. Critical thinkers define decisions precisely and gather accurate and reliable information from credible sources. They develop logical alternatives and evaluate possible consequences before they make decisions. Anyone can become an effective decision maker by learning some fundamental skills. Learn how to use critical thinking skills to make important decisions about complex topics.

Data Collection >

How can you evaluate alternative decisions? You developed alternatives by gathering and organizing factual information. Because almost all decisions affect someone, people’s opinions are important data too. You can collect data on opinions by writing and administering a survey. Your data collection may be useful both to you and other researchers and decision makers. A database application is a software program that specializes in storing and managing data for quick and easy retrieval. Learn how to use a database application and become an effective creator and user of databases in school, work, and life.

Data Analysis >

How can you evaluate alternatives and make a choice? By using survey data and a well-designed database, you can analyze data. When you analyze data, you can evaluate alternatives and make a choice for almost any decision. You can also create charts to help you evaluate alternatives and make choices by visualizing relationships among your data. Every visual medium uses charts because charts communicate relationships among data so effectively. Learn how to create forms and queries to manage your survey database. Use a spreadsheet application to conduct and represent your data analysis.

Expository Presentation >

Effective decision makers know hot to define a decision, gather information, develop alternatives, evaluate possibilities, and make choices. You can share your successful decision making with a live audience by creating, preparing, and delivering an expository presentation. You have everything you need to create an interesting and informative presentation. Can you make your presentation entertaining too? You can enhance your presentation with images, audio, and video when you learn how to manage multimedia from the Internet legally and ethically.
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Checklist: Before you begin, review the checklist for this module. Use the checklist to make sure that you complete all the tasks for each activity.

See the checklist >
Rubric: Before you begin, review the rubric for this module. Use the rubric to help you understand what is important to know and do.

See the rubric >

Big Idea

Do you know how to make decisions? You make a decision whenever you consider alternatives and make a choice. The most important decisions often arise from complex topics and require the most careful consideration of alternatives. Critical thinking can help you evaluate alternatives and make important decisions about complex topics. Critical thinkers are effective decision makers because they consider different points of view with reason and fairness. Anyone can become an effective decision maker by learning key fundamental skills. Learn how to use critical thinking skills to make important decisions about complex topics.

In this module:

· Learn to use critical thinking skills to make decisions

· Learn how basic statistics can summarize survey data

· Define an interesting and important decision around a complex topic

· Gather accurate and reliable information from credible sources

· Use graphic organizers to develop alternative choices for your decision

Activity 1: Thinking Skills >

Have you ever been asked to make an important decision? When a decision is complex, what you decide can be less important than how you decide. Critical thinking can help you make complex decisions. Learn to use critical thinking skills to make decisions.

Activity 2: Survey Data >

What is data and how can you use it to make decisions? Data is information that has been collected by observation or measurement. Surveys are a formal way to collect data on people’s opinions. Learn how basic statistics can summarize survey data.

Activity 3: Decision Definition >

What can you learn when you make a decision with data? You can use decision making to learn about almost anything that interests you. Defining a decision is a lot like choosing a topic for research. Define an interesting and important decision around a complex topic.

Activity 4: Information Gathering >

How do you gather accurate and reliable information to help you make a decision? The best strategy is to take notes from a variety of credible sources. Effective notes capture all the information relevant to your topic. Gather accurate and reliable information from credible sources.

Activity 5: Decision Alternatives >

How can you use information to make a decision? One effective strategy is to use graphic organizers to develop decision alternatives that are supported by accurate and reliable information. Use graphic organizers to develop alternative choices for your decision.

Look Back >

Reflect on what you learned in this module. Are you ready to collect survey data to help you make your decision? Use the checklist to make sure your tasks are complete. Use the rubric to assess your decision definition and alternatives. Talk about what you learned and how you did your work.
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Checklist for Decision Making
Checklists can help you keep track of your work. Use the following checklist to make sure you complete the task for each activity. If you have access to a printer, you may want to print the checklist for reference as you work through the activities. Ask your teacher for help if you have any questions about the checklist.

Activity 1: Thinking Skills

Task: Decision Analysis

· Read a news article about a current event

· Open a new word processing document and type your name, date, and a title

· Analyze the decision using critical thinking skills, by addressing the following questions:

· What is the decision and what can be accomplished by making this decision?

· What information would be useful to decision makers?

· What alternatives are available to decision makers?

· What are some possibilities of each alternative?

· What choice would you make among the alternatives?

· Check the spelling and grammar of your analysis
· Save your document

Activity 2: Survey Data

Task: Statistical Analysis

· Open a new word processing document and type your name, date, and a title

· Select a report that includes statistics on a topic that interests you

· Analyze the statistics, using critical thinking skills to address the questions:

· What decision could be made with this data?

· What information from this data is useful to decision makers?

· What are some alternatives that could be available?

· What are some possibilities of each alternative?

· What choice would you make among alternatives?
· Check the spelling and grammar of your analysis

· Save your document

Activity 3: Decision Definition

Task: Decision Definition

· Choose a topic that has an interesting and important decision

· Open a new word processing document and type your name, date, and a title

· Define the decision, using the following four steps:

· Brainstorm potential topics for your decision

· Evaluate the topics and choose one topic

· Narrow the focus of your topic to one specific decision

· Find sources to gather enough information to make the decision

· Write questions to guide your research, and address the following considerations:

· What information do you need to have to make the decision?

· What kinds of research questions will provide the information you need?

· What are some different points of view about the decision?

· What kinds of questions will help you understand the various points of view?

· Check the spelling and grammar of your document

· Save your document

Activity 4: Information Gathering

Task: Note-Taking

· Open a new word processing document and type your name, date, and a title

· Find credible sources on your topic

· Take notes on your topic to answer your research questions and use a variety of note-taking strategies, such as:

· Quote

· Paraphrase

· Summary

· Facts and data
· Original ideas
· When taking notes, be sure to:

· Record the source of each note

· Use quotation marks when copying exact words

· Double-check that you have paraphrased or summarized adequately

· Quote short phrases or sentences in a paraphrase or summary, if necessary

· Save your document

Activity 5: Decision Alternatives

Task: Graphic Organizer

· Open a new word processing document and type your name, date, and a title

· Choose a graphic organizer to represent your decision alternatives, such as:

· Fishbone (for cause-and-effect relationships)

· Interaction outline (for cause-and-effect relationships)

· Clustering diagram, concept map, web (for classify and divide)

· Compare-and-contrast organizer (for compare and contrast)

· Venn diagram (compare and contrast)

· Spider map (definitions)

· Problem-solution organizer (process)

· Cycle organizer (process)

· Create a graphic organizer to represent alternative choices for your decision

· Save your document
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Rubric for Decision Making
The main purpose of a rubric is to help you do your best work. Use the rubric to make sure you understand what you are expected to learn. Is all of your work best described by column 4? If not, what can you improve? If you have access to a printer, you may want to print the rubric for reference as your work through the activities. Ask your teacher for help if you have any questions about the rubric.
	
	4
	3
	2
	1

	Decision Definition
	Decision is defined objectively, with clear understanding of different points of view.

A survey is the best way to approach the decision.

Decision is focused and interesting to others.

Questions provide original insights about important aspects of the decision.
	Decision is defined objectively, with understanding of different points of view.

A survey is a good way to approach the decision.

Decision is focused and interesting to most others.

Questions are relevant to the decision and address all important aspects of the topic.
	Decision is defined, but not objectively, and with a vague understanding of different points of view.
Approaches other than a survey are better for the decision.

Decision is focused but may not be interesting to others.

Questions are relevant to the decision, but they do not address some important aspects of the topic.
	Decision is not defined and point of view not understood.
A survey is not a good way to approach the decision.

Decision is too broad to be made effectively.

Many questions are not relevant to the decision.

	Information Gathering
	A variety of credible sources that provide accurate and reliable information are used.

Specific and relevant keywords are used to narrow search results and improve the quality of hits.

Notes use summaries, paraphrase, and direct quotes to capture detailed information related to research questions.
	At least two types of sources are located without assistance, and all sources are appropriate and credible.

General and relevant keywords are used to narrow search results and improve the quality of hits.

Notes use summaries or paraphrase, and direct quotes to capture general information related to research questions.
	At least two types of sources are located without assistance, but some sources may not be appropriate or credible.

Vague and relevant keywords are used to narrow search results and improve the quality of hits.
Notes use summaries or paraphrase to capture some information related to research questions.
	All appropriate and credible sources are located with assistance.

Keywords are not identified or not used.
Notes do not relate to research questions or do not summarize or paraphrase relevant information.

	Decision Alternatives
	Reasonable alternatives representing multiple points of view are identified and developed.

Different kinds of graphic organizers are used to develop decision alternatives from different points of view.

Graphic organizers show important concepts that clearly and logically explain all important aspects of the alternative.
	Reasonable alternatives from at least two points of view are identified and developed.

Appropriate graphic organizers are used to develop decision alternatives from at least two points of view.

Graphic organizers show information used to develop alternatives, but the alternatives may not be fully explained.
	Reasonable alternatives from a single point of view are identified and developed.

An appropriate graphic organizer is used to develop at least one decision alternative.

Graphic organizers show information used to develop alternatives, but some of the information may be inaccurate or irrelevant.


	Reasonable alternatives are not identified or developed.

Graphic organizers are not used or are not used appropriately.

Graphic organizers do not have a clear purpose or use inaccurate or irrelevant information.

	Writing Mechanics
	All words are spelled and capitalized correctly.

All sentences are punctuated correctly.
	Almost all words are spelled and capitalized correctly.

Almost all sentences are punctuated correctly.
	Several words are misspelled or capitalized incorrectly.

Several sentences are punctuated incorrectly.
	Many words are misspelled and capitalized incorrectly, making the information hard to understand.

Many sentences are punctuated incorrectly, making the information hard to understand.


< Return to Decision Making
[PRORAMMING INSTRUCTIONS]
The content on this page can be provided as a word and pdf document for teachers to download and read offline. If you choose this option, copy this page to a word document and save as DecisionMaking_Rubric.doc

	View as Microsoft* Word


	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/DecisionMaking_Rubric.doc

	View as PDF
	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/DecisionMaking_Rubric.pdf


	Type of Page 
	Level 3 Content Page

	Supertitle
	Make Decisions with Data | Decision Making

	Headline Title
	Thinking Skills


[left-hand nav TEXT]

Vocabulary

Exploration

Information

Task

Quiz

[TITLE HIGHLIGHT BOX 1 ON RIGHT]

Look Ahead

[highlight Box TEXT]

Task: Read and analyze a news story about a complex topic.

Goal: Show that you know how to think critically about current events.

You may want to review an example of a decision analysis before you begin.
See the example:
Microsoft Word* | PDF
Key Concept

Have you ever been asked to make an important decision? You make many decisions every day when you choose what to wear, what to eat, and how to spend your time. You make a decision whenever you consider alternatives and make a choice.

What can you do when a decision is important and you are not sure of the best choice? Decisions about topics like your education, career, and family are important because they have a major effect on your life. The most important decisions are often the most complex.
Complex decisions have many parts with many connections. When a decision is complex, what you decide can be less important than how you decide. You must examine a complex decision from multiple points of view to make sure you consider all of its parts. You must be careful about the information you use and how you draw conclusions from information.

Critical thinking can help you make complex decisions. What does thinking critically mean? It means that you are objective and can see a topic from several points of view. It means that you are careful to draw logical conclusions from accurate and reliable information. Are you a critical thinker and effective decision maker? You can be if you learn key fundamental thinking skills.
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Words to Remember
This page gives basic definitions for some important terms that can help you learn about thinking skills. You can get a more complete definition of each term from Fact Monster*.

New Words

Accurate: Careful to provide true information.

Brainstorm: Think of many possibilities as quickly as you can.

Complex: Consisting of many parts that are connected or related to one another.

Concept (or Idea): A thought that combines specific information into a general statement.

Conclusion: A judgment, decision, or solution reached for specific reasons.

Consistent: Continuing to agree with specific information or ideas while working toward a goal.

Critical: Careful to evaluate information and draw correct conclusions.

Decision: A choice made after considering available alternatives.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Logical: Capable of thinking in a clear and consistent way to draw correct conclusions.

Objective: Able to put aside personal feelings and opinions.

Persistent: Continuing to work toward a goal even when an obstacle stands in the way of achieving the goal.

Point of View: The way a person tends to think about people, places, and events based on individual experiences.

Precise: Careful to provide only accurate and relevant information.

Reflective: Careful to focus on thinking about important ideas and concepts.

Relevant: Provide important information about a particular topic.
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Learning from the Web

Critical thinking can help you make complex decisions. Anyone can think critically and make effective decisions by learning some basic skills. Explore some Web sites about critical thinking and decision making. Learn the basic skills that can help you think critically and make decisions.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about critical thinking, keep those in mind too.

Some of these Web sites are quite advanced. Do not worry if you cannot understand everything that you read.

Guiding Questions

· Why is being able to think critically an important skill?

· What skills can help you think critically?

· When can critical thinking help you make a decision?

Web Sites

Critical Thinking

· Critical Thinking* from Students Taking a Stand*

· Defining Critical Thinking* from the Foundation for Critical Thinking*

· Thinking Critically* from Study Guides and Strategies*

Decision Making

· Five Steps to Better Critical-Thinking, Problem-Solving, and Decision-Making Skills* from Hillsborough Community College*

· Decision Step Models* from Decide Guide*

· Decision Making* from Answers*

· A Lexicon of Decision Making* from Decision Analysis Society*

· Brainstorming* from Mind Tools*
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What to Know
This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about critical thinking and decision making. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Critical Thinking Skills

Critical thinking involves being aware of not only what you think, but how you think. Learning to think critically involves two distinct processes. First, you learn the basic skills that make critical thinking possible. Second, you learn how to use those skills to make decisions.

Critical thinking requires some basic skills that anyone can develop. Critical thinking skills can be useful in any context. They are not limited to any specific subjects or topics. 
Critical thought is:

· Accurate. Critical thinkers are careful to use true information. Critical thinkers confirm what they believe with facts. They are not easily misled by misinformation.

· Clear. Critical thinkers communicate in ways that are appropriate for their audiences. You never have to guess what critical thinkers mean because they are easily understood.

· Consistent. Critical thinkers always work in orderly and methodical manners. They may change their minds but they do not contradict themselves.

· Logical. Critical thinkers put information together in orderly ways. They construct detailed arguments with no gaps or jumps.

· Objective. Critical thinkers put aside personal feelings and opinions. Critical thinkers look at topics from every point of view to make sure they have all the relevant information.

· Persistent. Critical thinkers overcome whatever obstacles they encounter. They continue to think critically until they reach logical conclusions.

· Precise. Critical thinkers use clear and specific ideas and language. You never have to guess what critical thinkers mean. They get straight to the point.

· Reflective. Critical thinkers always monitor their thinking while focusing on tasks at hand. They consistently evaluate the effectiveness of their thoughts and actions.

· Relevant. Critical thinkers only use important information. They connect specific details to main ideas and show how main ideas relate to one another.

How to Make Decisions

You cannot become an effective decision maker by just learning about the basic thinking skills. You must use the skills in many ways to become an effective decision maker. You can use critical thinking skills to make any important decision in school, work, and life.

Decision making is an important part of almost any field of study or occupation. Many methods and processes have been created for making different kinds of decisions. Some subjects and occupations are dedicated specifically to making certain kinds of decisions.

Five basic steps that you can use to make decisions in almost any situation are:

1. Define a decision. The first step is defining the decision to be made. Critical thinkers consider possible consequences of decisions and set goals for what they want to accomplish. An important decision usually has many decision makers. Critical thinkers consider various points of view and ask precise questions.

2. Gather information. The second step is gathering information about the topic that is relevant to the decision. Critical thinkers make sure the information they gather is accurate and relevant. They do not assume that answers are correct or incorrect. Instead, they persistently locate credible sources to support or dispute answers.
3. Develop alternatives. The third step is discovering what alternatives are available to choose. Brainstorming can help you think of all possible alternatives. Critical thinkers are objective and consider alternatives from different points of view. They develop important ideas and concepts that are relevant to each alternative.

4. Evaluate possibilities. The fourth step is evaluating the possibilities of each alternative. Critical thinkers evaluate alternatives consistently and logically. They give each alternative adequate consideration using the same criteria. They try to understand precisely the possible consequences, both good and bad, of each alternative. They make sure that each alternative is supported by accurate and relevant information.

5. Make a choice. The fifth step is making a choice from among the alternatives. Critical thinkers make sure that each chosen alternative is supported by well-developed ideas and concepts. Critical thinkers objectively evaluate the reasoning behind their choices. They can provide clear and consistent explanations of their choices. They are reflective about their choices and willing to reconsider their decisions when necessary.
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What to Do
Complete the following task to show what you have learned about critical thinking and decision making. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a decision analysis before you begin.
Task: Read and analyze a news story about a complex topic.

Goal: Show that you know how to think critically about current events.

See the example: Microsoft Word* or PDF

1. Read about a current event in the news. Identify a decision that could be made about the topic. You may choose one of the following news sources or your teacher may assign one:

· Time for Kids* from TIME*

· New York Times Student Connections* from the New York Times*

· Kidsnewsroom.org*

2. Check with your teacher to make sure the topic is complex and the decision is important. You will not be able to show that you can think critically if the decision is unimportant.

3. Start a new word processing document. Always remember to type your name and the date at the top of the document.

4. Type a title for the document. You may want to include the title of the news story you analyze, such as Decision Analysis of ______________.
5. Use critical thinking skills to analyze the decision. Make sure you address each of the following questions:

· What is the decision and what can be accomplished by making this decision?

· What information would be useful to decision makers?

· What alternatives are available to decision makers?

· What are some possibilities of each alternative?

· What choice would you make among the alternatives?
6. Check the spelling and grammar of your analysis.

7. Double-check your work by reading the document carefully one more time.

8. Review the checklist and revise your analysis to make sure it is complete.

9. Save your analysis. Ask your teacher for help if you do not know where to save the file. Your teacher may also ask you to print or e-mail your file.

10. Share your analysis.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about critical thinking and decision making. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. When you are objective, you _____.

· Put aside personal feelings and opinions [Correct! Objective thinking involves seeing information from all points of view.]
· Use only information that is important [Try again. Using only important information is a characteristic of relevant thinking.]
· Confirm what you believe with facts [Try again. Confirming facts is a characteristic of accurate thinking.]
2. What kind of thinking involves putting information together in an orderly way?

· Logical [Correct! Logical thinking provides a clear and consistent path to a reasonable conclusion.]
· Precise [Try again. Precise thinking is clear and specific, but a better answer is available.]
· Relevant [Try again. Relevant thinking uses only information that is important.]
3. How can you use critical thinking skills to identify a decision?

· Consider what can be accomplished from different points of view [Correct! Critical thinkers put aside personal feelings and opinions, and try to understand decisions from different points of view.]
· Make sure that decision makers use accurate and relevant information [Try again. Checking the accuracy and relevance of information is an important part of critical thinking, but another answer is more relevant to identifying a decision.]
· Ask any relevant question about the available alternatives [Try again. Asking questions is an important part of brainstorming alternatives, but another answer is more relevant to identifying a decision.]
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Task: Analyze the results of the survey on a topic that interests you.

Goal: Show that you can think critically about survey results.

You may want to review an example of a statistical analysis before you begin.
See the example:
Microsoft Word* | PDF
Key Concept

What is data and how can you use it to make decisions? Data is information that has been collected by observation or measurement. If observations or measurements are accurate, the information is factual. When you prepare to make an important decision, you want the most factual data you can find.

What kinds of data can help you understand a complex decision? You can collect data to help you make almost any decision. Complex decisions often call for several different kinds of data. Critical thinking skills can help you determine the kinds of data to collect and how to draw conclusions from the data. Different kinds of data could help you make decisions about:

· How you can help reduce global warming
· The high school or college you want to attend

· The career you want to pursue

Knowing people’s thoughts on a topic can help you understand different points of view on the topic. Surveys are a formal way to collect data on people’s opinions. However, you should not rely solely on survey data, because opinions may or may not be supported by facts.

Survey data is often summarized with basic statistics, such as percentages and averages. Statistics are numerical representations of facts and data. Statistical data can help you make a complex decision, but it cannot make the decision for you. Your critical thinking skills can help you use data to make effective decisions.
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Words to Remember
This page gives basic definitions for some important terms that can help you learn about survey data. You can get a more complete definition of each term from Fact Monster*.

New Words

Average: A number that represents a typical value of a dataset, especially the mean.

Central Tendency: A typical value of the members in a set of data.

Chart: Another term for graph, especially one that uses a picture to show relationships among selected parts of a set of data.

Data: Information collected by observation or measurement.

Dataset: A collection of data records.

Demographics: Basic statistics about a human population. For example, age, gender, race, residence, education, and income.

Fact: Information widely believed to be true and supported by objective data.

Mean: A measure of central tendency calculated by adding the values of a dataset and then dividing the sum by the number of values in the set.

Median: A measure of central tendency calculated by ordering the values in a dataset from lowest to highest and finding the middle value in the set.

Mode: A measure of central tendency calculated by ordering the values in a dataset from lowest to highest and finding the most common value in the set.

Opinion: Beliefs that may or may not be supported by facts.

Percentage: The number of one part of a group compared to the total number in the whole group.

Population: All members of a specific group.

Range: The highest value in a dataset minus the lowest value in the dataset.

Sample: One part of a population that represents the whole population.

Statistics: Facts and data that can be represented by numbers; also the study of numerical facts and data.

Survey: Gather facts and opinions from a sample population by asking questions.

Review Words

Accurate: Careful to provide true information.

Brainstorm: Think of many possibilities as quickly as you can.

Complex: Consisting of many parts that are connected or related to one another.

Consistent: Continuing to agree with specific information or ideas while working toward a goal.

Critical: Careful to evaluate information and draw correct conclusions.

Decision: A choice made after considering available alternatives.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Logical: Capable of thinking in a clear and consistent way to draw correct conclusions.

Objective: Able to put aside personal feelings and opinions.

Persistent: Continuing to work toward a goal even when an obstacle stands in the way of achieving the goal.

Point of View: The way a person tends to think about people, places, and events based on individual experiences.

Precise: Careful to provide only accurate and relevant information.

Reflective: Careful to focus on thinking about important ideas and concepts.

Relevant: Provide important information about a particular topic.
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Learning from the Web

Surveys are a formal way to collect data on people and their opinions. Survey data is often summarized with basic statistics, such as percentages and averages. Some examples of statistics, from the United States, that summarize survey data are:

· 94 percent of schools have Internet access in classrooms

· 18 percent of children ages 6–17 are overweight

· 2.6 people live in an average household
· The average 8–18 year-old watches more than three hours of television per day

Explore some Web sites about basic statistics such as percentages and averages. Learn how statistics can summarize survey data.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about survey data, keep those in mind too.

Guiding Questions

· What can you learn from survey results?

· Why do you need to think critically about survey results?

· How could you use a survey to collect data on a topic that interests you?

Web Sites

Percentages

· Finding a Percentage* from Ask Dr. Math*

· Percentage* from Ask Dr. Math*

· Perplexing Percentages* from Figure This!*

· Percent* from Math.com*

Central Tendency

· Mean, Median, Mode, Range* from Ask Dr. Math*

· Interactive Comparison of Mean and Median* from NCTM Illuminations*

· Middle School Statistics* from Ask Dr. Math*

· Descriptive Statistics* from the University of Illinois*
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What to Know
This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about survey data. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Purpose of Surveys

Surveys ask questions to collect data on people’s opinions about various topics. Many surveys also ask people some questions about themselves. A survey is one way to collect data that can help you make a decision.

Suppose you are interested in global warming and want to know what you can do to help. You could survey other students in your class to find out what personal actions they have taken to help reduce global warming.

Survey Data and Percentages

Survey data is often reported in percentages. Suppose you ask 25 students whether they have taken each of five different personal actions to reduce global warming. Twenty-one of your classmates say they have taken at least one of the five actions and four say they have not. What percentage of students in your class has taken personal action to reduce global warming?

You can compute the percentage of any part of a group compared to the whole. Just divide the number in the part by the number in the whole group. In the global warming example, the number in the part is 21 and the number in the whole is 25. You can compute that 21 divided by 25 equals 0.84. If you multiply 0.84 by 100, you get the percentage, which is 84 percent.

Survey Data and Central Tendency

Measures of central tendency provide a basic way to summarize survey data. Central tendency is one of the most important concepts in statistics. Central tendency refers to the value that most members of a dataset tend to have.
The three basic measures of central tendency are:

· Mean. The mean is the average value in a dataset. Mean is calculated by adding the values of a dataset and then dividing the sum by the number of values in the set. Consider the dataset {1, 1, 2, 4, 7}. The sum of the five values in this dataset is 1+1+2+4+7 = 15, so the mean is 15/5 = 3.

· Median. The median is the middle value in a dataset. Median is calculated by ordering the values in a dataset from lowest to highest and finding the middle value in the set. Consider the dataset {1, 1, 2, 4, 7}. The third value of the five values in the set is 2, so the median = 2.

· Mode. The mode is the most common value in a dataset. Mode is calculated by ordering the values in a dataset from lowest to highest and finding the most common value in the set. Consider the dataset {1, 1, 2, 4, 7}. The most common value in the set is 1, so the mode = 1.

The mean is commonly referred to as the average of a dataset. Technically, any measure of central tendency could be considered an average, or typical, value. Which measure you use depends on your purpose and on the dataset.

The mean changes whenever one value changes, so it is very sensitive to unusually small or large values. The median and mode only depend on the order of values, not on the size of the values. The median or mode may be a better measure with a few very small or very large values in a dataset.
In most datasets, the mean, median, and mode will be very similar. In the global warming example, 25 students were asked if they had taken each of five different personal actions to reduce global warming. The following dataset shows how many personal actions each of these 25 students reported, sorted from fewest to highest number of actions:

Dataset = {0, 0, 0, 1, 1, 1, 1, 1, 1, 2, 2, 2, 2, 2, 3, 3, 3, 3, 3, 4, 4, 4, 5, 5, 5}
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A total of 58 actions were taken by the 25 students. You can compute the mean of this dataset by dividing 58 by 25, which results in 2.32 actions. You can use the sorted dataset to determine that the median student (the thirteenth student in the dataset) reported taking two actions. The most common response in the dataset is 1, so the mode of the dataset is 1 action.

You would probably report that the “average” student in your class has taken 2.32 personal actions to reduce global warming. However, you could also report that most students in your class have taken at least 2 personal actions to reduce global warming. Finally, you could report that the most common number of personal actions taken by students was 1.
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Reporting Percentages

Charts can display survey data. The chart below shows that 21 out of 25 students, or 84 percent of students, have taken personal action to reduce global warming. A pie chart is a good way to show percentages.

[image: image2.png]Reducing Global Warming

18%

@ Students who have taken
personal action

@ Students who have not
taken personal action

84%





You could also report percentages for each of the five actions. The following bar graph shows how many students reported taking each action. You can use the numbers to compute percentages. A bar graph is a good way to report the number of items in selected categories.
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For example, 44 percent (=11/25*100) of the students reported planting a tree. In comparison, the action most frequently reported by students was recycling household waste. Overall, 84 percent (=21/25*100) of the students reported that they recycle. The least frequently reported action was using compact fluorescent light bulbs. Only 12 percent (3/21*100) of the students use compact fluorescent light bulbs.

Can you determine the percentage of students who reported using less heating and air conditioning? What percentage reported using less hot water?
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What to Do
Complete the following task to show what you have learned about survey data. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a statistical analysis before you begin.

Task: Analyze the results of the survey on a topic that interests you.

Goal: Show that you can think critically about survey results.

See the example: Microsoft Word* or PDF
1. Start a new word processing document. Always remember to type your name and the date at the top of the document.

2. Find a report that includes statistics on a topic that interests you. You may choose one of the following news sources or your teacher may assign one:

· NCES Reports* from NCES Kids Zone*

· ChildStats.gov* from the Federal Interagency Forum on Child and Family Statistics*

· American Fact Finder* from U.S. Census Bureau*

· Generation M: Media in the Lives of 8-18 Year-olds* from The Henry J. Kaiser Family Foundation*

3. Type a title for your document. You may want to include the title of the report, such as Statistical Analysis of ______________.
4. Use critical thinking skills to analyze the statistics. Make sure you address each of the following questions:

· What decision could be made with this data?

· What information from this data is useful to decision makers?

· What are some alternatives that could be available?

· What are some possibilities of each alternative?

· What choice would you make among alternatives?

5. Check the spelling and grammar of your analysis.

6. Double-check your work by reading the document carefully one more time.

7. Review the checklist and revise your analysis to make sure it is complete.

8. Save your analysis. Ask your teacher for help if you do not know where to save the file. Your teacher may also ask you to print or e-mail your file.

9. Share your analysis.

< Back to Information | Next to Quiz >

[PRORAMMING INSTRUCTIONS]
See programming notes on the Main Page in this section.
	Microsoft* Word


	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/DM_SurveyData_Example.doc

	PDF
	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/DM_SurveyData_Example.pdf


	Type of Page 
	Level 4 Content Page

	Supertitle
	Decision Making | Survey Data

	Headline Title
	Quiz


[left-hand nav TEXT]

Vocabulary

Exploration

Information

Task

Quiz

Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about surveys. Your answers are not recorded, and the quiz is not scored.

Please read all possible answers first, and then choose the best answer.

1. How do you compute the percentage of any part of a group compared to the whole group?

· Divide the number in the part by 100 [Try again. Dividing by 100 only works if the number in the whole group is exactly 100.]
· Divide the number in the part by the number of the whole [Correct! Dividing a part by the whole gives you the percentage.]
· Divide the number of the whole by the number in the part [Try again. Percentage is the number in the part divided by the number of the whole.]
2. How do you compute the mean of a dataset?

· Add the values of a dataset and then divide the sum by the number of values in the set [Correct! Dividing the sum of dataset values by the number of values gives you the mean.]
· Add the values of a dataset and then divide the number of values in the set by the sum [Try again. The described procedure does not produce a meaningful statistic.]
· Order the values in a dataset from lowest to highest and find the middle value in the set. [Try again. The middle value in a dataset is the median of the dataset.]
3. Which measure of central tendency is most typical when a dataset has a few very small or very large values?

· Average [Try again. Technically, any measure of central tendency could be called an average.]
· Mean [Try again. The mean is distorted by very small or very large values.]
· Median [Correct! The median is not distorted by very small or very large values because it only depends on the order of values.]
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Task: Define a decision by choosing a topic and writing some questions to guide research.

Goal: Show that you can define an interesting and important decision and use different types of questions effectively.

You may want to review an example of a decision definition before you begin.
See the example:
Microsoft Word* | PDF
Key Concept

Are you ready to make a decision with data? You can use the decision making process to learn about complex topics that interest you. Important decisions can be made in almost any subject. Once you know what subject you want to learn about, you must narrow your focus to a specific topic and identify an interesting decision.

An important decision about a complex topic must be carefully defined. Defining a decision is a lot like choosing a topic for research. Defining a decision involves brainstorming potential topics, evaluating the topics, and narrowing your focus to a specific decision. Finally, you want to make sure you can gather enough accurate and reliable information to make the decision you defined.

Before you begin any research, you should decide exactly what you need to know. What do you want to know about your topic? What makes the topic interesting to you? What information do you need to make the decision? Writing a few effective research questions keeps you focused while you gather information about the topic.

What types of questions you ask depends on what kinds of answers you need. An interesting decision usually requires more than one type of information to make. That means you will need to ask more than one type of question.
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Words to Remember
This page gives basic definitions for some important terms that can help you learn about defining a decision. You can get a more complete definition of each term from Fact Monster*.

New Words

Convergent: Moving toward one direction or having a limited number of answers.

Divergent: Moving in many directions or having many answers.

Evaluate: Determine the usefulness of a source.

Evaluative: Requiring judgment to decide among various opinions or answers.

Review Words

Accurate: Careful to provide true information.

Brainstorm: Think of many possibilities as quickly as you can.

Complex: Consisting of many parts that are connected or related to one another.

Consistent: Continuing to agree with specific information or ideas while working toward a goal.
Critical: Careful to evaluate information and draw correct conclusions.

Data: Information collected by observation or measurement.

Demographics: Basic statistics about a human population. For example, age, gender, race, residence, education, and income.

Fact: Information widely believed to be true and supported by objective data.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Logical: Capable of thinking in a clear and consistent way to draw correct conclusions.

Objective: Able to put aside personal feelings and opinions.
Persistent: Continuing to work toward a goal even when an obstacle stands in the way of achieving the goal.
Point of View: The way a person tends to think about people, places, and events based on individual experiences.

Population: All members of a specific group.

Precise: Careful to provide only accurate and relevant information.

Reflective: Careful to focus on thinking about important ideas and concepts.

Relevant: Provide important information about a particular topic.

Sample: One part of a population that represents the whole population.

Statistics: Facts and data that can be represented by numbers; also the study of numerical facts and data.

Survey: Gather facts and opinions from a sample population by asking questions.
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Learning from the Web

Defining a decision is a lot like choosing a topic for research. Once you know what subject you want to learn about, you must narrow your focus to a specific topic, identify an interesting decision, and make sure you can gather enough information to make the decision. Writing a few effective research questions keeps you focused while you gather information.

Explore some Web sites that can help you define your decision. Learn about the difference between a subject and a topic and how to brainstorm and refine ideas for a topic. Learn what types of questions to ask about your topic.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of any other questions about how to choose a topic and write effective research questions, keep those in mind too.

Guiding Questions

· How does brainstorming help you choose a topic and define a decision?

· How can you make sure your decision is defined narrowly in order to make an effective decision?

· What types of questions can you ask to help you make a decision?

Web Sites

Choosing a Topic

· Establish Your Topic* from Fact Monster*

· Choosing the Topic* from Essay Info*

· How to Brilliantly Brainstorm a Topic* from Scholastic*

Research Questions

· What’s the Question? from Fact Monster*

· Task Definition* from The Big6*

· How to Impress Your Teachers by Asking Good Questions!* from The Big6*
· Creating Research Questions* from Wheeling High School*

< Back to Vocabulary | Next to Information >

	Type of Page 
	Level 4 Content Page

	Supertitle
	Decision Making | Decision Definition

	Headline Title
	Information


[left-hand nav TEXT]

Vocabulary

Exploration

Information

Task

Quiz

[TITLE HIGHLIGHT BOX 1 ON RIGHT]

Types of Questions

[highlight Box TEXT]

Learn how to write effective questions.

Read more >
What to Know
This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about defining a decision. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Defining a Decision

You can use the decision making process to learn about complex topics that interest you. Important decisions can be made in almost any subject. You want to make sure your topic will provide an interesting decision.

First, narrow your focus to a specific topic within the subject. Then, make sure you can identify an interesting decision about your topic. Finally, make sure you have enough sources and time to make an effective decision.

Tips for Choosing a Topic

The most important quality of a topic for any decision is that you are interested in the topic. Some strategies for choosing a topic for decision making are:

1. Make a list of topics. Brainstorming is a great way to think of a topic. You can make a list of topics that interest you. Do not worry if they are good topics. Just write down or type anything that comes to mind.


Example: You are interested in the subject of environmental science, so you think of 
endangered species, global warming, and recycling as possible topics.

2. Evaluate the topics. After you brainstorm a list of topics, look at your list and consider whether the topics are appropriate. You may want to brainstorm some possible decisions and think about how you could define them.


Example: Endangered species is a complex topic, but you would rather learn about 
something you can influence directly. Global warming is a complex topic and your 
personal actions do have a small but direct influence. Recycling is important but has 
been an issue for a long time and may no longer be very interesting.

3. Narrow the focus. After you choose a topic, you should focus on a specific aspect of the topic. Identify an interesting and important decision with clear and significant consequences. You do not want to define a decision that is too broad to make effectively.


Example: Global warming is the best topic for you, but it is very complex. You could 
define many different decisions involving global warming. Everyone’s personal actions 
have a small but direct influence on global warming, so you narrow the focus to personal 
actions. You want to decide what you can do to help reduce global warming.

4. Check for sources. Finally, make sure you can find enough information about the topic. You do not need to research the decision yet, but you can conduct a preliminary search for sources of information.


Example: You search the Web for global warming and find that millions of sites have 
information about global warming. You go to your library and find many books on global 
warming in the library catalog.

Writing Effective Research Questions

Effective research questions are big enough to hold your interest and small enough to answer. Many questions focus on facts that can be memorized. Fact questions are very useful, but they may not provide enough information.

Usually, you cannot gain an understanding of a complex topic by just asking fact questions. Other types of questions can help you delve deeper into a topic. These include convergent, divergent, and evaluative questions:
· Convergent questions require more explanation than memory or fact questions but usually have correct answers.

· Divergent questions usually have many acceptable answers.
· Evaluative questions require judgment to decide among various opinions or answers.
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Writing Effective Questions

The types of questions you ask depends on the kinds of answers you need. An interesting decision usually requires more than one type of information to understand. That means you will need to ask more than one type of question. This page explains various kinds of research questions and gives examples.

Fact Questions

Fact questions always have a correct answer and usually start with words like:
· Who…?

· What…?

· Where…?

· When…?

Some examples of memory or fact questions are:

· Who invented the calendar?

· What is copyright?

· Where is Kazakhstan? 
Convergent (Why) Questions

Convergent questions require more explanation than memory or fact questions but usually have correct answers. They often start with words like:

· Why…?

· How…?

· According to…?

Some examples of convergent, or why, questions are:

· Why do we have copyright laws?

· How is a PC different from a Mac?

· According to most scientists, what is the most likely impact of greenhouse gases?

Divergent (Idea) Questions

Divergent questions usually have many acceptable answers and often include words like:

· What if…?

· How could…?

· How would…?

Some examples of divergent, or idea, questions are:

· What would your life be like if you lived in another country?

· How could greenhouse gases affect the weather where you live?

· How would research be different if copyright laws did not exist?

Evaluative (Opinion) Questions

Evaluative questions require judgment to decide among various opinions or answers. They often include words like:

· Do you think…?

· Why should…?

· How well…?

Some examples of evaluative or opinion questions are:

· Do you think downloading music and graphics from the Internet is always OK?

· Why should educational use of copyrighted materials have different rules than commercial use?

· How well did the text support the author’s point of view?
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What to Do
Complete the following task to show what you have learned about defining a decision. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a decision definition before you begin.
Task: Define a decision by choosing a topic and writing some questions to guide research.

Goal: Show that you can define an interesting and important decision and use different types of questions effectively.

See the example: Microsoft Word* or PDF

1. Choose a topic around which you can define an interesting and important decision. You may choose a topic from one of the following news sources or your teacher may assign one:

Science

· Rivers 2001* from National Geographic*

· Bagheera: Endangered Species* from Endangered Earth*

· Global Warming: What It Is* from the Environmental Protection Agency*

· Windows to the Universe* from the University Corporation for Atmospheric Research*

Current Events

· Time for Kids* from Times Inc.*

· New York Times Student Connections* from The New York Times Company*

· Kidsnewsroom.org*

Arts

· The Collection* at the National Gallery of Art*

· Art Museums* from Kidspace @ The Internet Public Library*

· Masters List A-Z* from American Masters* at PBS*

2. Check with your teacher to make sure you can define an interesting and important decision around the topic you selected.

3. Start a new word processing document. Always remember to type your name, the date, and a title at the top of the document.

4. Define the decision you want to make. Remember to describe each of the four steps you followed to define your decision:

· What potential topics did you brainstorm for your decision?

· Why did you choose your topic from those you evaluated?

· How did you narrow the focus of your topic down to a specific decision?

· Where can you gather enough information to make the decision?

5. Remember to save your document frequently while you work.

6. Write some questions to guide research for your decision. Make sure you address each of the following considerations:

· What information do you need to have to make the decision?

· What kinds of research questions will provide the information you need?

· What are some different points of view about the decision?

· What kinds of questions will help you understand the various points of view?

7. Check with your teacher to make sure you have written effective research questions. You may want to ask your teacher if you have too few or too many questions.

8. Check the spelling and grammar in your paragraphs.
9. Double-check your work by reading your document carefully one more time.

10. Review the checklist and revise your research questions to make sure they are complete.

11. Save your document.

12. Share your research questions.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about defining a decision. Your answers are not recorded, and the quiz is not scored.

Please read all possible answers first, and then choose the best answer.

1. How does brainstorming help you choose a topic for a decision?

· Brainstorming helps you narrow your focus. [Try again. You should narrow your focus after you brainstorm.]
· Brainstorming helps you think of possible topics. [Correct! Brainstorming is thinking of as many topics as you can as fast as you can.]
· Brainstorming helps you make sure you can find enough information. [Try again. You must be able to find enough information, but checking sources is not the main purpose of brainstorming.]
2. Which of the following is a divergent question?

· What would happen if smoking were made illegal? [Correct! This question could have many acceptable answers.]
· What are the health effects of smoking? [Try again. This is a convergent question. It has a correct answer but requires some explanation.]
· What does the Surgeon General say about smoking? [Try again. This is a fact question.]
3. Which of the following is an evaluative question?

· Should students be allowed to bring cell phones to school? [Correct! This question does not have a definite correct answer so you must decide among different opinions or points of view.]
· Why have some cities banned cell phones in schools? [Try again. This is a convergent question. You could find out what reasons cities have given for banning cell phones in schools.]
· How do students feel about bringing cell phones to school? [Try again. This is a convergent question. This question has a limited number of answers that can be found by asking students how they feel.]
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Task: Gather information to help you make a decision about your topic.

Goal: Show that you can gather accurate and reliable information by taking effective notes from credible sources.

You may want to review an example of notes before you begin.
See the example:
Microsoft Word* | PDF
Key Concept

You have chosen a topic and defined an interesting and important decision around the topic. You must understand your topic before you can make the decision. When the topic is complex and the decision is important, gathering accurate and reliable information becomes very important.

Do you know how to gather accurate and reliable information? One strategy is to use a variety of sources, such as books, encyclopedias, databases, and the Internet. You can use keyword searches to find information in library catalogs, databases, and Web sites. Think critically about any source and always evaluate the credibility of a Web site.

After you locate credible sources, you must capture any relevant information from the sources. Note-taking is an important skill you can use to capture information. Skilled note-takers know when to quote, paraphrase, or summarize an idea. They cite their sources carefully to make sure they do not commit plagiarism. Their notes are easy to organize and use later.

How can you make an effective decision? You can make well-informed decisions on almost any topic if you can gather accurate and reliable information. Learn the skills you need to become an efficient information-seeker and an expert note-taker.
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Words to Remember
This page gives basic definitions for some important terms that can help you learn about gathering information. You can get a more complete definition of each term from Fact Monster*.

New Words

Cite: Refer to a source of information, usually in a formal way.

Credible: A source you can trust to provide true information.

Database: A collection of information organized and stored on a computer so it can be quickly and easily searched and sorted.

Hit: A successful match between keywords and Web sites returned by a search engine or directory.

Keyword: A word that is related to a topic in an important way and helps you find more information about the topic.

Paraphrase: Restate an author’s ideas using different words.

Plagiarism: Copying or making slight changes in a written or created work and presenting it as a new or original work.

Quote: Use another person’s exact words.

Reliable: Capable of producing accurate results every time.

Research: Study a topic carefully using credible sources.

Search Directory: A Web site that categorizes Web pages by subject to make searching easier.

Search Engine: A program that scans the Internet and creates a database of the words contained in Web sites so users can find Web pages containing specified keywords.

Source: Anything or anyone providing information about a topic.

Summarize: Explain the main points and important details of an author’s ideas.

Review Words

Accurate: Careful to provide true information.

Convergent: Moving toward one direction or having a limited number of answers.

Data: Information collected by observation or measurement.

Dataset: A collection of data records.
Divergent: Moving in many directions or having many answers.

Evaluative: Requiring judgment to decide among various opinions or answers.

Fact: Information widely believed to be true and supported by objective data.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
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Learning from the Web

Some fundamental research strategies can help you quickly gather accurate and reliable information. You can use these strategies with library catalogs, databases, and Web sites. Explore some Web sites about locating sources and taking notes. Learn how to gather information more effectively.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about gathering information, keep those in mind too.

Guiding Questions

· How can you get the most accurate hits from a keyword search?

· What are some strategies to help you take effective notes?

· How can you make sure you do not commit plagiarism?

Web Sites

Locating Sources

· Look for Sources of Information* from Fact Monster*

· Using Search Engines* from Fact Monster*

· Grades 7-12* from The Big6*

· Creating Keywords* from The Big6*

Taking Notes

· Plagiarism* from Fact Monster*
· Recording and Organizing Information* from Fact Monster*

· Ideas About Note Taking and Citing Sources* from The Big6*

· Best Note-Taking Strategies* from Scholastic*
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What to Know
This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about gathering information. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Strategies for Gathering Information

The single most important strategy for gathering information is to use a variety of sources, such as books, encyclopedias, databases, and the Internet. You can use keyword searches to find information in library catalogs, databases, and Web sites. Some fundamental research strategies can help you get the best and most efficient results from your keyword searches.

Evaluating the information you find is always important, especially on Web sites. When you find a source, be sure to evaluate the information to make sure it is accurate and reliable. Evaluation involves judging a source against specific criteria. You can find many different lists of criteria, but they all have three characteristics in common. They all include criteria to make sure you have found a credible source of accurate and reliable information.

Taking Notes

When you use a source for your research, you cite the source in a bibliography. Citing all your sources is always important. A bibliography is a list of sources, usually in alphabetical order by the authors’ last names. Be sure to add sources to your bibliography as you take notes.

Five basic types of notes are:

· Quote. The simplest way to take notes is to copy an author’s exact words. You should quote a source only when the exact words themselves are important. You may decide to quote a source because the author has special expertise or authority. You may also use a quotation when an idea is very difficult to paraphrase or summarize adequately.

· Paraphrase. Restating an author’s ideas using different words is often the best way to take notes. Paraphrasing an idea adequately requires some thought and caution. Changing a few words or rearranging words or sentences is not enough. An adequate paraphrase expresses someone else’s idea in the words you would have used if you had thought of the idea yourself. Paraphrasing an idea is an effective way to help you learn and remember the information you gather.

· Summary. Explaining the main points and important details of another author’s ideas is usually the most efficient way to take notes. Writing an adequate summary often requires more thought and time than paraphrasing an idea. You might think of summarizing as paraphrasing a paraphrase. First, you put the author’s ideas in your own words. Then, you explain in your own words what the ideas mean to you and why they are important. In the long run, summarizing is usually more efficient than paraphrasing because it captures more information in fewer words. Furthermore, summarizing a source is probably the most effective way to help you learn and remember the information you gather.

· Facts and Data. Sometimes you simply want to record facts or data from a source. For example, you might note that, “The capital of Argentina is Buenos Aires.” You usually do not need to be concerned about paraphrasing or summarizing simple facts. You may also want to copy statistics, charts, or graphics from a source. You can often explain the meaning and importance of data in your own words, but sometimes the numbers or images are much more efficient. In these cases, you can effectively “quote” the data by copying the numbers or images and citing the source.

· Original Ideas. While you are gathering information from sources, you may have ideas of your own. When you have an original idea, you should record it immediately. However, you should always make sure that the idea really is original. It may actually be a paraphrase or summary of a source. If the idea is original, record it so that it is clearly separate from your notes on any source.

You must cite all your sources, not just those that you quote. You must also cite any sources that you paraphrase or summarize during your research. Otherwise, you have plagiarized the author of the source.

Plagiarism is when you fail to cite a source you have quoted, paraphrased, or summarized. If you do not adequately paraphrase or summarize a source, you may plagiarize the author even if you cite the source.
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Getting the Best from Your Searches

The key to getting the best results from any search program is the keyword. A good keyword is specific. It relates to your topic, and it does not relate to very many other topics. After you have good keywords, you can use some strategies to get better hit results. Remember that every search program is a little different. What works on one may not work on another. Even so, some strategies work on most search programs.

How to Get Fewer Hits

· Use more keywords. Most search programs look for all the keywords you enter. When you enter more keywords, your hits should be more accurate. Of course, your keywords must be specific.

· Use quotes. Most search programs treat more than one word in quotes as a single keyword. They return only sites that have the exact same words in the exact same order.
· Use AND or a plus sign (+). If you want to see only sites that have a keyword, you can put AND or + in front of the keyword. Note that some search programs assume you only want to see hits that have all keywords.

· Use NOT or a minus sign (-). If you do not want to see sites that have a keyword, you can put NOT or - in front of the keyword. Note that some search programs may ignore NOT or treat it as a regular word.

· Use more specific keywords. Using more specific terms or proper nouns as keywords returns fewer hits that are more specifically related to the topic. For example, greenhouse gases returns fewer hits than climate change, while Kyoto Treaty only returns hits that are specifically related to efforts to reduce global warming.

How to Get More Hits

· Use fewer keywords. Just as more keywords give you fewer hits, fewer keywords give you more hits. Sometimes, you may not be able to find a lot of information on a topic. In those cases, you can use fewer keywords to get more hits.

· Use OR. If you want to see all sources that have any of your keywords (even if they do not have all of your keywords), you can put OR between your keywords.

· Use more general keywords. Using more general terms returns more hits that are less specifically related to the topic. However, you can often use these hits to identify other keywords that may be more effective. For example, endangered species returns more hits than blue whale.
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Getting the Most from Your Notes

You can take notes in many ways. Some people take notes by hand on index cards or sticky notes. Others record notes in a journal or notebook. Index cards and sticky notes have the advantage of being easier to organize before you begin writing your essay.

You can use a word processing application to take notes. Specialized computer programs also help with taking notes. Electronic notes have the advantage of being easy to organize before you begin writing. They have the added advantage of being quick and easy to search.

You should find a method of note-taking that works for you. However you take your notes, some guidelines will help make sure your notes are effective:

· Always record the source for each note, including page number or Web address, when you take a note. Do not assume that you will be able to remember or find the source later.

· Always use quotation marks when you copy another author’s exact words. You may accidentally plagiarize the source if you forget to include quotation marks.

· Always take time to make sure you have adequately paraphrased or summarized a source. Do not be tempted to wait until later to revise a paraphrase or summary. You may accidentally plagiarize the source when you write your essay.

· You may quote short phrases or sentences as part of a paraphrase or summary. This can be useful when finding other words for a specific thought or piece of information is difficult. Make sure you use quotation marks around the phrases or sentences you copy.

· If you use a word processing application, you can find or create a form for taking notes. A form can help you remember to include a full citation for each source. It can also help you take better notes. For example, you can copy and paste information from the source into one part of the form and paraphrases its ideas in a separate section. You could summarize the source in another section of the form.
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What to Do
Complete the following task to show what you have learned about gathering information. While you work through the task, think about whether you are achieving the goal. You may want to review an example of notes before you begin.
Task: Gather information to help you make a decision about your topic.

Goal: Show that you can gather accurate and reliable information by taking effective notes from credible sources.

See the example: Microsoft Word* or PDF

1. Start a new word processing document. Always remember to type your name, the date, and a title at the top of the document.

2. Locate some credible sources on your topic. Try to locate a variety of sources such as books, encyclopedias, databases, and Web sites. Check with your teacher or a librarian if you are not sure where to locate a source. The following resources can help you find credible Web sites with information on your topic:

Online Encyclopedias

· Fact Monster*

· Answers.com*

· MSN Encarta*

· HighBeam Encyclopedia*

Search Tools

· Ask*

· Google*

· Yahoo!*

Evaluation Tools

· Web Site Evaluation Form* from the Verizon Foundation*
· WWW CyberGuide Ratings for Content Evaluation* (PDF; 1 page) from CyberBee*

· Critical Evaluation of a Web Site* from Discovery School*

3. Cite the sources you locate in the document. Your teacher may want you to use a specific format. The following Web sites can help:

· Landmarks Son of Citation Machine* from The Landmark Project*

· NoodleBib Express* from NoodleTools*

4. Remember to save your document frequently while you work.

5. Check with your teacher to make sure you have located enough credible sources.

6. Check your sources to make sure your citations are in the proper format and include all the required information.

7. Take notes on the sources you cited. You may want to start a new document for each source. You may also want to find or create a form to take notes on each source.

8. Remember to save your documents frequently while you work.

9. Check with your teacher to make sure you have enough accurate and reliable information to answer your research questions.

10. Review the checklist and revise your notes to make sure they are complete.

11. Save all documents.

12. Share your notes.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about gathering information. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. What is a good way to get fewer hits by excluding information that is not relevant from your searches?

· Use NOT or a minus sign (-) [Correct! When you get hits that are not relevant, find a keyword that the irrelevant hits have in common. Then, use NOT or a minus sign with that keyword to exclude the irrelevant hits from your search.]
· Use OR between keywords [Try again. Using OR between keywords results in getting more hits.]
· Use AND between keywords [Try again. Using AND between keywords results in getting more hits.]
2. Which statement describes plagiarism?

· When you paraphrase another author and cite the source [Try again. You can paraphrase as long as you cite the source.]
· When you quote another author’s words and cite the source [Try again. You can quote another author’s words as long as you cite the source.]
· When you summarize another author and do not cite the source [Correct! You must cite your sources, even when you summarize.]
3. Why should you always make sure to adequately paraphrase a source as you take notes?

· To help ensure that you do not accidentally plagiarize the source [Correct! You may forget that you did not completely paraphrase the source when you begin writing.]
· To make your notes easier to organize and use later [Try again. Effective notes are easier to organize and use, but another answer is better.]
· To make it easier to cite the source when you begin writing [Try again. You should always cite the source of a note, regardless of whether you quote, paraphrase, summarize, or record facts or data.]
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Task: Develop at least two alternative choices for your decision.
Goal: Show that you can use graphic organizers to represent decision alternatives.

You may want to review an example of a graphic organizer before you begin.
See the example: Microsoft Word* | PDF
Key Concept

What have you accomplished so far in the decision making process? First, you defined an interesting and important decision around a complex topic. Then, you efficiently gathered accurate and reliable information from credible sources. You skillfully took objective and precise notes on the information that was relevant to your decision.

How can you use your notes to develop alternative choices for your decision? First, you need to organize the information you gathered. One effective strategy is to organize your information graphically. A graphic organizer helps you arrange many different pieces of information into a few logical ideas or concepts.
When you organize information, you create knowledge. Graphic organizers are an ideal tool for creating and visually representing knowledge. You also create knowledge when you develop alternative choices for a decision. You can use graphic organizers to show how decision alternatives are supported by accurate and reliable information.

You can use many different kinds of graphic organizers to develop decision alternatives. You may want to represent several alternatives on one graphic organizer. You can also represent each of your alternatives on separate graphic organizers. You can even use different types of graphic organizers to develop different kinds of alternatives.
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Words to Remember
This page gives basic definitions for some important terms that can help you learn about developing decision alternatives. You can get a more complete definition of each term from Fact Monster*.

New Words

Graphics: Using pictures and other visual elements to communicate information.

Knowledge: Understanding that is achieved through experience and thought.

Organize: Combine separate pieces of information into a logical whole.

Understanding: Ability to see the meaning and importance of ideas and concepts.

Review Words

Cite: Refer to a source of information, usually in a formal way.

Concept (or Idea): A thought that combines specific information into a general statement.

Conclusion: A judgment, decision, or solution reached for specific reasons.

Convergent: Moving toward one direction or having a limited number of answers.

Credible: A source you can trust to provide true information.

Data: Information collected by observation or measurement.

Dataset: A collection of data records.

Divergent: Moving in many directions or having many answers.

Evaluative: Requiring judgment to decide among various opinions or answers.

Fact: Information widely believed to be true and supported by objective data.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Paraphrase: Restate an author’s ideas using different words.

Plagiarism: Copying or making slight changes in a written or created work and presenting it as a new or original work.

Quote: Use another person’s exact words.

Research: Study a topic carefully using credible sources.

Source: Anything or anyone providing information about a topic.

Summarize: Explain the main points and important details of an author’s ideas.
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Learning from the Web

Graphic organizers come in a variety of types to meet a variety of purposes. Which graphic organizers should you use? The answer depends on the kind of information you have and the type of decision alternatives you want to develop. Explore some Web sites about graphic organizers. Learn which types of graphic organizers you should use for various purposes.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about graphic organizers, keep those in mind too.

Guiding Questions

· What are the strengths and weaknesses of various types of graphic organizers?

· Which graphic organizers are most appropriate for the information you collected?

· What types of graphic organizers could help you develop alternative choices?

Web Sites

· Graphic Organizers* from SCORE*

· Compare and Contrast*

· Clustering*

· Cycle*

· Fishbone*

· Interaction Outline*

· Problem/Solution*

· Spider Map*

· Venn Diagram*

· Graphic Organizers* from Education Oasis*

· Cause and Effect*

· Compare and Contrast*

· Sequence, Cycle, Time Line, and Chain of Events*

· Tools for Reading, Writing, and Thinking* from Greece Central School District*
· Samples* from www.GraphicOrganizers.com*
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What to Know
This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about developing decision alternatives. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Uses of Graphic Organizers

How can you use your notes to develop alternative choices for your decision? First, you need to organize the information you gathered. One effective strategy is to organize your information graphically. A graphic organizer helps you arrange many different pieces of information into a few logical ideas or concepts.
When you organize information, you create knowledge. Graphic organizers are an ideal tool for creating and visually representing knowledge. You also create knowledge when you develop alternative choices for a decision. You can use graphic organizers to show how decision alternatives are supported by accurate and reliable information.

You can use many different kinds of graphic organizers to develop decision alternatives. You may want to represent several alternatives on one graphic organizer. You can also represent each of your alternatives on a separate graphic organizer. You can even use different types of graphic organizers to develop different kinds of alternatives.

How to Graphically Organize Information

Graphic organizers are ideal tools for arranging many pieces of information into a few logical concepts or ideas. Different types of graphic organizers are used for different purposes. All graphic organizers show relationships among information, ideas, and concepts.

A graphic organizer is a visual representation of knowledge. You create knowledge when you develop alternative choices for a decision. You can use graphic organizers to show how decision alternatives are supported by accurate and reliable information.

Some common reasons for using a graphic organizer are:

· Cause and Effect. The fishbone is a popular graphic organizer for showing cause-and- effect relationships. The fishbone shows how different causes contribute to a particular effect. It can also show details about each cause. An interaction outline shows cause-and-effect relationships between two people or groups.

· Classify and Divide. A clustering diagram, also called a concept map or web, is an effective way to sort many pieces of information and group them into categories.

· Compare and Contrast. A simple compare-and-contrast organizer shows the characteristics of two items on a list of attributes. A Venn diagram is also a popular graphic organizer for comparing and contrasting two or more concepts or ideas. A Venn diagram shows what two or more concepts or ideas have in common. It also shows what they do not have in common.

· Definition. The spider map is an effective way to organize definitions. The topic to be defined is the “body” of the spider. The main characteristics and support details of the topic make up the “legs” of the spider.

· Process. Some graphic organizers represent special processes. For example, a problem-solution organizer shows possible solutions to a problem. It can also show the results of alternative solutions. A cycle organizer represents a process that runs in a continuous circle.

You must choose the type of graphic organizer to best help you accomplish your goals. If you are deciding whether to take personal actions to reduce global warming, for example, you would want to understand the causes and effects of climate change. You could also classify and divide possible personal actions to determine which action is best for you.

If you are deciding whether a species should be on the endangered list, you might want to compare and contrast the species with other endangered species. You could also use a graphic organizer to determine whether the species meets the definition of endangered.
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What to Do
Complete the following task to show what you have learned about developing decision alternatives. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a graphic organizer before you begin.

Task: Develop at least two alternative choices for your decision.

Goal: Show that you can use graphic organizers to represent decision alternatives.

See the example: Microsoft Word* or PDF

1. Start a new word processing document. Always remember to type your name, the date, and a title at the top of the document. You may use a drawing or diagramming application if you have access to one.

2. Save your document with a filename that indicates it contains your graphic organizer.

3. Decide what kind of graphic organizers are best for the information you gathered and the decision you defined around your topic. Check with your teacher to make sure you select appropriate organizers.

4. Create graphic organizers to represent alternative choices for your decision. You may want to use a table or the drawing features of your word processing application.

5. Remember to save your document often while you work.

6. Review the checklist and revise your graphic organizers to make sure it is complete.
7. Share your graphic organizers.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about using graphic organizers to develop decision alternatives. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. What type of graphic organizer is best for showing cause-and-effect relationships?

· Clustering [Try again. A clustering organizer separates items into categories.]
· Fishbone [Correct! A fishbone shows the causes of an effect.]
· Spider Map [Try again. A spider map is best for defining a central topic.]
2. What type of graphic organizer is best for comparing and contrasting?

· Clustering [Try again. A clustering organizer separates items into categories.]
· Spider Map [Try again. A spider map is best for defining a central topic.]
· Venn Diagram [Correct! A Venn diagram shows what two or more concepts or ideas have and do not have in common.]
3. What do all graphic organizers have in common?

· They compare and contrast. [Try again. Comparing and contrasting is one purpose of a type of graphic organizer, but other organizers have different purposes.]
· They show relationships. [Correct! Graphic organizers can show many kinds of relationships.]
· They show similarities. [Try again. Showing similarities is one purpose of a type of graphic organizer, but other organizers have different purposes.]
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Thinking about Learning

What have you learned in this module? You explored critical thinking skills and the decision making process. You explored how surveys collect data that can inform decision making. You defined a decision and gathered information to help you develop alternative choices for the decision.

You have learned:

· How to use critical thinking skills to make important decisions effectively

· How basic statistics can summarize survey data and inform decision making

· How to define an interesting and important decision around a complex topic

· How to gather accurate and reliable information from credible sources

· How to use graphic organizers to develop alternative choices for a decision
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Checklist for Decision Making
A checklist can help you keep track of your work throughout the activity. Have you completed the task in each activity? Use the checklist to make sure you are ready to create a survey to collect data on your topic. Ask your teacher for help if you have any questions about the checklist.
Activity 1: Thinking Skills

Task: Decision Analysis

· Read a news article about a current event

· Open a new word processing document and type your name, date, and a title

· Analyze the decision using critical thinking skills, by addressing the following questions:

· What is the decision and what can be accomplished by making this decision?

· What information would be useful to decision makers?

· What alternatives are available to decision makers?

· What are some possibilities of each alternative?

· What choice would you make among the alternatives?

· Check the spelling and grammar of your analysis

· Save your document

Activity 2: Survey Data

Task: Statistical Analysis

· Open a new word processing document and type your name, date, and a title

· Select a report that includes statistics on a topic that interests you

· Analyze the statistics, using critical thinking skills to address the questions:

· What decision could be made with this data?

· What information from this data is useful to decision makers?

· What are some alternatives that could be available?

· What are some possibilities of each alternative?

· What choice would you make among alternatives?

· Check the spelling and grammar of your analysis

· Save your document

Activity 3: Decision Definition

Task: Decision Definition

· Choose a topic that has an interesting and important decision

· Open a new word processing document and type your name, date, and a title

· Define the decision, using the following four steps:

· Brainstorm potential topics for your decision

· Evaluate the topics and choose one topic

· Narrow the focus of your topic to one specific decision

· Find sources to gather enough information to make the decision

· Write questions to guide your research, and address the following considerations:

· What information do you need to have to make the decision?

· What kinds of research questions will provide the information you need?

· What are some different points of view about the decision?

· What kinds of questions will help you understand the various points of view?

· Check the spelling and grammar of your document

· Save your document

Activity 4: Information Gathering

Task: Note-Taking

· Open a new word processing document and type your name, date, and a title

· Find credible sources on your topic

· Take notes on your topic to answer your research questions, and use a variety of note-taking strategies, such as:

· Quote

· Paraphrase

· Summary

· Facts and data
· Original ideas
· When taking notes, be sure to:

· Record the source of each note

· Use quotation marks when copying exact words

· Double-check that you have paraphrased or summarized adequately

· Quote short phrases or sentences in a paraphrase or summary, if necessary

· Save your document

Activity 5: Decision Alternatives

Task: Graphic Organizer

· Open a new word processing document and type your name, date, and a title

· Choose a graphic organizer to represent your decision alternatives, such as:

· Fishbone (for cause-and-effect relationships)

· Interaction outline (for cause-and-effect relationships)

· Clustering diagram, concept map, web (for classify and divide)

· Compare-and-contrast organizer (for compare and contrast)

· Venn diagram (compare and contrast)

· Spider map (definitions)

· Problem-solution organizer (process)

· Cycle organizer (process)

· Create a graphic organizer to represent alternative choices for your decision

· Save your document
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Rubric for Decision Making
The main purpose of a rubric is to help you do your best work. What column best describes your decision and information gathering? Is all of your work best described by column 4? If not, what could you improve?
	
	4
	3
	2
	1

	Decision Definition
	Decision is defined objectively, with clear understanding of different points of view.

A survey is the best way to approach the decision.

Decision is focused and interesting to others.

Questions provide original insights about important aspects of the decision.
	Decision is defined objectively, with understanding of different points of view.

A survey is a good way to approach the decision.

Decision is focused and interesting to most others.

Questions are relevant to the decision and address all important aspects of the topic.
	Decision is defined, but not objectively, and with a vague understanding of different points of view.

Approaches other than a survey are better for the decision.

Decision is focused but may not be interesting to others.

Questions are relevant to the decision, but they do not address some important aspects of the topic.
	Decision is not defined and point of view not understood.

A survey is not a good way to approach the decision.

Decision is too broad to be made effectively.

Many questions are not relevant to the decision.

	Information Gathering
	A variety of credible sources that provide accurate and reliable information are located.

Specific and relevant keywords are used to narrow search results and improve the quality of hits.

Notes use summaries, paraphrase, and direct quotes to capture detailed information related to research questions.
	At least two types of sources are located without assistance, and all sources are appropriate and credible.

General and relevant keywords are used to narrow search results and improve the quality of hits.

Notes use summaries or paraphrase, and direct quotes to capture general information related to research questions.
	At least two types of sources are located without assistance, but some sources may not be appropriate or credible.

Vague and relevant keywords are used to narrow search results and improve the quality of hits.

Notes use summaries or paraphrase to capture some information related to research questions.
	All appropriate and credible sources are located with assistance..

Keywords are not identified or not used.

Notes do not relate to research questions or do not summarize or paraphrase relevant information.

	Decision Alternatives
	Reasonable alternatives representing multiple points of view are identified and developed.

Different kinds of graphic organizers are used to develop decision alternatives from different points of view.

Graphic organizers show important concepts that clearly and logically explain all important aspects of the alternative.
	Reasonable alternatives from at least two points of view are identified and developed.

Appropriate graphic organizers are used to develop decision alternatives from at least two points of view.

Graphic organizers show information used to develop alternatives, but the alternatives may not be fully explained.
	Reasonable alternatives from a single point of view are identified and developed.

An appropriate graphic organizer is used to develop at least one decision alternative.

Graphic organizers show information used to develop alternatives, but some of the information may be inaccurate or irrelevant.


	Reasonable alternatives are not identified or developed.

Graphic organizers are not used or are not used appropriately.

Graphic organizers do not have a clear purpose or use inaccurate or irrelevant information.

	Writing Mechanics
	All words are spelled and capitalized correctly.

All sentences are punctuated correctly.
	Almost all words are spelled and capitalized correctly.

Almost all sentences are punctuated correctly.
	Several words are misspelled or capitalized incorrectly.

Several sentences are punctuated incorrectly.
	Many words are misspelled and capitalized incorrectly, making the information hard to understand.

Many sentences are punctuated incorrectly, making the information hard to understand.
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Reflection on Decision Alternatives
How can you make sure you really understand something? One of the best ways is to explain it to someone else. You might talk to another student, a teacher, or someone in your family.

Be prepared to discuss:

· What you learned about critical thinking and decision making

· How statistics summarizing survey results can inform decision making

· How you chose a topic and defined a decision

· How you gathered information and developed alternative choices for your decision

< Back to Rubric | Next to Data Collection >
	Type of Page 
	Level Two Content Page

	Supertitle
	Make Decisions with Data

	Headline Title
	Data Collection

	Third Level Tabs
	[6]


 [3rd level tabs]


Tab 1: [Survey Questions]


Tab 2: [Survey Administration]


Tab 3: [Database Basics]


Tab 4: [Database Planning]


Tab 5: [Database Tables]


Tab 6: [Look Back]

[TITLE HIGHLIGHT BOX 1 ON RIGHT]

Look Ahead

[highlight Box TEXT]

Checklist: Before you begin, review the checklist for this module. Use the checklist to make sure that you complete all the tasks for each activity.
See the checklist >
Rubric: Before you begin, review the rubric for this module. Use the rubric to help you understand what is important to know and do.

See the rubric >

Big Idea

What kinds of data can help you evaluate the possibilities of decision alternatives? You developed alternatives by gathering and organizing factual information. Because almost all decisions affect someone, people’s opinions are important data too. You can collect opinion data by writing and administering a survey. The data you collect may be useful both to you and other researchers and decision makers. A database is a collection of information organized so that you can quickly retrieve the specific information you need. A database application is a software program that specializes in storing and managing data for quick and easy retrieval. Learn how to use a database application and become an effective creator and user of databases.

In this module:

· Write effective survey questions to collect useful opinion data

· Follow basic guidelines that help you collect accurate opinion data

· Learn how database applications store and manage data

· Plan an effective design for your survey database

· Create database tables to store you survey data

Activity 1: Survey Questions >

What makes a survey question effective? Effective survey questions provide data that helps you make your decision. Critical thinking skills can help you determine what opinion data is relevant and write survey questions. Write effective survey questions to collect useful opinion data.

Activity 2: Survey Administration >

How you collect data is just as important as how you write the questions. You can usually collect the most data in the least time by asking respondents to complete and return a questionnaire. Follow basic guidelines that help you collect accurate opinion data.

Activity 3: Database Basics >

Have you ever used a database? Whether you know it or not, you probably use a database almost every day. Have you ever used a database application? Database applications are a little different from other technology tools. Learn how database applications store and manage data.

Activity 4: Database Planning >

Why plan a database for your survey? How easily information can be retrieved from a database depends entirely on how well the database is designed. Effective designs are based on the most efficient separation of data items. Plan an effective design for your survey database.

Activity 5: Database Tables >

Creating a database is a simple process when you begin with an effective design. Tables are the most fundamental objects in a database. You can create tables yourself or use a wizard to walk you through the process. Create databases tables to store you survey data.

Look Back >

Reflect on what you learned in this module. Are you ready to analyze your survey data? Use the checklist to make sure your tasks are complete. Use the rubric to assess your survey data. Talk about what you learned and how you did your work.
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Checklist for Data Collection
Checklists can help you keep track of your work. Use the following checklist to make sure you complete the task for each activity. If you have access to a printer, you may want to print the checklist for reference as your work through the activities. Ask your teacher for help if you have any questions about the checklist.
Activity 1: Survey Questions

Task: Survey Questions

· Open a new word processing document and type your name, date, and a title

· Write close-ended questions for your survey and be sure each question:

· Collects numerical data that is easy to analyze

· Includes three or four possible responses that are not too long

· Is not too long

· Write one or two open-ended questions and be sure each question:

· Provides detailed information or quotes

· Is limited to an idea or concept that cannot be adequately addressed with a close-ended 
question

· Be sure that all your survey questions:

· Collect data to help make a decision

· Do not favor any point of view

· Are easy to understand

· Ask one idea per question

· Do not influence the answers

· Make sure that your questionnaire:

· Is as short as possible

· Lists questions in a logical order

· Does not list questions in an order that influences answers

· Includes basic demographic questions

· Consider the following questions:

· How will survey data help you make the decision you have defined?

· What information from this data would help make the decision?

· What are some alternatives that could be chosen?

· What are some possibilities of each alternative?

· What choice would you make?
· Check the spelling and grammar of your survey questions

· Save your document

Activity 2: Survey Administration

Task: Survey Respondents

· Open your survey questions

· Exchange and review a peer’s questionnaire, provide specific feedback, and consider your peer’s feedback

· With a peer, open a new word processing document and type your names, date, and a title

· Determine your population and select a representative sample

· Determine how you will deliver the questionnaire: printed copies, e-mail, or the Web

· Deliver the survey to your sample

· Be sure to explain the purpose of your survey

· Collect the questionnaires from your sample

· Save your completed questionnaires
Activity 3: Database Basics

Task: Database GUI Explanation

· Open a new word processing document and type your name, date, and a title

· Identify and describe five menu options on a database application that can help you manage your survey data

· Save your document

Activity 4: Database Planning

Task: Database Design
· With your partner, open a new word processing document and type your name, date, and a title

· Design a database, in your word processing application, with at least two tables to store and manage your and your partner’s survey data

· Follow these steps to plan your database:

· Consider your purpose

· Group data into tables

· Define fields for each table

· Identify primary keys for each table

· Test your tables with sample data

· Revise the design

· Discuss the questions:

· How will your survey data help you make the decision you have defined?

· What information from this data would be useful to decision makers?

· Save your document

Activity 5: Database Tables

Task: Database
· With your partner, start a new database

· Use your database design to:

· Create tables and define the fields:

· Give a descriptive name to the field

· Select the type of data for the field

· Describe the data

· Set the primary key for each table

· Use an automatically generated number to identify each respondent

· Enter answers of up to five respondents

· Check that all data is entered and visible in the tables

· Save your tables
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Rubric for Data Collection
The main purpose of a rubric is to help you do your best work. Use the rubric to make sure you understand what you are expected to learn. Is all of your work best described by column 4? If not, what can you improve? If you have access to a printer, you may want to print the rubric for reference as your work through the activities. Ask your teacher for help if you have any questions about the rubric.
	
	4
	3
	2
	1

	Survey Questions
	All questions are precise and clearly provide information relevant to important concepts that can be used to draw logical conclusions.

All close-ended questions and answer choices are concise and complete.

Open-ended questions are carefully worded to provide detailed information about important or complex ideas and concepts. 
	Most questions are precise and clearly provide information relevant to important concepts that can be used to draw logical conclusions.

Most close-ended questions and answer choices are concise and complete.

Open-ended questions address important or complex ideas and concepts.
	Some questions are precise and clearly provide information relevant to important concepts that can be used to draw logical conclusions.

Close-ended questions are concise and complete, but there are too many or too few answer choices.

Open-ended questions do not address important or complex ideas and concepts.
	Very few questions have a clear purpose or provide information relevant to important concepts that can be used to draw logical conclusions.

Close-ended questions are too long to understand or too short to be complete.

Open-ended questions are missing or unnecessary.

	Database

Tables
	Data is clearly and logically organized into tables 
that are related by an appropriate primary key.

Tables are formatted so they are attractive and easy to view, and the collected data is easy to understand.
	Data is logically organized into tables that are related by an appropriate primary key.

Tables are easy to view, titles of records and fields are easy to read, and the collected data is presented clearly.
	Data is logically organized into tables, but the tables are not related by a primary key.

Tables are easy to view and titles of records and fields are easy to read, but the collected data is not presented clearly.
	Data is poorly organized, and either too many or too few tables are used.

Tables are difficult to view or titles of records and fields are missing or difficult to read.

	Writing Mechanics
	All words are spelled and capitalized correctly.

All sentences are punctuated correctly.
	Almost all words are spelled and capitalized correctly.

Almost all sentences are punctuated correctly.
	Several words are misspelled or capitalized incorrectly.

Several sentences are punctuated incorrectly.
	Many words are misspelled and capitalized incorrectly, making the information hard to understand.

Many sentences are punctuated incorrectly, making the information hard to understand.

	Database

Basics
	Data is entered and tables are formatted accurately.

Advanced database features and terminology are used correctly.
	Data is entered and tables are generally formatted accurately.

Basic database features and terminology are used correctly.
	Data is entered and tables are created without assistance, but there may be some inaccuracies.

Basic database features are not used to format tables.
	Data is entered and tables are created with much assistance. 

	File Management
	Files are clearly named, consistently saved to the correct location, and well-organized in folders.
	Files are clearly named and consistently saved to the correct location, but they are not well-organized in folders.
	Work is not lost, but files are not clearly named or not consistently saved to the correct location.
	Work is lost because files are not clearly named or not consistently saved to the correct location.
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Task: Create a questionnaire for your survey.

Goal: Show that you know how to write effective survey questions.

You may want to review an example of survey questions before you begin.

See the example:
Microsoft Word* | PDF
Key Concept

What makes a survey question effective? A survey is a formal way to collect data on people’s opinions. Effective survey questions provide data that helps you make decisions. Complex decisions often call for several different kinds of data.

One of the keys to creating an effective survey is writing effective questions. Two basic types of survey questions are close-ended and open-ended. Each type has advantages and disadvantages. Both types must be carefully written to be effective. The list of questions to be asked in a survey is called a questionnaire.

When conducting a survey, collect some basic information about your respondents. This type of information is called demographic data. Demographic data will allow you to analyze how people with certain characteristics responded to your survey questions.

How can you make sure a survey gives you the data you want? Does it make any difference how you ask questions? How you ask questions and put them together in your questionnaire can have a significant influence on the answers you get. Critical thinking skills can help you write effective survey questions and put together effective questionnaires.
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Words to Remember

This page gives basic definitions for some important terms that can help you learn about survey questions. You can get a more complete definition of each term from Fact Monster*.

New Words

Bias: Tendency to favor one particular point of view. 
Close-ended: A type of question that has a limited number of answers from which to choose.

Open-ended: A type of question that allows for several different, detailed answers.

Questionnaire: A list of questions asked in a poll or survey.

Respondent: A person who answers questions in a poll or survey.

Survey: Gather facts and opinions from a sample population by asking questions.

Review Words

Accurate: Careful to provide true information.

Complex: Consisting of many parts that are connected or related to one another.

Concept (or Idea): A thought that combines specific information into a general statement.

Conclusion: A judgment, decision, or solution reached for specific reasons.

Critical: Careful to evaluate information and draw correct conclusions.

Data: Information collected by observation or measurement.

Dataset: A collection of data records

Decision: A choice made after considering available alternatives.

Demographics: Basic statistics about a human population. For example, age, gender, race, residence, education, and income.

Fact: Information widely believed to be true and supported by objective data.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Logical: Capable of thinking in a clear and consistent way to draw correct conclusions.

Objective: Able to put aside personal feelings and opinions.

Opinion: Beliefs that may or may not be supported by facts.

Point of View: The way a person tends to think about people, places, and events based on individual experiences.

Precise: Careful to provide only accurate and relevant information.

Reflective: Careful to focus on thinking about important ideas and concepts.

Relevant: Provide important information about a particular topic.

Statistics: Facts and data that can be represented by numbers; also the study of numerical facts and data.
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Learning from the Web

When conducting a survey, writing effective questions is important. You want to make sure you understand how the people you survey think about your topic. Explore some Web sites about writing effective questions for a survey. Learn how to write effective questions.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions that could help you create a more effective questionnaire, keep those in mind too.

Guiding Questions

· What kinds of questions should you ask in your survey?

· What kinds of questions should you avoid?

· What characteristics do most effective questions have in common?

Some of these Web sites are quite advanced. Do not worry if you cannot understand everything that you read. Exploring every Web site listed is not necessary. Find one or two Web sites that you can explore to answer the guiding questions.

Web Sites

· Types of Survey Questions* from the Encyclopedia of Educational Technology*

· How to Write a Good Survey* from InfoPoll*

· Survey Questions* from the SuperSurvey Knowledge Base*
· Constructing the Survey* from the Center for Social Research Methods*

· Types of Questions*

· Question Content*

· Response Format*

· Question Wording*

· Question Placement*

· 20 Top Tips To Writing Effective Surveys* from Survey Galaxy*
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What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about survey questions. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Guidelines for Effective Surveys

One of the keys to creating an effective survey is writing effective questions. The two basic types of survey questions are close-ended and open-ended. Each of these types has advantages and disadvantages. Both types must be carefully written to be effective. The list of questions to be asked in a survey is called a questionnaire.

Close-Ended Survey Questions

Close-ended questions simplify data collection because they have a finite number of possible answers. Effective close-ended questions:

· Collect numerical data that is easy to analyze

· Give three or four logical answer choices for each question

· Avoid very long questions or answers

Open-Ended Survey Questions

Open-ended questions can provide more detailed information, but they may require more time and effort. Open-ended questions should only be asked when detailed information is really needed. Open-ended questions are often useful in collecting data that can help you understand how respondents answered your close-ended questions. Effective open-ended questions:

· Provide detailed information or quotes

· Are limited to ideas or concepts that are too important or too complex to understand adequately with close-ended questions

Effective Survey Questions

Both close-ended and open-ended questions are effective only when they are carefully written. No strict rules exist for writing effective survey questions, but some basic guidelines help in most cases. Effective survey questions:

· Collect data that helps you make a decision

· Do not favor any point of view

· Are easy for respondents to understand

· Ask about only one idea in each question

· Do not influence the answers given by respondents

Effective Survey Questionnaires

Once you have written effective questions, you must think carefully about how to put the questions together on your questionnaire. No strict rules exist for creating an effective questionnaire, but some basic guidelines help in most cases. Effective survey questionnaires:

· Are as short as possible without sacrificing important information

· List questions and answers in a logical order

· Do not list questions in an order that influences the answers

· Include basic demographic questions relevant to the decision you defined
Thinking Critically About Survey Questions
Critical thinking skills can help you write effective survey questions and put together effective questionnaires. For example:

· Clear and precise thinking helps you write questions that are easy to understand.

· Write questions that provide accurate data that is directly relevant to your decision.

· Being objective and consistent helps you treat different points of view with fairness.

· Logical thinking helps you put together a questionnaire that does not confuse respondents.

· Being persistent helps ensure that you collect enough data to make your decision.

· Being reflective helps you keep an open mind and revise questions when needed.
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What to Do

Complete the following task to show what you have learned about survey questions. While you work through the task, think about whether you are achieving the goal. You may want to review an example of survey questions before you begin.
Task: Create a questionnaire for your survey.

Goal: Show that you know how to write effective survey questions.

See the example: Microsoft Word* or PDF

1. Start a new word processing document. Always remember to type your name and the date at the top of the document.

2. Type a title for the document. You may want to include your topic, such as Survey Questions for ______________.
3. Write some close-ended questions on your decision. Make sure they can be answered by other students at your school.

4. Create a list of three of four possible responses for each question. Make sure the possible responses cover any answer that someone might give.

5. Write one or two open-ended questions on your topic. Make sure they provide important information that you could not get with a close-ended question.

6. Remember to save your document often while you work.

7. Review your questions to see if they follow the guidelines for effective questions. Revise questions that do not follow the guidelines.

8. Check with your teacher to make sure your survey questions are effective. Be prepared to answer the following questions:

· How will survey data help you make the decision you have defined?

· What information from this data would help make the decision?

· What are some alternative that could be chosen?

· What are some possibilities of each alternative?

· What choice would you make?

9. Check the spelling and grammar of your survey questions.

10. Double-check your work by reading the document carefully one more time.

11. Review the checklist and revise your survey questions to make sure they are complete.

12. Share your survey questions.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about survey questions. Your answers are not recorded, and the quiz is not scored.

Please read all possible answers first, and then choose the best answer.

1. A biased question _____.

· Has answer choices that are not logical [Try again. You should provide logical answer choices, but illogical answer choices do not necessarily make a question biased.]
· Asks about more than one idea [Try again. You should ask about one idea per question, but asking about more does not necessarily make a question biased.]
· Favors one opinion or point of view over others [Correct! Creating survey questions that are free from bias is extremely important.]
2. What is the main advantage of close-ended questions?

· Their answers are long and detailed. [Try again. The answers to close-ended questions should be short and precise.]
· They provide data that can be easily analyzed. [Correct! Answers to close-ended questions can easily be entered into a computer and analyzed.]
· They are easier for people to answer. [Try again. Some people may find that answering close-ended questions is easier than answering open-ended questions, but this is not the main advantage of close-ended questions.]
3. What is the main advantage of open-ended questions?

· Their answers are long and detailed. [Correct! The answers to open-ended questions provide detailed information about important or complex ideas or concepts.]
· They provide data that can be easily analyzed. [Try again. Answers to open-ended questions cannot be easily entered into a computer and analyzed.]
· They are easier for people to answer. [Try again. Some people may find that answering open-ended questions is easier than answering close-ended questions, but this is not the main advantage of open-ended questions.]
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Task: Work with a partner to administer your surveys.

Goal: Show that you can collect accurate survey data to inform your decision.

You may want to review an example of a completed questionnaire before you begin.
See the example:
Microsoft Word* | PDF
Key Concept

Now that you have created a survey questionnaire, how will you use it to collect data? Writing effective questions is only part of the survey process. How you collect the data is just as important as how you write questions. Remember that you are collecting data to help you make a decision. You need the most accurate data you can possibly collect.

Survey data can be collected in two ways. You can interview respondents or you can give respondents the questions to read and answer themselves. Interviews usually take more time but can provide more detailed data. Questionnaires usually take less time and often enable you to collect data from more respondents.

Either way, you can choose from a variety of methods of asking your questions and collecting answers. Interviews can be conducted in person or by telephone. Questionnaires can be delivered by hand, through e-mail, or on the Web. The method you choose depends on your respondents and your purpose.

Following some basic guidelines for administering a survey helps you collect accurate data. First, identify the population of people from whom you want to collect data. Second, select representative members from the population to complete your questionnaire. Then, you are ready to decide the best method to collect data from the representative sample.
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Words to Remember
This page gives basic definitions for some important terms that can help you learn about survey administration. You can get a more complete definition of each term from Fact Monster*.

New Words

Administer: Apply or manage a process in a formal way.

Convenience: An appropriate and practical way to accomplish a particular purpose.

Interview: Meet or talk with another person to gather information by asking questions.

Pilot: A test or trial completed as practice or preparation for an event.

Probability: The possibility of an event expressed as a ratio. For example, the probability of a tossed coin landing heads-up is one in two (1:2, 1/2, or 0.5).

Professional: Meeting standards of behavior appropriate for work places.

Random: A process that gives every member of a population an equal probability of being selected from a population.

Representative: Providing an example of main characteristics of a group or acting on behalf of the group.

Review Words

Bias: Tendency to favor one particular point of view. 

Close-ended: A type of question that has a limited number of answers from which to choose.

Data: Information collected by observation or measurement.

Dataset: A collection of data records.

Demographics: Basic statistics about a human population. For example, age, gender, race, residence, education, and income.

Fact: Information widely believed to be true and supported by objective data.

Opinion: Beliefs that may or may not be supported by facts.

Open-ended: A type of question that allows for several different, detailed answers.

Population: All members of a specific group.

Questionnaire: A list of questions asked in a poll or survey.

Respondent: A person who answers questions in a poll or survey.

Sample: One part of a population that represents the whole population.

Statistics: Facts and data that can be represented by numbers; also the study of numerical facts and data.

Survey: Gather facts and opinions from a sample population by asking questions.
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Learning from the Web

Survey data can be collected in two ways. You can interview respondents or you can give respondents the questions to read and answer themselves. Explore some Web sites about administering a survey. Learn how to collect data with a questionnaire.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions that will help you collect data, keep those in mind too.
Guiding Questions

· What are some ways to administer a survey?

· What are the advantages and disadvantages of interviews and questionnaires?

· What are the advantages and disadvantages of printed, e-mailed, and online questionnaires?

Some of these Web sites are quite advanced. Do not worry if you cannot understand everything that you read. Exploring every Web site listed is not necessary. Find one or two Web sites that you can explore to answer the guiding questions.

Web Sites

Survey Administration

· Survey Research* from the Center for Social Research Methods*

· Types of Surveys*

· Selecting the Survey Method*

· Survey Basics: Data Collection* from the United States Census Bureau*

· How Market Research Works: Other Alternatives* from How Stuff Works*

Online Survey Tools

· Survey Monkey*

· Survey Console
· Free Online Surveys*
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What to Know
This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about administering a survey. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.
Administering a Survey

Surveys can be administered in two basic ways, through personal interviews or questionnaires. Both of these ways can be used in different variations. The method you choose to administer your survey depends on whom you are surveying and your purpose.

Interview

Interviews can be relatively informal discussions among a group of people or they can be highly structured question-and-answer sessions between an interviewer and a single respondent. They may take place in person or by telephone.

One important advantage of personal interviews is that you can often collect more detailed data. For example, you can ask follow-up questions to clarify a respondent’s answers. You may also be able to detect subtle clues in a respondent’s voice or body language. The main disadvantage of interviews is that they require a lot of time to conduct.

Questionnaire
Questionnaires can be delivered in different ways as well. Printed questionnaires can be handed out to respondents and collected by hand or mailed to respondents and returned by mail. An electronic questionnaire can be e-mailed to respondents and returned by e-mail. You can also create an online questionnaire and notify respondents of its Web address.

The main advantage of questionnaires is that you can collect data from more respondents more quickly than interviews. In the real world, questionnaires are usually much less costly to administer than interviews because they take much less time. Electronic or online questionnaires are usually the least costly because they do not require postage.

Guidelines for a Successful Survey

Administering a survey effectively requires some special knowledge and skills. Here are some guidelines that will help you collect valuable data:

· Identify a population. A population is a group of people from whom you want to collect facts and opinions. For example, all seventh grade students in your school make up a population. Any group of people can make up a population. How you identify the population for your survey depends on your purpose. You need to determine the group of people who would be affected by the decision you have defined. In most cases, that group would be the population you would want to survey.

· Select a representative sample. A sample is made up of the members of a population that you will ask to complete your questionnaire. If your population is small and accessible, you can sample the whole group. For example, you could ask all seventh-grade students in your school to complete your questionnaire. However, you could not realistically ask all seventh-grade students in the world to take your survey. Furthermore, surveying all the seventh-graders in the whole world would be unnecessary, provided that your sample is sufficiently representative of the population. The most representative samples are chosen randomly from a population. If you do not have access to all members of a population, you can use a sample that is as representative as possible.

· Prepare questionnaires. Determine the best method for delivering your questionnaire to respondents and collecting the completed surveys. If you are handing out or mailing a printed questionnaire, make sure you have enough copies for your sample. If you are e-mailing your questionnaire, make sure you have the capability to send and receive responses. If you are putting the questionnaire online, make sure you can inform your sample of the Web address and collect and access the data they provide.

· Conduct a pilot test. You should always conduct a pilot test of your questionnaire if possible. Give your questionnaire to one or two respondents. In this test run you can instruct respondents to tell you if any of the questions are confusing. A pilot test gives you a chance to make sure you get the data you want before you survey your sample.

· Deliver the survey. Provide your sample with enough information to complete and return your questionnaire as conveniently as possible. Make sure respondents know the purpose of your research. How well respondents answer your questions depends in part on how well you inform them about your purpose. You want to make sure that respondents are comfortable enough to give accurate answers.

· Collect the data. Collect as many completed questionnaires from your sample as possible. When printed questionnaires are collected, keep them together in a safe place. When you conduct an e-mail or online survey, be sure to make a backup copy of the data.
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What to Do
Complete the following task to show what you have learned about administering a survey. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a completed questionnaire before you begin.

Task: Work with a partner to administer your surveys.

Goal: Show that you can collect accurate survey data to inform your decision.

See the example: Microsoft Word* or PDF

1. Exchange questionnaires with a peer and complete each other’s surveys. Try to find a partner whose topic and decision are similar to yours, if possible. Your teacher may assign you a partner or may ask you to find a partner.

2. Review your peer’s questionnaire. Make sure you clearly understand all questions. Point out the questions that are especially well-crafted and the questions that may need to be revised. Try to offer specific suggestions for improvement.

3. Read the peer review of your questionnaire. Remember to put aside personal feelings and opinions. Consider each suggestion carefully from your peer’s point of view.

4. Still working with your partner, start a new word processing document. Type your names and the date at the top of the document.

5. Type a title for the document. You may want to include both of your topics, such as Survey Questions for _____________ and _____________.
6. Determine what population you want to sample. Make sure that your sample is as representative of the population as possible, provided you can get quick responses.

7. Check with your teacher to determine how you will deliver your questionnaire. You may use printed copies, e-mail, or the Web.

8. Deliver your questionnaire to the people in your sample. Your teacher may arrange for the people in your sample to complete the questionnaire or ask your team to manage the delivery and collection of questionnaires.

9. Collect the questionnaires that have been completed by your respondents.

10. You may want to look at some of the completed questionnaires. Were most respondents able to answer all of your questions? Did your respondents answer most questions the way you thought they would?

11. Review the checklist and revise your survey administration to make sure it is complete.

12. Store the completed questionnaires in a safe place so you can use the data later.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about administering surveys. Your answers are not recorded, and the quiz is not scored.

Please read all possible answers first, and then choose the best answer.

1. What is the main advantage of questionnaires?

· They allow you to get more detailed information. [Try again. Interviews are usually the best way to collect data when you need very detailed information.]
· They are more professional. [Try again. Any way you collect data should be equally professional.]
· They take very little time to conduct. [Correct! Questionnaires can be completed by more people in far less time than interviews.]
2. For a decision that affects a whole community, you should collect data from _____.
· Every member of the community [Try again. Unless the community is very small, collecting data from all members is unnecessary.]
· Randomly selected community members [Correct! Randomly selected community members provide the most representative sample of the population.]
· Your family and friends who live in the community [Try again. Collecting data from your family and friends may be convenient but this approach probably will not represent the whole community.]
3. Which method of administering a survey is usually quickest?

· Interviewing respondents in person [Try again. Interviewing in person usually takes the most time.]
· Mailing questionnaires to respondents [Try again. Mailing questionnaires to respondents, who must then mail them back, requires several days.]
· Posting a questionnaire on the Web [Correct! Respondents can be notified of a survey’s Web address by e-mail and responses can be collected as soon as the questions are answered.]
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Task: Describe five menu options in your database application’s graphical user interface.

Goal: Explain how you can use these five options to manage your survey data.

You may want to review an example of a database GUI explanation before you begin.
See the example:
Microsoft Word* | PDF
Key Concept

Have you ever used a database? You almost certainly have, even if you did not realize it. A database is a collection of information organized so that you can quickly retrieve the specific information you need. Search engines are databases, whether they search the Web, an electronic reference source, or the collection of a library.

Have you ever used a database application? If not, a database application may seem a little different from other technology tools you have used. Database applications specialize in storing and managing data on a computer for quick and easy retrieval. Once you know how to use a database application, you can create databases and use them more effectively.

Database applications store data in tables made up of rows and columns, similar to a worksheet in a spreadsheet application. In database terminology, the rows contain records and the columns contain fields. In a survey database, each record contains the data collected from one respondent and each field contains the answers of all respondents to one question.

Database applications are different from many other software programs because a single database file contains more than one type of object. Most database applications include at least four types of objects—tables, queries, forms, and reports. However, tables are the most fundamental object in any database. For now, just focus on learning how tables work.
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Words to Remember
This page gives basic definitions for some important terms that can help you learn about databases. You can get a more complete definition of each term from Fact Monster*.

New Words

Application: A computer program designed for a specific purpose.

Cell: A single box at the intersection of one row and one column in a worksheet.

Column: A line of cells going up and down, or vertically.

Database Application: An application designed to store and manage a collection of information so it can be quickly and easily searched and sorted.

Field: A distinct item of information stored in a database and making up part of a record.

GUI (Graphical User Interface): A set of menus and icons that makes an application easier for people to use.

Icon: A picture that represents a specific action for a computer to take.

Program: A set of instructions for a computer to perform.

Record: A distinct unit for which information is stored in the fields of a database.

Row: A line of cells going side to side, or horizontally.

Spreadsheet: An application designed to analyze and represent data.

Word Processing Application: A software application designed to create documents.

Workbook: A computer file created with a spreadsheet application and containing one or more worksheets.

Worksheet: A table with rows and columns with cells into which data and formulas can be entered.

Review Words

Data: Information collected by observation or measurement.

Database: A collection of information organized and stored on a computer so it can be quickly and easily searched and sorted.

Dataset: A collection of data records.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Survey: Gather facts and opinions from a sample population by asking questions.
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Learning from the Web

Database applications are designed to store and manage collections of information so that information can be quickly and easily searched. They store data in tables made up of rows and columns, similar to a worksheet in a spreadsheet application. In database terminology, the rows contain records and the columns contain fields.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about databases, keep those in mind too.

Guiding Questions

· How is a database application similar to, and different from, other applications?

· How does a database application store and manage data?

· How can you use a database application to manage your survey data?

Some of these Web sites are quite advanced. Do not worry if you cannot understand everything that you read. Exploring every Web site listed is not necessary. Find one or two Web sites that you can explore to answer the guiding questions.

Web Sites

· Database* from NC Wise Owl*

· Introduction to Databases* from Penn State University*

· Databases from Scratch I: Introduction* from Geek Girls*

· Database Fundamentals* from About*

· Database vs. Spreadsheet Is No Contest* from The Phoenix Business Journal*
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What to Know
This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about databases. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Using a Database Application

A database is a collection of information organized and stored on a computer so that the information can be quickly and easily searched. Database applications are similar to spreadsheet applications, but they also have important differences. If you have not used a spreadsheet application recently, you may want to review spreadsheet basics.

Database applications store data in tables made up of rows and columns, similar to worksheets in spreadsheet applications. Just as one workbook in a spreadsheet application may contain many worksheets, one database may contain many tables. In database terminology, rows contain records and columns contain fields.
A record is all the information in a database that pertains to one person, place, or thing. In a survey database, each record contains the data collected from one respondent. A field is one distinct item of information in each of the records. In a survey database, each field contains an answer provided by a respondent to one question.

Database applications have a graphical user interface (GUI). A database GUI is very similar to the GUIs in applications you have probably used more frequently, such as word processing and spreadsheet applications. The interface provides menus that list the actions a user can take. The GUI also provides icons that represent commands on the menus. Icons are grouped together in toolbars.

Database Table Menus
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Using the Toolbar

The icons for commonly used options on different menus are gathered together on the Database toolbar. The advantage of the toolbar is that you can select a menu option with one click. You do not have to open a menu first and then select an option.
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The Database toolbar allows you to start a new database file, open an existing database, and save changes to a database file. You can preview how a database object looks when printed and print the object. You can also cut, copy, and paste data from the toolbar.
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Working with Spreadsheet Applications

A spreadsheet is basically a table made up of rows and columns. The intersection of each row and column creates a cell that can hold data. Spreadsheet applications specialize in analyzing and representing data.

A single spreadsheet is sometimes called a worksheet. A spreadsheet file, sometimes called a workbook, can contain multiple worksheets. For example, you could have a worksheet for each month of the year, with all 12 worksheets saved in one workbook. Spreadsheet applications can perform calculations on data in any cell in the same worksheet, another worksheet in the same workbook, or even a worksheet in a different file.

Spreadsheet applications have a graphical user interface (GUI). A spreadsheet GUI is very similar to the GUIs in applications you have probably used more frequently, such as word processing applications. The interface provides menus that list the actions a user can take. The GUI also provides icons that represent commands on the menus. Icons are grouped together in toolbars.
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Using the Toolbar

The icons for commonly used options on different menus are gathered together on the Standard toolbar. The advantage of the toolbar is that you can select a menu option with one click. You do not have to open a menu first and then select an option.
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The Standard toolbar allows you to start a new file, open an existing file, save changes to a file, and print a file. You can cut, copy, and paste from the Standard toolbar. You can insert a hyperlink or a function to compute a sum or perform other calculations. You can also check spelling from the Standard toolbar.
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What to Do
Complete the following task to show what you have learned about a database application. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a database GUI explanation before you begin.

Task: Describe five menu options in your database application’s graphical user interface.

Goal: Explain how you can use these five options to manage your survey data.

See the example: Microsoft Word* or PDF

1. Explore the graphical user interface of your database application. Identify five menu options you can use to manage your survey data.

2. Start a new word processing document. Always remember to type your name, the date, and a title at the top of the document.

3. Describe the five menu options you identified. Explain how these options can help you manage your survey data.

4. Remember to save your document often while you work.

5. Review the checklist and revise your document to make sure it is complete.

6. Share your descriptions.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about databases. Your answers are not recorded, and the quiz is not scored.

Please read all possible answers first, and then choose the best answer.

1. What are the main parts of a graphical user interface (GUI)?

· Files, menus, and toolbars [Try again. Files are not part of a GUI.]
· Menus, icons, and toolbars [Correct! The purpose of menus, icons, and toolbars is to make it easy for people to use the application.]
· Toolbars, menus, and views [Try again. You can change how a GUI looks but views are not a main part of a GUI.]
2. What menu allows you to change the appearance of the data in a table?

· Edit [Try again. The Edit menu contains commands for changing the data itself but not for changing how it looks.]
· Format [Correct! The Format menu controls the appearance of the contents of a database table.]
· View [Try again. The View menu controls how the GUI looks and how the table itself is displayed but not the contents of the table.]
3. What part of a database’s GUI allows you to cut or copy data from one record and paste the data into another record?

· Edit menu [Try again. You can cut and copy from the Edit menu, but a better answer is available.]
· Standard toolbar [Try again. You can cut and copy from the Standard toolbar, but a better answer is available.]
· Both of the above [Correct! The Cut, Copy, and Paste commands are on the Edit menu and the Standard toolbar.]
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Task: Working with your partner, design a database to store and manage your survey data.

Goal: Show that you understand basic database principles by creating an effective database design.

You may want to review an example of a database design before you begin.

See the example:
Microsoft Word* | PDF
Key Concept

The first step in creating a database is thinking about the information you want to manage. Why should you plan a database to manage your survey? Why not just start a new database file and enter your survey data?

Suppose you create a database to manage information about students in your class. In the first field, you enter each student’s first and last name. Your teacher asks you to sort the database in alphabetical order by last name. Do you see the problem? If you create one field for names, then you can only sort by the first name.

The solution is to break down your information into the smallest meaningful data items. Then, create a field for each data item. For example, if you create separate fields for first name and last name, then you can sort the student data by either first names or last names.
Once you break your information down into the smallest meaningful data items, you still have some important questions to answer. Do you have information about different topics or different aspects of a topic? If so, you may need to create more than one table. What tables do you need and how will they be related? What fields will each table contain? You must also tell the database what type of data each field stores, such as numbers, short text, or long text.

Next to Vocabulary >

[PRORAMMING INSTRUCTIONS]
The content below is available for translation and located on the Technology Literacy File Sharing site under the Content and Files Tab > Explain > Make Decisions with Data Examples

	Microsoft* Word


	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/DC_DatabasePlanning_Example.doc

	PDF
	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/DC_DatabasePlanning_Example.pdf


	Type of Page 
	Level 4 Content Page

	Supertitle
	Data Collection | Database Planning

	Headline Title
	Vocabulary


[left-hand nav TEXT]

Vocabulary

Exploration

Information

Task

Quiz

Words to Remember

This page gives basic definitions for some important terms that can help you learn about database planning. You can get a more complete definition of each term from Fact Monster*.

New Words

Boolean: A type of data that can have only one of two values, such as true or false.

Datum: A single piece of information, such as a fact or statistic, which cannot be divided into smaller pieces.

Primary Key: A field with no duplicate values; that is, no two records in the database have the same value.

Relational Database: A database with more than one table that uses primary keys to relate information stored in one table to information stored in other tables.

Review Words

Application: A computer program designed for a specific purpose.

Data: Information collected by observation or measurement.

Database: A collection of information organized and stored on a computer so it can be quickly and easily searched and sorted.

Database Application: An application designed to store and manage a collection of information so it can be quickly and easily searched and sorted.

Dataset: A collection of data records.

Field: A distinct item of information stored in a database and making up part of a record.

GUI (Graphical User Interface): A set of menus and icons that makes an application easier for people to use.

Icon: A picture that represents a specific action for a computer to take.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Program: A set of instructions for a computer to perform.

Record: A distinct unit for which information is stored in the fields of a database.
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Learning from the Web

Why should you take the time to plan a database? Planning a database almost always saves time in the long run. You can begin by breaking your information down into the smallest meaningful data items. Then, create a field for each data item. What other questions should you answer when you plan a database?

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about planning a database, keep those in mind too.

Guiding Questions

· What should you remember when you plan a database?

· What are some possible benefits of creating a database for your survey data?

· How can you use what you learn to plan your survey database?

Some of these Web sites are quite advanced. Do not worry if you cannot understand everything that you read. Exploring every Web site listed is not necessary. Find one or two Web sites that you can explore to answer the guiding questions.

Web Sites

· Plan Your Tables* from Microsoft*

· Designing a Database* Rutgers-Camden*

· Databases from Scratch II: Simple Database Design* from Geek Girls*

· Databases from Scratch III: The Design Process* from Geek Girls*

· Database Keys* from About*
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What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about planning a database. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Guidelines for Planning a Database

Planning is perhaps the most important part of creating a database. Critical thinking skills can help you design an effective database. 
Six basic planning steps can help you design a database that is effective and efficient:

1. Consider your purpose. Remember that you collected survey data to inform the decision you defined. Review the decision alternatives that you developed. You want to make sure that your database will help you evaluate those alternatives.

2. Group data into tables. Sort your survey data into logical groups based on how the information serves your purpose. Try to assign each data item to only one table so that you do not waste storage space in the database. Information that falls into several groups should usually be sorted into a separate table. Give each group a distinctive name, which is the name of a table in your database.

3. Define fields for each table. Break your information to be stored in each table down into the smallest meaningful items. Make a list of every datum, or single item of data, that you want to store in each table. Define your fields by giving each datum a distinctive name. Describing the data in a field will make your database easier to use later and help other people understand your data. Determine the type of data that each field stores. The most common data types include:

· Text fields store shorter text data, usually up to 255 characters.

· Memo fields store longer text data, usually up to tens of thousands of characters.

· Number fields store most numbers, although you can set the field size property to specific kinds of numbers, such as integers and decimals. You can also change the appearance of numbers in a field with the format property.

· Date/Time fields store dates and times. You can change the way dates and times are displayed in a field with the format property.

· Currency fields store amounts of money. You can change the way currency data is displayed in a field with the format property.

· Yes/No (Boolean) fields store data than can have only one of two values, yes (1) or no (0).

4. Identify primary keys for each table. Make sure that every record in each table can be uniquely identified. If you have defined a field that cannot have duplicate values, you can use that field as a primary key. Otherwise, add a field for an identification number, such as an automatically generated number that begins at 1 and increases by one each time you add a record. Each record in the database will have a unique value for the identification number field.

5. Test your tables with sample data. You want to make sure that your design works as well as possible and uses as little storage space as possible. You can test your design with sample data even before you create your database. Use a word processing application to create tables that represent the tables of your database. Type the data for only a few records (respondents) into the tables to make sure that:

· All of your data can be entered into one of the tables and fields you defined.

· Each field’s data type will accommodate the values of that datum for all records.

· All fields in each table are logically associated with one another. Move any fields that seem out of place to a more appropriate table.
· Each table includes a primary key that can be related to other tables in the database.

· The same information is never stored twice in two different places.
· All records have a value for every field in a table.
6. Revise the design. Correct any design problems you found when you tested your tables with sample data. You may want to ask someone else to review your design. Another person may be able to take a fresh look at the design and identify problems you overlooked.
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What to Do

Complete the following task to show what you have learned about planning a database. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a database design before you begin.

Task: Working with your partner, design a database to store and manage your survey data.

Goal: Show that you understand basic database principles by creating an effective database design.

See the example: Microsoft Word* or PDF

1. Working with your partner, start one new word processing document. Always remember to type your names and the date at the top of the document.

2. Type a title for the document. You may want to include your topic, such as Database Design for ______________.
3. Discuss with you partner how you should plan a database to store and manage the data you collected together. Your database should include at least two tables—one for the data from your questions and one for the data from your partner’s questions.

4. Working with your partner, design a database to store and manage your survey data. Use your word processing application to represent the design in any way you choose. For example, you may want to create a diagram or a sample table. Check with your teacher if you think you have access to a more appropriate application to create your design.

5. Remember to save your document often while you work.

6. Make sure that your database design will store and manage all of the data you and your partner collected.

7. Review your design to see if it follows the guidelines for planning a database. Revise parts of the design that do not follow the guidelines.

8. Check with your teacher to make sure your database design is effective. Be prepared to answer the following questions:

· How will survey data help you make the decision you have defined?

· What information from this data would be useful to decision makers?

9. Review the checklist and revise your database design to make sure it is complete.

10. Share your database design.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about database planning. Your answers are not recorded, and the quiz is not scored.

Please read all possible answers first, and then choose the best answer.

1. What should you do first when planning a database?

· Consider your purpose [Correct! Databases are created to serve some purpose, and the purpose should be your starting point.]
· Enter data [Try again. You should plan a database carefully before you enter any data.]
· Group data into tables [Try again. Grouping data into tables is important, but you should do something else first.]

2. What data type is best for a field called First Name?

· Memo [Try again. Memo fields are best for larger alphabetical data items, such as product descriptions or research notes. Storing short information, like a first name, in a memo field would not be efficient.]
· Number [Try again. First names are not numerical data.]
· Text [Correct! Text fields are best for smaller alphabetical data items, such as first names.]
3. Which of the following observations would cause you to revise a database design?

· All records have a value for every field [Try again. Designs that have a value for every record in every field are very efficient because they do not waste any storage space.]
· Each table includes a primary key [Try again. Each table should include a primary key.]
· The same data is stored in two tables [Correct! Primary keys should be the only field that appears in more than one table.]
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Task: Create a database and test it with a sample of your survey data.

Goal: Show that you can identify and use a database application’s menus and toolbars.

You may want to review an example of database tables before you begin.
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Microsoft Access* | PDF
Key Concept

Have you planned an effective database design? If so, you are ready to create database tables and enter your data. Creating a database is a simple process when you begin with an effective design. You already know what tables to create and how to define fields.

Database applications provide a special view for creating a table. You create a table by adding your fields to a list, choosing a data type from a list box, and setting any special properties, such as formats for the field. Typing short descriptions of the data stored in your fields may be useful to you later and will help others understand your table design.

Most database applications also provide a wizard and toolbar to make creating tables easy. You can create a table by selecting the wizard from the application’s menus or from the toolbar. Some database applications allow you to create a table just by entering data into a blank datasheet. Creating tables and defining fields before entering data usually saves time in the long run.

Data entry is itself an important part of data collection. If you enter your data incorrectly, you will get incorrect results. You do not want all your hard work to be wasted, so you must be careful to enter your data correctly. If you enter your data correctly, you can make a good choice when you use the data to evaluate alternatives.
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Words to Remember

This page gives basic definitions for some important terms that can help you learn about data tables. You can get a more complete definition of each term from Fact Monster*.

New Words

Datasheet View: Used to add, edit, and delete information in a table.

Design View: Used to create and define fields in your table.

Interactive: Performing actions based on input from a user.

Keystroke: Pressing a key on a keyboard.

Wizard: An interactive feature designed to help users of an application perform a specific task in a series of steps.

Review Words

Application: A computer program designed for a specific purpose.

Boolean: A type of data that can have only one of two values, such as true or false.

Data: Information collected by observation or measurement.

Database: A collection of information organized and stored on a computer so it can be quickly and easily searched and sorted.

Database Application: An application designed to store and manage a collection of information so it can be quickly and easily searched and sorted.

Dataset: A collection of data records.

Datum: A single piece of information, such as a fact or statistic, which cannot be divided into smaller pieces.

Field: A distinct item of information stored in a database and making up part of a record.

GUI (Graphical User Interface): A set of menus and icons that makes an application easier for people to use.

Icon: A picture that represents a specific action for a computer to take.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Primary Key: A field with no duplicate values; that is, no two records in the database have the same value.

Program: A set of instructions for a computer to perform.

Record: A distinct unit for which information is stored in the fields of a database.

Relational Database: A database with more than one table that uses primary keys to relate information stored in one table to information stored in other tables.
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Learning from the Web

Database applications provide a special view for creating tables. Most database applications also provide wizards and toolbars to make creating tables easy. Data entry is itself an important part of data collection. If you enter your data incorrectly, you will get incorrect results.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about creating a data table, keep those in mind too.

Guiding Questions

· What major steps are involved in creating database tables?

· How do you enter data into the table you create?

· How many ways are there to create a table and enter data?

Some of these Web sites are quite advanced. Do not worry if you cannot understand everything that you read. Exploring every Web site listed is not necessary. Find one or two Web sites that you can explore to answer the guiding questions.

Web Sites

· Table that Data* from Microsoft*

· Create the Tables You Need* 

· Set Up Fields* 

· Define Relationships Between Tables* 
· Access 2000 Tutorial* from Florida Gulf Coast University*

· Screen Layouts* 
· Creating Tables* 

· Datasheet Records* 

· Getting Started With Microsoft Access* from the University of Texas*

· Exploring Tables* from Eastern Kentucky University*
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What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about creating a data table. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Design View

You can create a table by selecting Design View from the Insert menu or Database toolbar. You create a table in design view by adding fields to a list. Neither the table itself nor any data is displayed in design view. You can also set the data type as you add each field.

In most database applications, defining a field involves three basic steps:

1. Field Name. Type a descriptive name for the field.

2. Data Type. Select the type of data that will be entered into this field from a list box:
· Text fields store shorter text data, usually up to 255 characters.

· Memo fields store longer text data, usually up to tens of thousands of characters.

· Number fields store most numbers, although you can set the field size property to specific kinds of numbers, such as integers and decimals. You can also change the appearance of numbers in a field with the format property.

· Date/Time fields store dates and times. You can change the way dates and times are displayed in a field with the format property.

· Currency fields store amounts of money. You can change the way currency data is displayed in a field with the format property.

· Yes/No (Boolean) fields store data than can have only one of two values, yes (1) or no (0).

3. Description. Type a description of the data that will be stored in the field.

If you do not set one of the fields you create as the primary key, most database applications prompt you to set a primary key when you close the table. By default, most database applications add an automatically generated number that begins with 1 and increases by one each time you add a record. However, you can set the primary key to an existing field if you have a field that cannot contain duplicate records.

Table Wizard

Most database applications provide a wizard and toolbar to make creating tables easy. You can create a table by selecting the Table Wizard from the Insert menu or Database toolbar. The table wizard helps make sure you remember to set all the properties of the table and its fields. A wizard is just a guide. It does not make decisions for you.
Different database applications usually have some differences in their table wizards. In most database applications, the table wizard requires you to complete at least four steps to create a table:

1. Sample Tables and Fields. Select the tables containing fields you want to include in your database from the listed sample tables. Select the fields you want to include in your database from the listed sample fields for each table. Click > to add fields to your table. Click >> if you want to add all of the sample fields in a list. The wizard may allow you to change field properties, such as data type. When you have selected all the fields you want, click the Next button.

2. Set a Primary Key. A wizard usually sets a primary key for you by default. If so, the primary key is usually an automatically generated number that begins with 1 and increases by one each time you add a record. However, you can set the primary key to an existing field if you have a field that cannot contain duplicate records. Click the Next button.

3. Establish Relationships. A wizard may ask if the table you are creating is related to other tables already in the database. In some cases, the wizard may be able to relate the new table to existing tables for you. Click the Next button.

4. Create the Table. A wizard usually opens the table by default. However, you may be able to choose to continue to work on the table design or create a form based on the table. Click the Finish button to create the table.

Before you click the Finish button, you can use the Back and Next buttons to revise the table at any time. After you click the Finish button, you can enter your data.

Datasheet View

In some database applications, you can create a table by opening a blank datasheet and entering data. Creating a table in datasheet view is similar to starting a new worksheet in a spreadsheet application. You can enter data in a new table by selecting Datasheet View from the Insert menu or Database toolbar.

When you enter data in a new table in datasheet view, you usually cannot name fields or set data types or other properties. You can name fields and set properties by opening the table in design view later. 
When you close a table created in datasheet view, most database applications prompt you to set a primary key. By default, the primary key is usually an automatically generated number that begins with 1 and increases by one each time you add a record. However, you can set the primary key to an existing field if you have a field that cannot contain duplicate records.
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What to Do

Complete the following task to show what you have learned about creating a data table. While you work through the task, think about whether you are achieving the goal. You may want to review an example of database tables before you begin.

Task: Create a database and test it with a sample of your survey data.

Goal: Show that you can identify and use a database application’s menus and toolbars.

See the example: Microsoft Access* or PDF

1. Working with your partner, start a new database.

2. Create tables and define the fields as you planned in your database design document.

3. Set the primary key for each table. Use an automatically generated number to identify each respondent. Make sure you use the same identification number for any particular respondent in all your tables.

4. Enter the answers of a few respondents. Do not enter more than five records.

5. Make sure all of your survey data you entered is visible in the tables.

6. Review the checklist and make sure your tables are complete.

7. Check with your teacher to make sure you have correctly created your tables.

8. Share your tables.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about data tables. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. How can you change the way information in one field is displayed in a datasheet view?

· Use the Format menu [Try again. The Format menu controls the way the whole datasheet is displayed, not individual fields.]
· Set the field’s format property [Correct! Format is a property of each field that you can set when you define the field or in design view.]
· Both of the above [Try again. Only one of the answers is correct.]
2. Which of the following ways of creating a table is most likely to cause problems later?

· Datasheet view [Correct! Creating a table in datasheet view makes defining fields difficult, which may cause problems with the database in the long run.]
· Design view [Try again. You can define fields completely in design view, which reduces the likelihood that you will have problems with the database in the long run.]
· Table wizard [Try again. You can define fields completely in a table wizard, which reduces the likelihood that you will have problems with the database in the long run.]
3. How does a table wizard help you create a table?

· A table wizard automatically defines all the properties of a field. [Try again. A table wizard walks you through the steps of adding the main parts of a table, but it does not automatically define all properties of your fields.]
· A table wizard helps make sure you include all the main parts of a table. [Correct! A table wizard is a guide that helps you include all the main parts of a table.]
· A table wizard makes decisions about the type of data that is most appropriate for a field. [Try again. You must choose the data type that is appropriate for your field.]
< Back to Task | Next to Look Back >

[PRORAMMING INSTRUCTIONS]
Please refer to the Quiz Functionality document for more information.

	Type of Page 
	Level 3 Content Page

	Supertitle
	Make Decisions with Data | Data Collection

	Headline Title
	Look Back


[left-hand nav TEXT]

Checklist

Rubric

Reflection

Thinking about Learning

What have you learned in this module? You explored some different ways to prepare and administer a survey. You explored how database applications work and how they are different from many other technology tools you may have used. You planned an effective database design and used it to create tables to store your survey data.

You have learned:

· How to create an effective questionnaire for a survey

· How to collect accurate opinion data by administering a survey

· How database applications use tables to store and manage data

· How to plan an effective design for your survey database

· How to create database tables to store you survey data
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Checklist for Data Collection
A checklist can help you keep track of your work throughout the activity. Have you completed the task in each activity? Use the checklist to make sure you are ready to analyze your survey data. Ask your teacher for help if you have any questions about the checklist.
Activity 1: Survey Questions

Task: Survey Questions

· Open a new word processing document and type your name, date, and a title

· Write close-ended questions for your survey and be sure each question:

· Collects numerical data that is easy to analyze

· Includes three or four possible responses that are not too long

· Is not too long

· Write one or two open-ended questions and be sure each question:

· Provides detailed information or quotes

· Is limited to an idea or concept that cannot be adequately addressed with a close-ended 
question

· Be sure that all your survey questions:

· Collect data to help make a decision

· Do not favor any point of view

· Are easy to understand

· Ask one idea per question

· Do not influence the answers

· Make sure that your questionnaire:

· Is as short as possible

· Lists questions in a logical order

· Does not list questions in an order that influences answers

· Includes basic demographic questions

· Consider the following questions:

· How will survey data help you make the decision you have defined?

· What information from this data would help make the decision?

· What are some alternatives that could be chosen?

· What are some possibilities of each alternative?

· What choice would you make?

· Check the spelling and grammar of your survey questions

· Save your document

Activity 2: Survey Administration

Task: Survey Respondents

· Open your survey questions

· Exchange and review a peer’s questionnaire, provide specific feedback, and consider your peer’s feedback

· With a peer, open a new word processing document and type your names, date, and a title

· Determine your population and select a representative sample

· Determine how you will deliver the questionnaire: printed copies, e-mail, or the Web

· Deliver the survey to your sample

· Be sure to explain the purpose of your survey

· Collect the questionnaire from your sample

· Save your completed questionnaire

Activity 3: Database Basics

Task: Database GUI Explanation

· Open a new word processing document and type your name, date, and a title

· Identify and describe five menu options on a database application that can help you manage your survey data

· Save your document

Activity 4: Database Planning

Task: Database Design

· With your partner, open a new word processing document and type your name, date, and a title

· Design a database, in your word processing application, with at least two tables to store and manage your and your partner’s survey data

· Follow these steps to plan your database:

· Consider your purpose

· Group data into tables

· Define fields for each table

· Identify primary keys for each table

· Test your tables with sample data

· Revise the design

· Discuss the questions:

· How will your survey data help you make the decision you have defined?

· What information from this data would be useful to decision makers?

· Save your document

Activity 5: Database Tables

Task: Database
· With your partner, start a new database

· Use your database design to:

· Create tables and define the fields:

· Give a descriptive name to the field

· Select the type of data for the field

· Describe the data

· Set the primary key for each table

· Use an automatically generated number to identify each respondent

· Enter answers of up to five respondents

· Check that all data is entered and visible in the tables

· Save your tables
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Rubric for Data Collection
The main purpose of a rubric is to help you do your best work. What column best describes your survey administration, survey questions, and spreadsheet? Is all of your work best described by column 4? If not, what could you improve?

	
	4
	3
	2
	1

	Survey Questions
	All questions are precise and clearly provide information relevant to important concepts that can be used to draw logical conclusions.

All close-ended questions and answer choices are concise and complete.

Open-ended questions are carefully worded to provide detailed information about important or complex ideas and concepts. 
	Most questions are precise and clearly provide information relevant to important concepts that can be used to draw logical conclusions.

Most close-ended questions and answer choices are concise and complete.

Open-ended questions address important or complex ideas and concepts.
	Some questions are precise and clearly provide information relevant to important concepts that can be used to draw logical conclusions.

Close-ended questions are concise and complete, but there are too many or too few answer choices.

Open-ended questions do not address important or complex ideas and concepts.
	Very few questions have a clear purpose or provide information relevant to important concepts that can be used to draw logical conclusions.

Close-ended questions are too long to understand or too short to be complete.

Open-ended questions are missing or unnecessary.

	Database

Tables
	Data is clearly and logically organized into tables 

that are related by an appropriate primary key.

Tables are formatted so they are attractive and easy to view, and the collected data is easy to understand.
	Data is logically organized into tables that are related by an appropriate primary key.

Tables are easy to view, titles of records and fields are easy to read, and the collected data is presented clearly.
	Data is logically organized into tables, but the tables are not related by a primary key.

Tables are easy to view and titles of records and fields are easy to read, but the collected data is not presented clearly.
	Data is poorly organized, and either too many or too few tables are used.

Tables are difficult to view or titles of records and fields are missing or difficult to read.

	Writing Mechanics
	All words are spelled and capitalized correctly.

All sentences are punctuated correctly.
	Almost all words are spelled and capitalized correctly.

Almost all sentences are punctuated correctly.
	Several words are misspelled or capitalized incorrectly.

Several sentences are punctuated incorrectly.
	Many words are misspelled and capitalized incorrectly, making the information hard to understand.

Many sentences are punctuated incorrectly, making the information hard to understand.

	Database

Basics
	Data is entered and tables are formatted accurately.

Advanced database features and terminology are used correctly.
	Data is entered and tables are generally formatted accurately.

Basic database features and terminology are used correctly.
	Data is entered and tables are created without assistance, but there may be some inaccuracies.

Basic database features are not used to format tables.
	Data is entered and tables are created with much assistance. 

	File Management
	Files are clearly named, consistently saved to the correct location, and well-organized in folders.
	Files are clearly named and consistently saved to the correct location, but they are not well-organized in folders.
	Work is not lost, but files are not clearly named or not consistently saved to the correct location.
	Work is lost because files are not clearly named or not consistently saved to the correct location.
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Reflection on Data Collection
How can you make sure you really understand something? One of the best ways is to explain it to someone else. You might talk to another student, a teacher, or someone in your family.

Be prepared to discuss:

· What you learned about preparing and administering a survey

· How database applications work and how they differ from other applications

· What you learned about planning an effective database design

· How you created your database tables and why you chose that method
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Checklist: Before you begin, review the checklist for this module. Use the checklist to make sure that you complete all the tasks for each activity.

See the checklist >
Rubric: Before you begin, review the rubric for this module. Use the rubric to help you understand what is important to know and do.

See the rubric >

Big Idea

How can you evaluate alternatives and make a choice? You administered a survey and created a well-designed database for your data. When you analyze data, you can evaluate possibilities and make a choice for almost any decision. You can create charts to help you evaluate possibilities and make a choice by visualizing, or visually representing, relationships among your data. Learn how to create forms and queries to manage your survey database. Use a spreadsheet application to analyze your data with formulas and functions, and represent your data visually with charts.

In this module:

· Create a form for entering data into your survey database

· Create queries to retrieve survey data that informs your decision

· Analyze your survey data and evaluate alternative choices

· Learn how to read and interpret different kinds of charts

· Create charts that help you to visualize your evaluation and choice

Activity 1: Database Forms >

Can you think of some databases you have used? Most databases have forms that format information from the database in a more readable way. Forms can display data and make entering date easier. Create a form for entering data into your survey database.

Activity 2: Database Queries >

What can you learn from the survey data you collected? Queries retrieve information from a database by finding records that match specified criteria. Decide what you want to know and what information you need to retrieve. Create queries to retrieve survey data that inform your decision.

Activity 3: Decision Possibilities >

Are you ready to evaluate alternative choices? Data analysis involves selecting and using appropriate formulas and functions. You can export your queries and import the data into a spreadsheet application. Analyze your survey data and evaluate alternative choices.

Activity 4: Data Visualization >

How many different kinds of charts have you seen? A chart is a visual representation of the meaning of a set of data. Different kinds of charts visualize different kinds of relationships among different kinds of data. Learn how to read and interpret different kinds of charts.

Activity 5: Decision Choice >

Are you ready to make a choice? You can create charts to help you visualize relationships among your survey data. Use your critical thinking skills to determine the kinds of charts that can help you evaluate decision alternatives. Create charts that help you visualize your evaluation and choice.
Look Back >

Reflect on what you learned in this module. Are you ready to make a presentation explaining your choice? Use the checklist to make sure your tasks are complete. Use the rubric to assess your decision choice. Talk about what you learned and how you did your work.
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Checklist for Data Analysis
Checklists can help you keep track of your work. Use the following checklist to make sure you complete the task for each activity. If you have access to a printer, you may want to print the checklist for reference as your work through the activities. Ask your teacher for help if you have any questions about the checklist.
Activity 1: Database Forms

Task: Database Form

· Open your survey database

· Create a form to enter all of the fields in your tables

· Choose the types of controls you plan to use:
· Text Box

· Option (Radio) Button

· Checkbox

· List Box

· Combo Box

· Command Button

· Set the properties of all labels and controls (in design view)

· Open your form and enter the remaining records of your survey data

· Check that all data is entered and visible when you open the form

· Save your form

Activity 2: Database Queries

Task: Database Query Design

· Open a new word processing document and type your name, date, and a title

· Design at least two queries that provide information to help you make your decision and consider the following questions:

· What do you want to know?

· Which tables and fields contain the information you need?

· What keywords or criteria can you use to retrieve the information?

· Follow the steps to create queries:

· Select tables
· Select fields
· Show and sort

· Set criteria

· Save the query

· Open your survey database

· Create at least one query in design view and one using the wizard, and save each with a descriptive name

· Run your queries and see the results in datasheet view
· Refine the query in order to get the results you expected

· Make sure all your data is visible in the results of each query

· Save your database

Activity 3: Decision Possibilities
Task: Data Summary

· Open your survey database

· Export the data from your queries

· Start a new spreadsheet workbook and type your name and the data

· Import the data from your queries into the spreadsheet

· Use appropriate formulas and functions to analyze your data

· Open a new word processing document and type your name, date, and a title

· Evaluate your decision alternatives by addressing the following questions:

· How did you expect your survey data to help you make a decision?

· What kinds of information does your analysis of the survey data provide?

· How does your analysis help you refine alternative choices?

· What information does your survey data provide about the possibilities of each 
alternative?

· How does your analysis help you evaluate the possibilities?

· Check the spelling and grammar of your evaluation

· Save your document

Activity 4: Data Visualization
Task: Data Charts

· Open the workbook with your imported query data

· Start a new worksheet and type your name and the date

· Create charts to represent your survey data and add the charts to your worksheet(s), making sure that you:

· Choose the type of charts that best represent your data

· Import the data you want to represent in your charts

· Title each chart

· Title and label the x-axis (not for pie chart)

· Title and label the y-axis (not for pie chart)

· Create a legend

· Place the chart on a new worksheet or an existing worksheet in the same workbook

· If necessary, revise and reformat your charts to clearly visualize your data

· Save your charts

Activity 5: Decision Choice

Task: Decision Choice

· Open the workbook with your summarized survey data and charts

· Format your data and charts to make them more attractive and easy to read

· Make sure that your evaluation and choice are clearly shown in your data

· Start a new word processing document and type your name, date, and a title

· Use critical thinking skills to make a choice and explain your choice by addressing the following questions:

· Which alternative is the best choice for your decision?

· How did your survey data help you make your choice?

· How did other information you gathered help you make your choice?
· What other data might cause you to reconsider your choice?

· Check the spelling and grammar of your choice explanation

· Save your document
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Rubric for Data Analysis
The main purpose of a rubric is to help you do your best work. Use the rubric to make sure you understand what you are expected to learn. Is all of your work best described by column 4? If not, what can you improve? If you have access to a printer, you may want to print the rubric for reference as your work through the activities. Ask your teacher for help if you have any questions about the rubric.

	
	4
	3
	2
	1

	Forms and Queries
	Advanced database features are used to ensure the integrity of all data in forms and queries.

Data is manipulated efficiently with forms and queries.

Correct database terminology is used when discussing database features.
	Forms and queries accurately represent all of the data collected.

Forms and queries data tables are used without assistance

Basic database menus and commands are used efficiently.
	Forms and queries accurately represent most of the data collected.

Forms and queries data tables are often used without assistance.

Database menus and commands are sometimes used efficiently.
	Forms or queries are missing or do not accurately represent the data collected.

Forms or query data tables are rarely used without assistance.

Database menus and commands are not used efficiently.

	Decision Possibilities
	The evaluation is precise and uses relevant information to develop important possibilities that are logical and thoroughly supported.

Different types of formulas effectively analyze all of the relevant data.
	The evaluation is precise and uses relevant information to develop important possibilities, but they may not be logical or well-supported.

Formulas effectively analyze most of the relevant data.
	The evaluation is precise and provides relevant information, but possibilities are unimportant or poorly developed.

Formulas accurately analyze relevant data, but other formulas would be more effective.
	The evaluation is not precise and provides inaccurate or irrelevant information.

Formulas are missing or do not accurately analyze relevant data.

	Data Visualization
	All charts are clearly used to develop important concepts that support a decision alternative.

Different types of charts represent all relevant data accurately and effectively.
	Most charts are used to develop important concepts, but they may not support a decision alternative.

Charts represent most relevant data accurately and effectively.
	Most charts have a clear purpose, but they may not be used to support a decision alternative.

Charts represent relevant data, but other kinds of data or other types of charts would be more effective.
	Charts are missing or do not have a clear purpose.

Charts are missing or do not accurately represent the relevant data.

	Decision Choice
	Worksheets and charts are attractive and engaging, easy to read and interpret, and provide visual evidence of all survey results and thoroughly support a choice.
	Worksheets and charts are easy to read, summarize poll results, and provide adequate evidence to support a choice.
	Worksheets and charts are easy to read and summarize poll results but do not provide enough evidence to support a choice.
	Worksheets and charts are difficult to read and do not summarize poll results or support a choice.

	Writing Mechanics
	All words are spelled and capitalized correctly.

All sentences are punctuated correctly.
	Almost all words are spelled and capitalized correctly.

Almost all sentences are punctuated correctly.
	Several words are misspelled or capitalized incorrectly.

Several sentences are punctuated incorrectly.
	Many words are misspelled and capitalized incorrectly, making the information hard to understand.

Many sentences are punctuated incorrectly, making the information hard to understand.

	Database

Basics
	Data is entered and tables are formatted accurately.

Advanced database features and terminology are used correctly.
	Data is entered and tables are generally formatted accurately.

Basic database features and terminology are used correctly.
	Data is entered and tables are created without assistance.

Basic database features and terminology are sometimes used correctly.
	Data is entered and tables are created with much assistance.

Basic database features and terminology are not used, used incorrectly, or used with much assistance.

	Spreadsheet Basics
	Formulas are entered and charts are created without assistance, and advanced spreadsheet menus and commands are used efficiently.
	Formulas are entered and charts are created without assistance, and basic spreadsheet menus and commands are used efficiently.
	Formulas are entered and charts are created without assistance, but basic spreadsheet menus and commands are not used efficiently.
	Formulas are entered and charts are created with assistance, or formulas and charts are not used. 
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Task: Create a form and use it to enter the remaining records of your survey data.

Goal: Show that you can create a form to enter data into a database.

You may want to review an example of a database form before you begin.
See the example:
Microsoft Access* | PDF
Key Concept

Can you think of some databases you have used? You probably did not see any tables from those databases. Most databases have forms that format information from the database in a more readable way. Forms can be used to enter or display data.

Electronic forms have two parts—controls and labels. Controls accept information from users and display information from the database. Labels tell the people who use the forms what each control does. Most controls are bound to fields in the database.

Designing a form from a blank page requires a lot of time and expertise. Most database applications also provide a wizard and toolbar to make creating tables easy. You can create a form by selecting the wizard from the application’s menus or from the toolbar. In most cases, you can save a lot of time by using a wizard to create a form.

Data entry is itself an important part of data collection. If you enter your data incorrectly, you will get incorrect results. You do not want all your hard work to be wasted, so you must be careful to enter your data correctly. Forms can help make sure your data is entered correctly.
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Words to Remember

This page gives basic definitions for some important terms that can help you learn about database forms. You can get a more complete definition of each term from Fact Monster*.

New Word

Form: A document designed to collect or display information.

Review Words

Application: A computer program designed for a specific purpose.

Data: Information collected by observation or measurement.

Database: A collection of information organized and stored on a computer so it can be quickly and easily searched and sorted.

Database Application: An application designed to store and manage a collection of information so it can be quickly and easily searched and sorted.

Dataset: A collection of data records.

Datasheet View: Used to add, edit, and delete information in a table.

Datum: A single piece of information, such as a fact or statistic, which cannot be divided into smaller pieces.
Design View: Used to create and define fields in your table.

Field: A distinct item of information stored in a database and making up part of a record.

GUI (Graphical User Interface): A set of menus and icons that makes an application easier for people to use.

Icon: A picture that represents a specific action for a computer to take.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Interactive: Performing actions based on input from a user.

Primary Key: A field with no duplicate values; that is, no two records in the database have the same value.

Program: A set of instructions for a computer to perform.

Record: A distinct unit for which information is stored in the fields of a database.

Relational Database: A database with more than one table that uses primary keys to relate information stored in one table to information stored in other tables.

Wizard: An interactive feature designed to help users of an application perform a specific task in a series of steps.
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Learning from the Web

Database forms use labels and controls to make information more readable. Forms can be used to enter or display data. You can design a form from a blank page, but using a wizard to help you is almost always better. Explore some Web sites about database forms and learn how to create a form for data entry.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about creating forms in a database, keep those in mind too.

Guiding Questions

· What major steps are involved in creating database forms?

· How can you use a form to enter data into your database?

· How many ways are there to create a form and enter data?

Some of these Web sites are quite advanced. Do not worry if you cannot understand everything that you read. Exploring every Web site listed is not necessary. Find one or two Web sites that you can explore to answer the guiding questions.

Web Sites

· Forms I: Create a Form to Enter and View Your Data* from Microsoft*

· Why Use Forms?* 

· Create a Form* 

· Forms* from Florida Gulf Coast University*

· Creating and Navigating Around Forms* from Eastern Kentucky University*

· Databasics III: Data Entry Design* from Geek Girls*

< Back to Vocabulary | Next to Information >
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What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about database forms. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Design View

You can create a form by selecting Design View from the Insert menu or Database toolbar. You create a form in design view by selecting fields from a list and adding them to a grid. Neither the form itself nor any data is displayed in design view.

Electronic forms have two parts—controls and labels. Controls accept information from users and display information from the database. Labels tell people who use the form what each control does. Most controls are bound to fields in the database. Several kinds of controls provide ways to enter and display different kinds of data. Some common form controls include:
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The properties of a control determine everything from the field to which the control is bound to the font in which the value is displayed. You must set the properties of every label and control when you design a form. Some controls have more than 50 properties!
Even though many properties can usually be left at their default values, creating a form in design view requires a lot of time and expertise. If you have that expertise, design view gives you complete and precise control of a form. If you do not need complete and precise control, you can save a lot of time by using a form wizard.

Form Wizard

Most database applications provide a form wizard and toolbar to make creating forms easy. You can create a form by selecting the Form Wizard from the Insert menu or Database toolbar. A form wizard in a database application is one of the greatest time-saving wizards in any application.

Form wizards in various database applications usually have some minor differences. In most database applications, creating a form involves the following five basic steps:

1. Select Tables. Select the tables that contain the data you want to enter.

2. Select Fields. Select the table fields from that you want to include in the form. Click > to add the fields to your form. Click >> if you want to add all of the fields in a table. Click the Next button.

3. Choose Layout. Choose the form’s basic layout. You may be able to lay out the form in columns, in a table, or as a datasheet. Click the Next button.

4. Format Labels. Choose a label format for field labels from a number of basic designs. Choose a design that is easy to read. Click the Next button.

5. Create the Form. The form usually opens by default. However, you may choose to continue to refine the form in design view. When you have made all your selections, click the Finish button to create the form.
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Use the Intel® Education Help Guide to learn technology skills.
Databases

##Open database#skillid=DB_1.5##

##Use database forms#skillid=DB_3.1&ShowGroup=true##
##Search the Help Guide#skillid=null##
What to Do

Complete the following task to show what you have learned about creating a form in a database. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a database form before you begin.
Task: Create a form and use it to enter the remaining records of your survey data.

Goal: Show that you can create a form to enter data into a database.

See the example: Microsoft Access* or PDF

1. Open your survey database.

2. Determine what types of controls are most appropriate for entering your survey data. Think about how different types of controls, such as radio buttons, checkboxes, list boxes, and combo boxes, can help make sure your data is entered correctly.
3. Create a form to enter all of the fields in your tables. If you are using an automatically generated identification number, you do not necessarily need to include that field.

4. Check with your teacher to make sure you have correctly created your form.

5. Open your form and enter the remaining records of your survey data.

6. Make sure all fields that will be entered are visible when you open the form.

7. Check with your teacher to make sure you have correctly entered all your data.

8. Share your form.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about database forms. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. How can you change the appearance of data in a form?

· Use the Format menu [Try again. For most applications, the Format menu would be correct, but database applications are different.]
· Set the control’s properties [Correct! You can change the format of data when you set the properties of the control that is bound to the data.]
· Both of the above [Try again. Only one of the answers is correct.]
2. Which of the following ways of creating a table requires the most time and expertise?

· Datasheet view [Try again. A form cannot be created in datasheet view.]
· Design view [Correct! Design view gives you complete control of a form, but using design view to create a form takes time and expertise to correctly position the labels and controls and set all their properties.]
· Form wizard [Try again. A form wizard in a database application is one of the greatest time-saving wizards in any application.]
3. How does a form wizard help you create a form?

· A form wizard automatically defines all the properties of a field. [Try again. A form wizard walks you through the steps of adding the main parts for creating a form but does not automatically include all properties of your fields.]
· A form wizard automatically lays out the form and formats labels and controls. [Correct! The wizard saves a lot of time by laying out the form and allowing you to choose among some preset formats for labels and controls.]
· A wizard makes decisions about how controls are bound to fields. [Try again. You must choose which field should be bound to a control.]
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Task: Design and run queries that select information to help you make your decision.

Goal: Show that you can create a query to retrieve information from a database.

You may want to review an example of a database query design and a database query before you begin.
See the examples: 
Microsoft Word* | PDF

Microsoft Access* | PDF
Key Concept

What can you learn from the survey data you collected? You created a well-designed database and correctly entered your survey data. If you asked a survey question to get information you need, you can query your survey database to get the answer.
Queries allow you to retrieve information from a database. They work by finding records that match criteria you specify in the query. Queries are like tables, but they only contain the data that matched your criteria. The more you know about queries, the more control you have over the information you can retrieve from a database.
Queries can be as simple as retrieving all the records that contain a certain value in a particular field, such as the value Orange in the Color field. Queries can also be extremely complex, involving long and complicated logical and mathematical operations.
Basic queries are much easier to design than forms. The first step is always deciding what you want to know and what information you need to retrieve. Then, you can design a query by selecting the fields that contain the information you need. The most important part of designing a query is specifying criteria that retrieves the right records.
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Words to Remember

This page gives basic definitions for some important terms that can help you learn about database queries. You can get a more complete definition of each term from Fact Monster*.

New Words

Ascending: Ordered from lowest to highest or first to last, such as 1–10 or A–Z.

Criterion: A rule or guide used to measure value and aid in decision making.

Descending: Ordered from highest to lowest or last to first, such as 10–1 or Z–A.

Query: A question or request.

Retrieve: Find and bring back.

Review Words

Application: A computer program designed for a specific purpose.

Data: Information collected by observation or measurement.

Database: A collection of information organized and stored on a computer so it can be quickly and easily searched and sorted.

Dataset: A collection of data records.

Database Application: An application designed to store and manage a collection of information so it can be quickly and easily searched and sorted.

Datasheet View: Used to add, edit, and delete information in a table.

Design View: Used to create and define fields in your table.

Field: A distinct item of information stored in a database and making up part of a record.

Form: A document designed to collect or display information.

GUI (Graphical User Interface): A set of menus and icons that makes an application easier for people to use.

Icon: A picture that represents a specific action for a computer to take.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Interactive: Performing actions based on input from a user.

Primary Key: A field with no duplicate values; that is, no two records in the database have the same value.

Program: A set of instructions for a computer to perform.

Record: A distinct unit for which information is stored in the fields of a database.

Relational Database: A database with more than one table that uses primary keys to relate information stored in one table to information stored in other tables.

Wizard: An interactive feature designed to help users of an application perform a specific task in a series of steps.
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Learning from the Web

What can you learn from the survey data you collected? Queries are questions that you answer by retrieving information from a database. The more you know about queries, the more control you have over the information you can retrieve from a database. Explore some Web sites about database queries and learn how to retrieve precisely the information you want.
While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about querying a database, keep those in mind too.

Guiding Questions

· How do you decide what information you want to retrieve?

· What major steps are involved in creating database queries?

· How many ways can a query be created and run?
Some of these Web sites are quite advanced. Do not worry if you cannot understand everything that you read. Exploring every Web site listed is not necessary. Find one or two Web sites that you can explore to answer the guiding questions.

Web Sites

· Queries I: Get Answers with Queries* from Microsoft*

· Put Data to Use* 

· Create Select Queries* 

· Queries* from Eastern Kentucky University*

· Databasics V: Getting Information Out* from Geek Girls*

· Queries* from Florida Gulf Coast University*

· Getting Started With Microsoft Access* from the University of Texas*
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What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about database queries. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Retrieving Information with Queries

Queries allow you to retrieve information from a database. Queries can be as simple as retrieving all the records that contain a certain value in a particular field, such as the value Orange in the Color field. Queries can also be extremely complex, involving long and complicated logical and mathematical operations.
The more you know about queries, the more control you have over the information you can retrieve from a database. In any case, you must first decide what information you want to retrieve.
Three questions can help you make that decision:

· What do you want to know?

· Which tables and fields contain the information you need?

· What keywords or criteria can you use to retrieve the information?

Design View

You can create a query by selecting Design View from the Insert menu or Database toolbar. You create a query in design view by selecting fields from a list and adding them to a grid. The most important part of designing a query is specifying criteria that retrieve the right records.

In most database applications, creating a query involves five basic steps:

1. Select Tables. Select the tables that contain the data you want to find. If you have already created a query in the database, you can also select fields from that query.

2. Select Fields. Select the fields from each table that you want to include in the query. You can usually drag the fields from a list and add them to a grid.

3. Show and Sort. You may want to use a field to select data from a table but not want to display that particular field in the results. You can usually choose whether you want to show each field you have added to the query. You can choose to sort the results in ascending or descending order by a field.

4. Set Criteria. Set criteria that will select only the records you want to retrieve. You can usually type the value of the field for the records you want to retrieve. Criteria can also be more complex, including logical operators or mathematical equations.

5. Save the Query. Save the query from the File menu. When you modify a query you already created, you can select Save As from the File menu and give the query a new name. Save As preserves the original query and saves the new query.

Once you have saved the query, you can view the results by selecting the Datasheet View from the View menu or the Query Design toolbar.

Query Wizard

Most database applications provide a wizard and toolbar to make creating queries easy. You can create a query by selecting the Query Wizard from the Insert menu or Database toolbar. A query wizard helps make sure you remember to set all the properties of a query. A wizard is just a guide. It does not make decisions for you.

Query wizards in various database applications usually have some differences. In most database applications, you need to complete at least two steps to create a query with a wizard:

1. Select Fields. Select the table you want to query and the fields you want to include in your query. Click > to add the fields to your query. Click >> if you want to add all of the fields in a table. Select another table if you want to add more fields. When you have selected all the fields from all the tables you need, click the Next button.

2. Create the Query. You can usually choose to continue to work on the query design or to open the query in datasheet view. Click the Finish button to create the query.

Some database applications also allow you to set criteria in the query wizard. Before you click the Finish button, you can use the Back and Next buttons to revise the query at any time. After you click the Finish button, you can enter criteria for the query in design view.
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What to Do

Complete the following task to show what you have learned about querying a database. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a database query design and a database query before you begin.
Task: Design and run queries that select information to help you make your decision.

Goal: Show that you can create a query to retrieve information from a database.

See the examples: Microsoft Word* or PDF






Microsoft Access* or PDF

1. Start a new word processing document. Always remember to type your name and the date at the top of the document.

2. Type a title for the document. You may want to include your topic, such as Query Design for ______________.
3. Design at least two queries that provide information to help you make your decision. Make sure you address the following questions:

· What do you want to know?

· Which tables and fields contain the information you need?

· What keywords or criteria can you use to retrieve the information?

4. Check with your teacher to make sure your database design is effective. Be prepared to answer each of the preceding three questions.

5. Open your survey database.

6. Create at least one query in design view and another query with the query wizard. Save each query with a descriptive name.

7. Run your queries and look at the results in datasheet view. Did you get the results you expected? If not, return to design view and refine the query until you get the information you want to retrieve.

8. Make sure all of your data is visible in the results for each query.

9. Review the checklist and make sure your queries are complete.

10. Check with your teacher to make sure you have correctly created your queries.

11. Share your queries.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about database queries. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. What part of a query determines which records are retrieved?

· Criteria [Correct! Criteria can be as simple as typing a value that you want to retrieve or as complex as logical or mathematical operations.]
· Datasheet [Try again. Results of a query are displayed in a datasheet.]
· Wizard [Try again. Determining what records are retrieved with a wizard may be possible in some database applications, but another answer is better.]
2. What is the best way to look at the results of a query?

· Datasheet view [Correct! Datasheet view displays the results of a query in a table.]
· Design view [Try again. You can create a query in design view, but you cannot see the results.]
· Query wizard [Try again. You can create a query with a query wizard, but you cannot see the results until you click Finish and leave the wizard.]
3. How does a query wizard help you create a query?

· A query wizard automatically defines criteria for selecting records. [Try again. A query wizard walks you through the steps of a creating a query but does not automatically set criteria for the fields you select.]
· A query wizard makes decisions about what type of data is most appropriate for a field. [Try again. You must enter criteria that apply only to the records you want to retrieve.]
· A query wizard simplifies completing some of the steps involved in creating a query. [Correct! A query wizard simplifies some of the steps required to create a query, especially adding tables and fields to a query.]
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Task: Summarize your survey data so you can evaluate decision alternatives.

Goal: Show that you know how to use formulas and functions to analyze data.

You may want to review an example of a data summary and a decision evaluation before you begin.
See the examples: 
Microsoft Excel* | PDF

Microsoft Word* | PDF
Key Concept

Are you ready to evaluate possibilities of each alternative choice? You have created queries to retrieve the information you need to evaluate possibilities. Now you need to analyze the data to find out what you can learn from your survey.
Data analysis involves selecting and using appropriate formulas and functions to help answer questions. Critical thinking skills can help you select and use the most appropriate formulas and functions to analyze your data.

You can use database queries to perform calculations on data. Often, the easiest approach is to export query results from a database application and import the data into a spreadsheet application. A spreadsheet is a table of rows and columns into which you can enter data.

Spreadsheet applications use formulas and functions to perform calculations. A formula is an equation built from numbers, symbols, and cell references. A function is a formula that is built into the application. Spreadsheet applications are usually the best tool for analyzing data.
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Words to Remember

This page gives basic definitions for some important terms that can help you learn about using data analysis to evaluate decision possibilities. You can get a more complete definition of each term from Fact Monster*.

New Words

Calculate: Find an answer by applying mathematical functions to numbers.

Data Analysis: Selecting and using appropriate formulas and functions to answer questions with data.

Equation: A mathematical expression that includes operators and numbers or variables in which two quantities are equal.

Export: Send data from an application.

Formula: A set format for writing an equation with specific operators and variables (cell references) or numbers.

Function: A built-in formula in a spreadsheet application.

Import: Bring data into an application.

Operator: A symbol that represents a specific mathematical calculation, such as + represents addition.

Value: The number or quantity represented by a variable or formula.

Variable: A letter used in an equation in place of a number that is unknown or can change, such as x in 4 + x = 9.

Review Words

Application: A computer program designed for a specific purpose.

Criterion: A rule or guide used to measure value and aid in decision making.

Data: Information collected by observation or measurement.

Database: A collection of information organized and stored on a computer so it can be quickly and easily searched and sorted.

Database Application: An application designed to store and manage a collection of information so it can be quickly and easily searched and sorted.

Dataset: A collection of data records.

Field: A distinct item of information stored in a database and making up part of a record.

GUI (Graphical User Interface): A set of menus and icons that makes an application easier for people to use.

Icon: A picture that represents a specific action for a computer to take.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Program: A set of instructions for a computer to perform.

Query: A question or request.

Record: A distinct unit for which information is stored in the fields of a database.

Retrieve: Find and bring back.

Spreadsheet: An application designed to analyze and represent data.

Workbook: A computer file created with a spreadsheet application and containing one or more worksheets.

Worksheet: A table with rows and columns with cells into which data and formulas can be entered.
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Learning from the Web

Data analysis involves selecting and using appropriate formulas and functions to help answer questions. Spreadsheet applications are usually the best tool for analyzing data. Explore some Web sites about using formulas and functions in a spreadsheet. Learn how to use a spreadsheet application to analyze data.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about using formulas and functions to analyze data, keep those in mind too.

Guiding Questions

· How are the formulas similar to one another?

· In what order do the parts of a formula have to be written?

· What formulas and functions can you use to analyze your survey data?

Web Sites

· Using Equations* from Internet4Classrooms*

· Calculating Percent* from Internet4Classrooms*

· Using Functions* from Internet4Classrooms*

· Entering Formulas* from the EHS Virtual Computer Lab*

· How to Use Excel Spreadsheet Formulas* from About*
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What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about spreadsheet analysis. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Making Decisions with Data

Data analysis involves selecting and using appropriate formulas and functions to help answer questions. You can analyze your survey data to help answer your research questions. Critical  thinking skills can help you select and use the most appropriate formulas and functions. 
Consider the following questions as you analyze your data:

Decision 
· Why did you collect this data? 
· How did you expect your survey data to help you make a decision? 
· How does your survey data help you understand different points of view on the decision?

Information
· What kinds of information does your analysis of the survey data provide? 
· How does your survey data support or dispute other information you gathered? 
· What formulas and functions can provide information that helps you make a decision?
Alternatives 
· How does your analysis help you refine alternative choices? 
· What information does your survey data provide about each alternative? 
· How can your survey data help you look at alternatives from different points of view?
Possibilities
· How does your analysis help you evaluate the possibilities of each alternative? 
· What possibilities are supported by your survey data? 
· What possibilities does your survey data suggest are unlikely?

Choice 
· How does your survey data help you make a choice? 
· What choice does your data analysis most support? 
· How does the analysis help you explain your choice? 
· What other data might cause you to reconsider your choice?

Analyzing Data with Formulas and Functions

A formula is an equation you enter into a spreadsheet that can include cell references. A formula describes an equation’s action, such as adding two numbers together. But instead of using numbers, like 2 + 2, a formula can use cell references, like A1 + A2. When a spreadsheet application finds a formula, it follows the formula’s action and then follows the cell references in the formula to get the numbers (or data) needed to complete the action.
A function is a standard formula that is built into a spreadsheet application. The difference is that you create formulas and the application includes functions.

After formulas and functions are entered into a spreadsheet, the spreadsheet can perform hundreds or even thousands of calculations instantly. If the data in any cells change, the spreadsheet application can automatically update the formulas and functions.
Spreadsheet applications are powerful technology tools for two main reasons:

· They can perform many calculations instantly.

· They can update calculations automatically when data changes.
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Working with Formulas and Functions

Spreadsheet applications use formulas and functions to calculate data. A formula is an equation you enter into a spreadsheet that can include cell references. A function is a standard formula that is built into a spreadsheet application. The difference is that you create formulas and the application includes functions.

Using a Formula

Suppose you want to add numbers in column A and column B in a spreadsheet, and you want to show the sum in column C. To set this up, you could select cell C2, click in the Formula Bar, and type =A2+B2. When you press the Enter key, the spreadsheet application will add the numbers in cells A2 and B2 and show the sum in C2.
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You can easily perform the same calculation on all of the remaining numbers in column A and column B of the spreadsheet. You would simply select the cell C2 and drag the lower right corner of the cell down the remaining cells in column C. This action repeats the formula in all of the remaining cells.

[image: image10.png]Select the cellC2 and drag the lower
right comer of the cell down the
remaining cells in column C





[image: image11.png]C4

A

KN 52 34

2| 68 107 175
3 14 51 65

4 8 pl 7]
5

3





Using a Function

Functions, such as sums, are formulas built into spreadsheet applications. For example, another way to add cells A2 and B2 would be to select cell C2 and type the function =SUM(A2:B2) into the formula bar. The effect of using this function is the same as using the formula =A2+B2. You can also repeat the function for the remaining numbers in columns A and B.

[image: image12.png]=SUM(A2:B2)





The advantage of functions becomes clear when a calculation has many variables. For example, suppose you want to add numbers in the first five columns of a spreadsheet. First, you would select cell F2 to contain the sum. Then, you then have two choices of what to type into the Formula Bar:

· The formula =A2+B2+C2+D2+E2
· The function =SUM(A2:E2)
Now, suppose you want to add numbers in the first 40 columns of a spreadsheet. Would you type a formula or use a function? Remember, the more you have to type, the more likely you are to make mistakes. Therefore, the main advantages of functions are saving time and reducing errors.
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What to Do

Complete the following task to show what you have learned about using spreadsheets for data analysis. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a data summary and a decision evaluation before you begin.
Task: Summarize your survey data so you can evaluate decision alternatives.

Goal: Show that you know how to use formulas and functions to analyze data.

See the examples: Microsoft Excel* or PDF






Microsoft Word* or PDF

1. Open your survey database.

2. Export the data from your queries.

3. Start a new workbook for you analysis. Always remember to type your name and the date at the top of the worksheet.
4. Import the data from your queries into a spreadsheet application.

5. Use appropriate formulas and functions to analyze your data.
6. Remember to save your workbook often while you work.
7. Check with your teacher to make sure you have used the appropriate formulas and functions to analyze your data.
8. Start a new word processing document. Always remember to type your name and the date at the top of the document.
9. Type a title for the document. You may want to include your topic, such as Decision Evaluation for ______________.
10. Use critical thinking skills to evaluate your decision alternatives. Make sure you address each of the following questions:
· How did you expect your survey data to help you make a decision?

· What kinds of information does your analysis of the survey data provide?

· How does your analysis help you refine alternative choices?

· What information does your survey data provide about the possibilities of each alternative?

· How does your analysis help you evaluate the possibilities?

11. Remember to save your document often while you work.
12. Check the spelling and grammar of your evaluation and double-check your work by reading the document carefully one more time.
13. Review the checklist and revise your evaluation to make sure it is complete.
14. Share your evaluation.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about data analysis with spreadsheets. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. What do spreadsheet applications use to perform calculations on data?

· Formulas [Try again. Spreadsheet applications use formulas, but another answer is better.]
· Functions [Try again. Spreadsheet applications use functions, but another answer is better.]
· Both of the above [Correct! Spreadsheets applications use formulas and functions to perform calculations on data. A function is a formula that is built into the application.]
2. Which function would add the contents of the first five cells in the first column of a worksheet?

· =A1:A5 [Try again. The example is not a valid formula.]
· =SUM(A1:A5) [Correct! The example correctly uses the SUM function.]
· =AVG(A1:A5) [Try again. The AVG function averages a series of numbers rather than adds them.]
3. How do you update a value in a formula when the data in one of the cell references changes?

· Select the cell containing the formula and click the update icon. [Try again. A spreadsheet does not have an update icon.]
· Save changes to the worksheet then close and reopen the file. [Try again. You can save and reopen a worksheet to update values, but it is not necessary.]
· Do nothing—worksheets can automatically update values in formulas [Correct! You do not need to do anything! A spreadsheet application does the work for you.]
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Task: Visualize your survey data with charts so that you can illustrate the data and make a decision.

Goal: Show that you know how to use charts to help you visualize information.

You may want to review an example of data visualization before you begin.
See the example: Microsoft Excel* | PDF
Key Concept

Do you see what I mean? If charts could talk, that is probably what they would ask you. A chart is a visual representation, or visualization, of information. Charts communicate information by illustrating relationships among data. Different kinds of charts visualize different kinds of relationships among different kinds of data.

Certain relationships among data require particular types of charts to help you visualize the relationships. You can create charts to visualize relationships among your survey data. What kind of relationships do you need to visualize? The most common ways to visualize data include:

· Comparing parts of the whole to each other
· Looking for similarities or differences among items

· Tracking change over time

Once you know what you want to visualize, you must determine the most appropriate charts. Use your critical thinking skills to determine what types of charts can help you visualize your evaluation of decision alternatives.
You can use toolbar and wizard features of your spreadsheet application to create your charts. Spreadsheet applications also have toolbars and wizards to walk you through specialized tasks. Using them is very similar to how you created forms and queries in your database.
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Words to Remember

This page gives basic definitions for some important terms that can help you learn about data visualization. You can get a more complete definition of each term from Fact Monster*.

New Words

Bar Chart: A picture that compares similarities and differences in a set of data.

Graph: Another term for chart, especially one that shows the relationship between two or more sets of numbers, and also shows change over time.

Grid: A system of lines that divides a space into equally sized segments
Interpret: Understand or explain meaning.

Legend: A box or area that explains the meaning of colors or symbols used in a chart or graph.

Line Graph: A picture that shows how a set of data changes over time.

Pie Chart: A picture that compares parts of a set of data with each other and to the whole set.

Representation: An image, expression, or example of a topic or idea.

Visual: Using pictures or images to attract viewers’ eyes to information or ideas.

Visualization: A visual representation of information or an idea.

X-axis: The labeled straight line at the bottom of a chart or graph that runs left to right, or horizontally.

Y-axis: The labeled straight line at the side of a chart or graph that runs up and down, or vertically.

Review Words

Calculate: Find an answer by applying mathematical functions to numbers.

Chart: Another term for graph, especially one that uses a picture to show relationships among selected parts of a set of data.

Data Analysis: Selecting and using appropriate formulas and functions to answer questions with data.

Equation: A mathematical expression that includes operators and numbers or variables in which two quantities are equal.

Export: Send data from an application.

Formula: A set format for writing an equation with specific operators and variables (cell references) or numbers.

Function: A built-in formula that is built into a spreadsheet application.

Import: Bring data into an application.

Operator: A symbol that represents a specific mathematical calculation, such as + represents addition.

Spreadsheet: An application designed to analyze and represent data.

Value: The number or quantity represented by a variable or formula.

Variable: A letter used in an equation in place of a number that is unknown or can change, such as x in 4 + x = 9.

Workbook: A computer file created with a spreadsheet application and containing one or more worksheets.

Worksheet: A table with rows and columns with cells into which data and formulas can be entered.
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Learning from the Web

Charts are visual representations, or visualizations, of data. Charts make understanding the meaning of data easier, but you still must learn how to read and interpret them. Explore some Web sites about how charts can help you visualize information.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of any other questions about visualizing data with charts, keep those in mind too.

Guiding Questions

· What are the main parts of a chart and how does each part help you understand and visualize the data?

· What are the most common types of charts and what type of data does each type of chart help you visualize?

· What features do spreadsheet applications provide to help you create charts?

Web Sites

Understanding Charts

· Learning About Charts and Graphs* from FoDOweb*

· Graph Types* from NCEAS*

· Create a Graph* from NCES Kids*
· Getting the Picture: Communicating Data Visually* from Annenberg Media*

Creating Charts

· Creating a Chart or Graph* from Internet4Classrooms*

· Creating Graphs from Excel Data* from the EHS Virtual Computer Lab*

· How to Use the Excel Chart Wizard* from About*
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What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about using charts to visualize information. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Understanding Charts
All charts are visual representations of relationships among data. You have to know how to read and interpret a chart to understand what it is telling you. That means that you must be able to recognize the main parts of a chart and know what they do. 
The main parts of a chart are:

· Title: The title of a chart should quickly describe what the chart is about. A good title describes the data relationship a chart represents. In the example, the chart Reducing Global Warming by Personal Action shows how many students in an imaginary school have and have not taken at least one personal action to reduce global warming.

· X-axis: The x-axis should have a title that tells you what type of data is shown horizontally in the graph. In the example, the x-axis title is Grade. The x-axis should also include labels that tell you the values for the data. In the example, the values for grade are Sixth, Seventh, and Eighth.

· Y-axis: The y-axis should have a title that tells you what type of data is shown vertically in the graph. In the example, the y-axis title is Number of Students. The y-axis should also include labels that tell you the values for the data. In the example, the values are 0, 5, 10, 15, 20, 25, and 30.

· Legend: The legend describes how data is represented in the chart. In the example, the legend tells you that the red bars represent the number of students who have taken a personal action to reduce global warming. The blue bars represent the number of students who have not acted to reduce global warming.
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Using the Chart Wizard

Spreadsheet applications provide a chart wizard and toolbar to make creating charts easy. The chart wizard opens when you select Chart from the Insert menu or click the Chart Wizard button on a toolbar. You can open the Chart toolbar from the View menu at any time. You can revise an existing chart by clicking any part of the chart. You can format an existing chart by double-clicking any part of the chart.

A chart wizard helps make sure you remember to include all the main parts of a chart. A wizard is just a guide. It does not make decisions for you. To create a chart, you first select the data you want to represent, and then you select Chart from the Insert menu to open the wizard. You usually need to complete four steps to create a chart with a chart wizard:

1. Chart Type. Select a chart type from the list. Choose the type of chart that best fits your data. Click the Next button.

2. Chart Source Data. The data you want to represent will usually be stored in the rows of your worksheet. If you want to represent data stored in columns, you can change the source of data for the chart. Click the Next button.

3. Chart Options. Enter descriptive titles for the chart, x-axis, and y-axis. For a three-dimensional chart, type a descriptive title for the z-axis, the third axis in a three-dimensional chart. Make sure the legend provides any information needed to interpret the chart. Choose any other formatting options needed to make the chart easy to read and interpret. Click the Next button.

4. Chart Location. Place the chart on a new worksheet or an existing worksheet in the same workbook. Click the Finish button to create the chart.

As you work through the wizard, explore all of the tabs so you can see all available options. Before you click the Finish button, you can use the Back and Next buttons to revise the chart at any time. After you click the Finish button, select Print Preview from the File menu to see how your chart will look when it is printed. Review the chart to make sure it is easy to read and interpret.

Using the Chart Toolbar

The Chart toolbar provides quick access to all parts of a chart. The Chart toolbar is most useful when you want to revise an existing chart, but you can also use it to create a new chart. A chart toolbar has three essential components:

· Chart Type. Select a chart type from the drop-down menu. Choose the type of chart that best fits your data. If you are creating a new chart, the chart is automatically placed in the current worksheet when you select a chart type. If you are revising an existing chart, you can change the chart type by clicking any of the options.

· Chart Object. Select the part of the chart you want to edit from the menu.

· Format Selected Object. Click the Format icon to revise or format the selected part.

Whenever you revise or format a chart, select Print Preview from the File menu to see how your chart will look when it is printed. Review the chart to make sure it is easy to read and interpret.
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Know Your Charts

Certain kinds of data require particular types of charts and graphs to represent them. The most common types of charts include:

· Bar Chart. Compares similarities and differences in a set of data. The items that you want to compare are represented by bars. The height or length of the bar represents the quantity of each item. For example, you could use a bar chart to compare the amount of carbon dioxide, one of the greenhouse gases that causes global warming, emitted by different countries.
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· Line Graph. Shows how a set of data changes over time. Time is usually represented on the x-axis. The items that you want to track over time are represented by points connected by lines. The location of the point on the y-axis represents the quantity of a data item at a particular time. For example, you could use a line graph to track global emissions of carbon dioxide, one of the greenhouse gases that causes global warming.
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· Pie Chart. Compares parts of a set of data with each other and to the whole set. A pie chart gets its name from the fact that it looks like a pie—it is a circle representing a single set of data. Each part of the data set is represented by a slice of the pie. The size of the slice represents the quantity of that part. For example, the circle may represent all personal actions to reduce global warming taken by students in your class. Each slice would represent the number of students who took a particular action. A pie chart does not have an x-axis or a y-axis because it shows relationships within a single data set.
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What to Do

Complete the following task to show what you have learned about different types of charts. While you work through the task, think about whether you are achieving the goal. You may want to review an example of data visualization before you begin.
Task: Illustrate your survey data with charts so that you can visualize your data and make a decision.

Goal: Show that you know how to use charts to help you visualize information.

See the example: Microsoft Excel* or PDF

1. Open the workbook containing your imported query data.
2. Start a new worksheet. Always remember to type your name and the date at the top of the worksheet.
3. Create charts to visually represent your survey data. Add the charts to your worksheet. You may want to start a new worksheet for each chart.
4. Remember to save the workbook each time you create a new chart.
5. Revise and reformat your charts as needed. Make it easy to see how your charts and data help you evaluate possibilities.

6. Check with your teacher to make sure your charts accurately illustrate your survey data.
7. Use Print Preview to make sure your worksheets are properly formatted.

8. Review the checklist and revise your charts to make sure they are complete.
9. Share your charts.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about creating charts to visualize data. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. What chart would be best for comparing the responses to a close-ended question?

· Bar [Try again. Bar charts are not the best choice for comparisons of parts to parts or part to whole.]
· Line [Try again. Line graphs are not a good choice for comparisons of parts to parts or part to whole.]
· Pie [Correct! Pie charts show a comparison of part of a data set to other parts, such as the percentage of respondents who choose each answer to a close-ended question.]
2. What chart would be best for comparing your scores on each of four tests?

· Bar [Correct! Bar charts are the best choice for comparing similarities and differences in a set of data.]
· Line [Try again. Line graphs are not the best choice for comparing similarities and differences in a set of data.]
· Pie [Try again. Pie charts are not the best choice for comparing similarities and differences in a set of data.]
3. How does a chart wizard help you create a chart?

· A chart wizard makes decisions about what type of chart is most appropriate. [Try again. You must choose the type of chart that is appropriate for your data.]
· A chart wizard automatically includes all the main parts of a chart. [Try again. A chart wizard walks you through the steps of adding the main parts of a chart, but it does not automatically include all the parts.]
· A chart wizard helps make sure you include all the main parts of a chart. [Correct! A chart wizard is a guide that helps you include all the main parts of a chart.]
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Task: Make your choice and explain your decision.

Goal: Show that you can format data and charts to help you make and explain a decision.

You may want to review an example of a decision choice and a decision explanation before you begin.
See the examples: 
Microsoft Excel* | PDF

Microsoft Word* | PDF
Key Concept

Are you ready to make a choice? You have worked hard to collect and analyze opinion data to help you evaluate the possibilities of each decision alternative. What have you learned from your survey that can help you make a choice? How can you represent what you decided visually?

Are you ready to make a choice and explain your decision making process to others? Before you share your decision with others, you should format your worksheets. Formatting allows others to easily see the data you collected and what data you used to evaluate possibilities.

Survey results can be shared in many ways. Decision makers often print charts that represent their data and share them with peers. Sometimes, decision makers create posters that explain their choices and how they made their decisions.
Why would you want to share your decision? Format your worksheets and share them with teachers, classmates, or other people you know. Use the feedback you get to help ensure that you evaluate all possibilities with reason and fairness and make the best choice.
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Words to Remember

This page gives basic definitions for some important terms that can help you learn about formatting worksheets and charts to share and explain decisions. You can get a more complete definition of each term from Fact Monster*.

New Words

Alignment: Specific arrangement of type and graphics in a publication.

Font: A collection of letters and numbers in the same type.

Type: A style of letters and numbers used in a publication or presentation.

Review Words

Bar Chart: A picture that compares similarities and differences in a set of data.

Chart: Another term for graph, especially one that uses a picture to show relationships among selected parts of a set of data.
Data: Information collected by observation or measurement.

Graph: Another term for chart, especially one that shows the relationship between two or more sets of numbers, and also shows change over time.
Grid: A system of lines that divide a space into equally sized segments.

Interactive: Performing actions based on input from a user.

Legend: A box or area that explains the meaning of colors or symbols used in a chart or graph.

Line Graph: A picture that shows how a set of data changes over time.

Pie Chart: A picture that compares parts of a set of data with each other and to the whole set.

Representation: An image, expression, or example of a topic or idea.

Visual: Using pictures or images to attract viewers’ eyes to information or ideas.

Visualization: A visual representation of information or an idea.

Wizard: An interactive feature designed to help users of an application perform a specific task in a series of steps.

X-axis: The labeled straight line at the bottom of a chart or graph that runs left to right, or horizontally.

Y-axis: The labeled straight line at the side of a chart or graph that runs up and down, or vertically.
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Learning from the Web

Sharing your decision with peers can help ensure that you evaluate all possibilities with reason and fairness and make the best choice. Formatting your worksheets and charts makes them easier for your peers to read and interpret. Explore some Web sites about using a spreadsheet application to format charts and worksheets.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you have any other questions about formatting worksheets and charts, keep those in mind too.

Guiding Questions

· How can you make sure your charts and data are easy to read and interpret?

· Which decision alternative is best supported by your visualization?

Web Sites

Formatting a Spreadsheet

· The Formatting Toolbar* from Internet4Classrooms*

· Basic Formatting in Excel—Tutorial Part 1* from About*

· Basic Formatting in Excel—Tutorial Part 2* from About*

· How to Use the Print Options in Excel* from About*
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What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about formatting worksheets and charts to share and explain decisions. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Getting Feedback by Sharing Data
Once you have analyzed and visualized your data, you are ready to make a choice and share the decision with peers. Sharing your decision with peers can help ensure that you evaluate all possibilities with reason and fairness and make the best choice. Critical thinking skills can help you make a choice and explain your decision. 
Consider the following questions:

Decision 
· Why did you collect this data? 
· How did you expect your survey data to help you make a decision? 
· How does your survey data help you understand different points of view on the decision?

Information 
· What kinds of information does your analysis of the survey data provide? 
· How does your survey data support or dispute other information you gathered? 
· What formulas and functions can provide information that helps you make a decision?
Alternatives 
· How does your analysis help you refine alternative choices? 
· What information does your survey data provide about each alternative? 
· How can your survey data help you look at alternatives from different points of view?
Possibilities 
· How does your analysis help you evaluate the possibilities of each alternative? 
· What possibilities are supported by your survey data? 
· What possibilities does your survey data suggest are unlikely?

Choice 
· How does your survey data help you make a choice? 
· What choice does your data analysis most support? 
· How does the analysis help you explain your choice? 
· What other data might cause you to reconsider your choice?

Decision makers often print worksheets and charts to share with peers. Sometimes, they create posters that explain their choices and how they made their decisions. You can share your data with teachers, classmates, or other people you know. Use the feedback you get to help ensure that you evaluate all possibilities with reason and fairness and make the best choice.
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Formatting Your Data

You always want your work to look great! Formatting your spreadsheets is just as important as formatting your word processing documents. The graphical user interface for formatting a spreadsheet is very similar to the GUI in a word processing application and other applications. After you format your spreadsheet, you need to make sure it is properly set up for printing.

The Format menu and toolbar can help you format a spreadsheet:

Format Menu and Toolbar

· Font. You can change the font, size, and style from either the Format menu or toolbar. You should use fonts that make your data easy to read. Use bold and italic sparingly for headings or emphasis. The Format menu offers more font choices than the toolbar.

· Alignment. A spreadsheet automatically aligns numbers to the right of a cell and words to the left. In most cases, this makes both numbers and words easier to read. Sometimes, you may want to change the alignment of a cell. For example, you should usually center column headings. You can change alignment from either the Format menu or toolbar.

· Numbers and Dates. The ability to format numbers and dates is one of the most useful features of a spreadsheet. For example, you can choose the number of decimal places to display in a cell, row, or column. Another common number format is for percentages. For example, you can format the value 0.80 to display as 80%, 80.0%, 80.00%, and so forth. The value of the data does not change, only the appearance of the data in the spreadsheet. You can change some number and date formats from the Format toolbar and many more options are available from the Format menu.

· Merge and Center. Sometimes, you may want to combine two or more cells into one cell. This usually happens when you want to create a heading for two or more columns. All you have to do is select the cells you want to merge and click the Merge And Center icon on the Formatting toolbar. Make sure the text for the heading is in the left-most cell. The contents of the other cells you merge will be lost.

· Borders. You can create borders for cells from either the Format menu or toolbar. Borders are especially useful for separating column headings from data. You should use borders sparingly in most cases.

· Color. You can change font color and the background color of cells by using either the Format menu or toolbar. Wise color choices can make a spreadsheet more attractive to view and easier to read, but using too many colors or low contrasting colors can make your spreadsheet difficult to read. Be smart about what colors you use and how much you use them!

· Column Width. You can change column width from the Format menu. You can also drag the line that separates one column from the next. You want to make sure that a column is wide enough to display all the data it contains. AutoFit automatically adjusts the column width to accommodate your data.

· Row Height. You can change row height from the Format menu. You can also drag the line that separates one row from the next. Adjusting row height can make your spreadsheet more attractive and easier to read.

File Menu

· Page Setup. Page Setup allows you to control how a spreadsheet will look when it is printed. You can change the page orientation from portrait to landscape when the width of your data is greater than the height. You can reduce the size of a spreadsheet to fit onto a page. You can change the margins or create a header or footer to display at the top or bottom of each printed page. You can set a print area if you only want to print a certain part of a spreadsheet. You can set print titles so that column or row headings appear on every page. This is useful when your data requires more than one page to print. Page Setup is accessible from the File menu or Print Preview mode.
· Print Preview. Print Preview allows you to see how a spreadsheet will look when it is printed. You can enter Print Preview mode from the File menu or the Standard toolbar.
· Print. You can print a spreadsheet from the File menu or while in Print Preview mode.
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What to Do

Complete the following task to show what you have learned about using charts to represent data. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a decision choice and a decision explanation before you begin.
Task: Make your choice and explain your decision.

Goal: Show that you can format data and charts to help you make and explain a decision.

See the example: Microsoft Excel* or PDF





    Microsoft Word* or PDF
1. Open the workbook that contains your summarized survey data and charts.

2. Use appropriate formatting features to make your data and charts more attractive and easy to read.

3. Remember to save your worksheets often while you work.

4. Make sure your evaluation and choice are clearly visible in your data.

5. Check with your teacher to make sure your worksheets are properly formatted.

6. Start a new word processing document. Always remember to type your name and the date at the top of the document.
7. Type a title for the document. You may want to include your topic, such as Decision Choice for ______________.
8. Use critical thinking skills to make a choice. Make sure you address each of the following questions:
· Which alternative is the best choice for your decision?

· How did your survey data help you make your choice?

· How did other information you gathered help you make your choice?

· What other data might cause you to reconsider your choice?

9. Remember to save your document often while you work.
10. Check the spelling and grammar of your decision choice.
11. Double-check your work by reading the document carefully one more time.
12. Review the checklist and revise your decision choice to make sure it is complete.
13. Share your decision choice.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about formatting worksheets and charts. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. How would the value 0.8 appear when formatted in percent style?

· 8% [Try again. This is how the value 0.08 would appear in percent style.]
· 80% [Correct! 0.8 is equivalent to 80%.]
· 0.8% [Try again. This is how the value 0.008 would appear in percent style.]
2. What feature allows you to control the page orientation, margins, headers, and how a spreadsheet will look when it is printed?
· Format menu [Try again. The Format menu controls how data is displayed in the spreadsheet.]
· Page Setup [Correct! Page Setup allows you to change the page orientation, margins, headers, footers, print area, and print titles.]
· Print Preview [Try again. Print Preview shows you how a spreadsheet will look when it is printed, but it does not control how the spreadsheet looks.]
3. What can be used to make column headings more distinct from data?

· Borders [Try again. Borders can separate headings from data, but another answer is better.]
· Color [Try again. Color can draw more attention to headings, but another answer is better.]
· Both of the above [Correct! Borders can separate headings from data, and color can draw more attention to headings.]
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Thinking about Learning

What have you learned in this module? You created a form to enter your survey data into a database. You created queries to retrieve information from your survey database. You analyzed your survey data to help you make a decision. You created charts to help you visualize your survey data.

You have learned:

· How to create a form for entering data into your survey database

· How to create queries to retrieve survey data that inform your decision
· How to analyze your survey data with formulas and functions

· How to read and interpret different kinds of charts

· How to create charts to help you visualize your evaluation and choice
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Checklist for Data Analysis
A checklist can help you keep track of your work throughout the activity. Have you completed the task in each activity? Use the checklist to make sure you are ready to publish the results of your data analysis. Ask your teacher for help if you have any questions about the checklist.

Activity 1: Database Forms

Task: Database Form

· Open your survey database

· Create a form to enter all of the fields in your tables

· Choose the types of controls you plan to use:

· Text Box

· Option (Radio) Button

· Checkbox

· List Box

· Combo Box

· Command Button

· Set the properties of all labels and controls (in design view)

· Open your form and enter the remaining records of your survey data

· Check that all data is entered and visible when you open the form

· Save your form

Activity 2: Database Queries

Task: Database Query Design

· Open a new word processing document and type your name, date, and a title

· Design at least two queries that provide information to help you make your decision and consider the following questions:

· What do you want to know?

· Which tables and fields contain the information you need?

· What keywords or criteria can you use to retrieve the information?

· Follow the steps to create queries:

· Select tables

· Select fields

· Show and sort

· Set criteria

· Save the query

· Open your survey database

· Create at least one query in design view and one using the wizard, and save each with a descriptive name

· Run your queries and see the results in datasheet view

· Refine the query in order to get the results you expected

· Make sure all your data is visible in the results of each query

· Save your database

Activity 3: Decision Possibilities

Task: Data Summary

· Open your survey database

· Export the data from your queries

· Start a new spreadsheet workbook and type your name and the data

· Import the data from your queries into the spreadsheet

· Use appropriate formulas and functions to analyze your data

· Open a new word processing document and type your name, date, and a title

· Evaluate your decision alternatives by addressing the following questions:

· How did you expect your survey data to help you make a decision?

· What kinds of information does your analysis of the survey data provide?

· How does your analysis help you refine alternative choices?

· What information does your survey data provide about the possibilities of each 
alternative?

· How does your analysis help you evaluate the possibilities?

· Check the spelling and grammar of your evaluation

· Save your document

Activity 4: Data Visualization

Task: Data Charts

· Open the workbook with your imported query data

· Start a new worksheet and type your name and the date

· Create charts to represent your survey data and add the charts to your worksheet(s), making sure that you:

· Choose the type of charts that best represent your data

· Import the data you want to represent in your charts

· Title each chart

· Title and label the x-axis (not for pie chart)

· Title and label the y-axis (not for pie chart)

· Create a legend

· Place the chart on a new worksheet or an existing worksheet in the same workbook

· If necessary, revise and reformat your charts to clearly visualize your data

· Save your charts

Activity 5: Decision Choice

Task: Decision Choice

· Open the workbook with your summarized survey data and charts

· Format your data and charts to make them more attractive and easy to read

· Make sure that your evaluation and choice are clearly shown in your data

· Start a new word processing document and type your name, date, and a title

· Use critical thinking skills to make a choice and explain your choice by addressing the following questions:

· Which alternative is the best choice for your decision?

· How did your survey data help you make your choice?

· How did other information you gathered help you make your choice?

· What other data might cause you to reconsider your choice?

· Check the spelling and grammar of your choice explanation

· Save your document
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Rubric for Data Analysis
The main purpose of a rubric is to help you do your best work. What column best describes your worksheets, charts, and analysis? Is all of your work best described by column 4? If not, what could you improve?
	
	4
	3
	2
	1

	Forms and Queries
	Advanced database features are used to ensure the integrity of all data in forms and queries.

Data is manipulated efficiently with forms and queries.

Correct database terminology is used when discussing database features.
	Forms and queries accurately represent all of the data collected.

Forms and queries data tables are used without assistance

Basic database menus and commands are used efficiently.
	Forms and queries accurately represent most of the data collected.

Forms and queries data tables are often used without assistance.

Database menus and commands are sometimes used efficiently.
	Forms or queries are missing or do not accurately represent the data collected.

Forms or query data tables are rarely used without assistance.

Database menus and commands are not used efficiently.

	Decision Possibilities
	The evaluation is precise and uses relevant information to develop important possibilities that are logical and thoroughly supported.

Different types of formulas effectively analyze all of the relevant data.
	The evaluation is precise and uses relevant information to develop important possibilities, but they may not be logical or well-supported.

Formulas effectively analyze most of the relevant data.
	The evaluation is precise and provides relevant information, but possibilities are unimportant or poorly developed.

Formulas accurately analyze relevant data, but other formulas would be more effective.
	The evaluation is not precise and provides inaccurate or irrelevant information.

Formulas are missing or do not accurately analyze relevant data.

	Data Visualization
	All charts are clearly used to develop important concepts that support a decision alternative.

Different types of charts represent all relevant data accurately and effectively.
	Most charts are used to develop important concepts, but they may not support a decision alternative.

Charts represent most relevant data accurately and effectively.
	Most charts have a clear purpose, but they may not be used to support a decision alternative.

Charts represent relevant data, but other kinds of data or other types of charts would be more effective.
	Charts are missing or do not have a clear purpose.

Charts are missing or do not accurately represent the relevant data.

	Decision Choice
	Worksheets and charts are attractive and engaging, easy to read and interpret, and provide visual evidence of all survey results and thoroughly support a choice.
	Worksheets and charts are easy to read, summarize poll results, and provide adequate evidence to support a choice.
	Worksheets and charts are easy to read and summarize poll results but do not provide enough evidence to support a choice.
	Worksheets and charts are difficult to read and do not summarize poll results or support a choice.

	Writing Mechanics
	All words are spelled and capitalized correctly.

All sentences are punctuated correctly.
	Almost all words are spelled and capitalized correctly.

Almost all sentences are punctuated correctly.
	Several words are misspelled or capitalized incorrectly.

Several sentences are punctuated incorrectly.
	Many words are misspelled and capitalized incorrectly, making the information hard to understand.

Many sentences are punctuated incorrectly, making the information hard to understand.

	Database

Basics
	Data is entered and tables are formatted accurately.

Advanced database features and terminology are used correctly.
	Data is entered and tables are generally formatted accurately.

Basic database features and terminology are used correctly.
	Data is entered and tables are created without assistance.

Basic database features and terminology are sometimes used correctly.
	Data is entered and tables are created with much assistance.

Basic database features and terminology are not used, used incorrectly, or used with much assistance.

	Spreadsheet Basics
	Formulas are entered and charts are created without assistance, and advanced spreadsheet menus and commands are used efficiently.
	Formulas are entered and charts are created without assistance, and basic spreadsheet menus and commands are used efficiently.
	Formulas are entered and charts are created without assistance, but basic spreadsheet menus and commands are not used efficiently.
	Formulas are entered and charts are created with assistance, or formulas and charts are not used. 
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Reflection on Data Analysis
How can you make sure you really understand something? One of the best ways is to explain it to someone else. You might talk to another student, a teacher, or someone in your family.

Be prepared to discuss:

· What you learned about creating queries and forms in a database application

· How you analyzed your data and evaluated alternative choices for your decision

· What you learned about reading and interpreting different kinds of charts

· What you learned when you shared your evaluation and choice with others
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Checklist: Before you begin, review the checklist for this module. Use the checklist to make sure that you complete all the tasks for each activity.
See the checklist >
Rubric: Before you begin, review the rubric for this module. Use the rubric to help you understand what is important to know and do.
See the rubric >

Big Idea

Congratulations on your accomplishments so far! You have shown that you are a critical thinker and an effective decision maker. You defined a decision, gathered information, developed alternatives, evaluated possibilities, and made a choice. You can share your successful decision making with a live audience by creating, preparing, and delivering an expository presentation. You have everything you need to create an interesting and informative presentation. Can you make your presentation entertaining too? You can enhance your presentation with images, audio, and video by learning how to manage multimedia from the Internet legally and ethically.

In this module:

· Learn how to use expository nonfiction in a presentation

· Outline an interesting and informative presentation about your decision making process
· Create an attractive and easy-to-read presentation from your outline

· Enhance your presentation by adding multimedia legally and ethically

· Deliver an interesting, informative, and entertaining presentation

Activity 1: Expository Nonfiction >

What if your teacher asked you to explain your decision to a live audience? Expository nonfiction explains a topic in an interesting and informative way. Most presentations are one of many different uses of expository nonfiction. Learn how to use expository nonfiction in a presentation.

Activity 2: Presentation Outline >

What characteristics make presentations interesting and informative? Effective presentations use few words to convey the most important ideas. An outline can help you decide what ideas to include. Outline an interesting and informative presentation about your decision making.

Activity 3: Presentation Design >

When you have a live audience, make the most of it! Presentation tools provide the technology you need to create a presentation. Graphic design provides the knowledge and skills to use the technology tools effectively. Create an attractive and easy-to-read presentation from your outline.

Activity 4: Multimedia Management >

Can a presentation be entertaining as well as interesting and informative? Multimedia presentations use images, audio, and video to explain a topic. Most images, audio, and video on the Web are copyrighted. Enhance your presentation by adding multimedia legally and ethically.

Activity 5: Presentation Delivery >

How can you make sure your presentation is a success? Delivering a multimedia presentation to an audience is a performance—and you are the star! Preparation is the most important part of any performance. Deliver an interesting, informative, and entertaining presentation.

Look Back >

Reflect on what you learned in this module. Are you confident in creating, preparing, and delivering a presentation? Use the checklist to make sure your tasks are complete. Use the rubric to assess your expository presentation. Talk about what you learned and how you did your work.
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Checklist for Expository Presentation
Checklists can help you keep track of your work. Use the following checklist to make sure you complete the task for each activity. If you have access to a printer, you may want to print the checklist for reference as your work through the activities. Ask your teacher for help if you have any questions about the checklist.
Activity 1: Expository Nonfiction

Task: Expository Analysis

· Look at an example of an expository presentation

· Open a new word processing document and type your name, date, and a title

· Write two or three paragraphs explaining how the presentation uses the expository style of writing, by:

· Citing specific instances of effective (or ineffective) expository writing

· Explaining what types of expository writing the presentation uses

· Explaining what you learned from the presentation

· Check the spelling and grammar in your paragraphs

· Save your analysis

Activity 2: Presentation Outline

Task: Expository Presentation Outline

· Open a new word processing document and type your name, date, and a title

· Create an outline using your graphic organizer you created earlier in the decision making process

· Use an outline format with:

· A title

· An introduction

· At least three main points in a logical order

· Supporting points for the main points in a logical order

· A conclusion

· Make sure that labels are short, descriptive, and written in a consistent manner

· Check that you have not repeated ideas

· Save your document

Activity 3: Presentation Design

Task: Presentation

· Open your presentation outline

· Start a new slideshow presentation and type your name and the date on the title slide

· Use the Insert menu to create slides from your presentation outline

· Use the Edit and Format menu to make sure your main and supporting points are clear

· Use graphic design principles to make your presentation visually appealing

· Exchange presentations with a peer and review each other’s work, making sure to:
· Provide positive feedback: point out the parts that are attractive and easy to read

· Provide specific suggestions for improvement: point out the parts that may need to be 
revised

· Review the peer review of your presentation

· Revise your presentation based on the feedback

· Check the spelling and grammar of your presentation

· Save your presentation

Activity 4: Multimedia Management

Task: Media Citations

· Open a new word processing document and type your name, date, and a title

· Find at least three images and one audio or video clip on the Web that helps to explain how you defined your decision, gathered information, developed alternatives, and made a choice

· Download the media to your computer

· Add the media to your word processing document

· For each image or clip:

· Cite the source

· Explain how the media helps explain your decision

· Record the copyright status

· Get permission for any of the images, audio, or video if necessary

· Insert the media into your presentation, using graphic design principles to enhance your presentation

· Exchange presentations with a peer and review each other’s presentations, making sure to:
· Provide positive feedback: point out the media that are most effective

· Provide specific suggestions for improvement: point out the media that may need to be 
removed or replaced

· Review the peer review of your presentation

· Revise your presentation based on the feedback

· Check the spelling and grammar of your presentation

· Save your presentation

Activity 5: Presentation Delivery

Task: Final Presentation

· Open your presentation

· Check the spelling and proofread your presentation

· Practice delivering your presentation, remembering to:

· Review your slide order

· Run the slideshow from View or Slide Show menu to make sure your slides are ready to present

· Practice in front of a mirror, a friend, or an adult

· Make sure you know how to connect and use a projector

· Set up a projection device
· Deliver your presentation to an audience, making sure to:

· Dress appropriately

· Summarize and emphasize the main points

· Make eye contact

· Make sure your audience understands everything

· Stay on schedule

· Answer questions

· Get feedback from someone in the audience by asking:

· What parts had the most and least visual appeal?

· Were any parts difficult to read or understand?

· What did the viewer learn from your presentation?

· What parts of the presentation did the viewer find most and least interesting?

· What questions did the viewer have that were not answered in your presentation?
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Rubric for Expository Presentation
The main purpose of a rubric is to help you do your best work. Use the rubric to make sure you understand what you are expected to learn. Is all of your work best described by column 4? If not, what can you improve? If you have access to a printer, you may want to print the rubric for reference as your work through the activities. Ask your teacher for help if you have any questions about the rubric.

	
	4
	3
	2
	1

	Outline
	The outline clearly shows the relationships among main points and supporting points. 
	The outline consistently distinguishes main points and supporting points, and shows relative importance of relationships.
	The outline distinguishes most main points and supporting points related to research questions, but does not show relative importance of relationships.
	The outline does not relate to research questions or does not distinguish main points and supporting points.

	Content
	The presentation thoroughly captures and holds the audience’s attention.

The presentation explains the decision in a smooth and logical order, and offers a new viewpoint or insight in a way that makes a lasting impression on the audience.
	The presentation adequately captures the audience’s attention.

The presentation explains the decision in a smooth and logical order, and offers a new viewpoint or insight; however, the content may not make a lasting impression on the audience.
	The presentation does not capture the audience’s attention throughout.

The presentation clearly states, adequately explains, and summarizes the decision; however, the content may not be engaging or may not be presented in a smooth and logical order.
	The presentation does not capture the audience’s attention.

The presentation does not clearly state, adequately explain, or summarize the decision.



	Design
	Slide layouts are consistent and easy to read, and use a variety of design principles to attract and hold interest.
	Slide layouts are consistent and easy to read, but may not use design principles to attract and hold interest.
	Slide layouts are consistent, but may be too plain to hold interest or too cluttered for the audience to read.
	Slide layouts are not consistent and may be too plain to hold interest or too cluttered for the audience to read.

	Multimedia
	Images, audio, and video enhancements are credited, support and illustrate main points, and enrich the audience’s learning experience.
	Images, audio, and video enhancements are credited and carefully selected to support and illustrate important main points.
	Images, audio, or video enhancements are not credited or sometimes distract the audience from the content.
	Presentation does not include images, audio, or video enhancements.

	Delivery
	Presenter maintains consistent eye contact, rarely refers to notes, and frequently interacts with the audience.
	Presenter makes frequent eye contact, sometimes refers to notes, and answers most questions.
	Presenter frequently refers to notes but makes some eye contact and answers some questions.
	Presenter does not make eye contact, reads from notes, or does not answer questions.

	Mechanics
	All multimedia and effects work properly, and technical problems do not occur.
All words are spelled and capitalized correctly.
	Most multimedia and effects work properly, and technical problems are resolved quickly.

Almost all words are spelled and capitalized correctly.
	Most multimedia and effects work properly, but technical problems interrupt the presentation.

Several words are misspelled or capitalized incorrectly.
	Multimedia or effects do not work properly, or technical problems make the presentation difficult to understand.
Many words are misspelled and capitalized incorrectly.

	File Management
	Files are clearly named, consistently saved to the correct location, and well-organized in folders.
	Files are clearly named and consistently saved to the correct location, but they are not well-organized in folders.
	Work is not lost, but files are not clearly named or not consistently saved to the correct location.
	Work is lost because files are not clearly named or not consistently saved to the correct location.
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Task: Read and interpret an expository presentation on a subject that interests you.
Goal: Show that you know how to recognize and read different types of expository writing.

You may want to review an example of an expository analysis before you begin.
See the example: Microsoft Word* | PDF
Key Concept

What if your teacher asked you to explain how you made your decision to a live audience? For example, you might be asked to share your decision with your class, parents, or community members. Making a decision with data was a lot of work, so you would have a lot to explain!
Being able to explain a topic and inform an audience is an important communication skill. The expository style of writing helps you to tell readers what you know about a topic or show readers how to do something. A well-written exposition presents all relevant information without favoring any particular point of view.
Different types of expository writing serve different purposes. If you decided to take personal actions to reduce global warming, for example, you would want to explain the causes and effects of climate change. You could also classify and divide possible personal actions to explain how you decided which personal action was best for you.

A presentation is an explanation of a topic to a live audience, so most presentations use the expository style of writing. Effective presentations use few words to convey the most important ideas and concepts. Although the format is different from an essay, presentations are one of the most important uses of expository nonfiction.

Next to Vocabulary >
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Words to Remember

This page gives basic definitions for some important terms that can help you learn about expository nonfiction. You can get a more complete definition of each term from Fact Monster*.

New Words

Audience: The people who read a publication or view a work of art, performance, or presentation.

Cause: A person, group, event, idea, action, or object that produces a specific result or outcome.

Classify: Arrange people, groups, places, events, ideas, actions, or objects so that each one is assigned to a category.

Compare: Study two (or more) people, groups, places, events, ideas, actions, or objects to identify shared characteristics.

Contrast: Type or graphics that work together to create a desired effect; also, study two (or more) people, groups, places, events, ideas, actions, or objects to identify distinctive characteristics.

Divide: Separate people, groups, places, events, ideas, or things so that each one is placed into a category.

Effect: A specific result or outcome produced by something said or done by a person, group, event, idea, or thing.

Expository: A type of writing that explains a topic or informs an audience.

Interpret: Understand or explain meaning.

Nonfiction: Any creative work that describes or comments on actual events, such as a newspaper article or biography.

Presentation: An explanation of a topic given in the presence of an audience.

Review Words

Type or graphics that work together to create a desired effect; also, study two (or more) people, groups, places, events, ideas, actions, or objects to identify distinctive characteristicsData: Information collected by observation or measurement.

Fact: Information widely believed to be true and supported by objective data.

Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Objective: Able to put aside personal feelings and opinions.

Opinion: Beliefs that may or may not be supported by facts.
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Learning from the Web

Explore some Web sites about expository nonfiction. Notice the different types of expository writing, such as compare-and-contrast and classify-and-divide. Learn how to read expository nonfiction and distinguish different expository types.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of any other questions about the expository style of writing, keep those in mind too.

Guiding Questions

· What are some good reasons to write in the expository style?

· How is the expository style different from other writing you may have done?

· How can you recognize different types of expository writing?

Web Sites

· You Got Some 'Splaining to Do, Lucy: Exposition* from Fact Monster*

· The Perfect Couple: Cause and Effect*

· Neat and Tidy: Classify—Divide*

· Alike and Different: Comparison and Contrast*

· You Could Look It Up: Definition*

· “How-to” Essays: Process Analysis*
· Writing Workshop: Research Paper* from Scholastic*

· Expository Essays and Prompts* from The Five Paragraph Essay*

· Expository Essay* from Essay Info*
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Learn how to use different types of expository writing.

Read more >
What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about expository nonfiction. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

The Expository Style of Writing

The expository style of writing is a good choice when you want to tell readers what you know about a topic or show readers how to do something. The primary purpose of an exposition is to communicate information to an audience. Expository writing presents objective information, such as facts and data, without favoring any particular point of view.

You can use the expository style to write about almost any topic in almost any subject. Different types of expository writing are best for different purposes. Most expository types can be used in almost any subject, but some are particularly useful in certain subjects. An exposition may use only one of these types, or it may use multiple types for different purposes within the essay.

You should be able to distinguish the following five types of expository writing:
· Cause-and-effect expositions explain why an event happens.

· Classify-and-divide expositions sort people, groups, places, events, ideas, actions, or objects into categories based on similarities and differences.

· Compare-and-contrast expositions explain the similarities and differences among two or more different people, groups, places, events, ideas, actions, or objects.

· Definition expositions explain the most important characteristics of a person, group, place, event, idea, action, or object.

· Process expositions tell an audience how to complete an action.

Expository writing is probably the most common type of nonfiction. Research papers are usually written in the expository style because they report facts and data about a topic. You could also use the expository style in a book report, memorandum, presentation, poster, letter, or e-mail.
Expository Nonfiction in Presentations

Any time objectivity is important, the expository style can help. A presentation is an explanation of a topic to a live audience, so most presentations use the expository style of writing. The format in which you choose to write depends on your purpose and audience.
If you decided to take personal actions to reduce global warming, for example, you could use the expository style to explain the causes and effects of climate change. You could also use the expository style to classify and divide possible personal actions to explain how you decided which personal action is best for you.

If you decided that a species should be added to the endangered list, you could use the expository style to compare and contrast the species with other endangered species. You could also use the expository style to explain how the species meets the definition of endangered.

Effective presentations use few words to convey the most important ideas and concepts. Presentations put information on slides in the same way that other types of writing put information into paragraphs. Well-crafted slides and well-written paragraphs share many characteristics.

Some important points to remember about the expository style in presentations:

· The topic must be specific enough to present all relevant information in the presentation.

· The first slide should clearly state the topic and the purpose of the presentation.
· Each slide should be organized around a main point.

· All information in a slide should be directly related to its main point.

· Slides should be arranged in a logical order that is easy to follow and understand.

· The last slide should summarize the information that has been presented and explain how the purpose of the presentation has been achieved.

· The last slide should not introduce any new information.

< Back to Exploration | Next to Task >
	Type of Page 
	Leaf

	Supertitle
	Expository Presentation | Expository Nonfiction

	Headline Title
	Expository Types


< Return to Information
View as Microsoft
 Word* | View as PDF

Types of Expository Writing

You can use the expository style to write about almost any topic in almost any subject. Different types of expository writing are best for different purposes. Most expository types can be used in almost any subject, but some are particularly useful in certain subjects. An exposition may use only one of these types, or it may use multiple types for different purposes within the essay.

You should be able to distinguish the following five types of expository writing:
Cause and Effect
Cause-and-effect expositions explain why an event happens. The reasons an event happens are causes, and the actual event is the effect. A simple event may have only one cause, but complex events usually have many causes. A single cause may also have many effects. Cause-and-effect relationships are particularly useful in science and social studies because they help explain natural and human events.

Cause-and-Effect Words: because, due to, consequently, if… then, therefore, and thus.
Classify and Divide
Classify-and-divide expositions sort people, groups, places, events, ideas, actions, or objects into categories based on similarities and differences. The goal is usually to use as few categories as possible without overlap. For example, scientists sort living organisms into species with each organism belonging to exactly one species. An effective classify-and-divide exposition must be useful for some purpose. For example, knowing how to classify different species helps scientists understand how life evolved.
Classify-and-Divide Words: sort, category, class, group, type, and kind.

Compare and Contrast
Compare-and-contrast expositions explain the similarities and differences among two (or more) people, groups, places, events, ideas, actions, or objects. The exposition may present all characteristics of one item and then another, or similarities and differences in the characteristics may be presented one at a time. Compare-and-contrast expositions are especially flexible, having effective uses in almost any subject.
Compare Words: also, both, like, alike, likewise, comparable, similar, and related.
Contrast Words: however, but, not, different, distinct, contrasting, unlike, dissimilar, and unrelated.

Definition
Definition expositions explain the most important characteristics of a person, group, place, event, idea, action, or object. They explain what makes the item being defined what it is and not something else. The goal is to define the item in such a way that it could not be mistaken for anything else. The readers should be able to identify the item being defined even if they did not know the topic of the exposition.

Definition Words: defined, characterized, identified, named, termed, labeled, distinguished, exemplified, and restricted.

Process
Process expositions tell an audience how to complete an action. They follow a sequence from a starting point to a successful conclusion. The goal is to explain the process in such a way that the reader can follow the sequence without any missteps or mistakes. Process expositions are particularly important in math and science. They can explain how to carry out a calculation, solve a problem, or conduct an experiment.

Process Words: directions, instructions, procedure, step, method, formula, technique, apply, carry out, follow, conduct, and perform.
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What to Do

Complete the following task to show what you have learned about expository nonfiction. While you work through the task, think about whether you are achieving the goal. You may want to review an example of an expository analysis before you begin.
Task: Read and interpret an expository presentation on a subject that interests you.
Goal: Show that you know how to recognize and read different types of expository writing.

See the example: Microsoft Word* or PDF

1. Most of the reading and writing we are asked to do in school and work is in the expository style. Find an example of an expository presentation about a subject that interests you. You can use one of the following Web sites or other sources. You may want to check with your teacher to make sure the presentation you choose is appropriate.

Collections of Multimedia Presentations

· Science Presentations* from North Chadderton School*

· PowerPoint Slides Available for Download* from Internet4Classrooms*

· PowerPoint Resources Found on the Web* from Internet4Classrooms*

Examples of Multimedia Presentations

· Effective Presentations* from Eastern Connecticut State University*

· Desert Survival* from North Chadderton School*

· Periodic Table* (Hypertext and Hypermedia) from Internet4Classrooms*

2. Start a new word processing document. Always remember to type your name and the date at the top of the document.

3. Type a title for the document. You may want to include the title of the example you analyze, such as Expository Analysis of ______________.

4. Write two or three paragraphs explaining how the presentation uses the expository style of writing. Make sure you address each of the following matters:

· Cite specific instances of effective (or ineffective) expository writing

· Explain what types of expository writing the presentation uses

· Explain what you learned from the presentation

5. Remember to save your document frequently while you work.

6. Check the spelling and grammar in your paragraphs.
7. Double-check your work by reading your document carefully one more time.

8. Review the checklist and revise your analysis to make sure it is complete.
9. Share your analysis.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about types of expository writing. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. An expository essay is a good choice for which of the following purposes?

· Describing [Try again. An expository essay may be descriptive, but that is not its main purpose.]
· Persuading [Try again. An expository essay may be persuasive, but that is not its main purpose.]
· Explaining [Correct! An expository essay presents objective information about a topic.]
2. In what format would you most likely use the expository style of writing?

· Personal narrative [Try again. The narrative style of writing is primarily intended to describe rather than explain.]
· Research paper [Correct! Research papers are usually written in the expository style because they report facts and data about a topic.]
· Short story [Try again. Short stories are written in narrative style, which is primarily intended to describe rather than explain.]
3. What type of expository writing would you use to explain the similarities and differences between two authors or artists?

· Classify and divide [Try again. Classify-and-divide expositions separate multiple items into categories.]
· Compare and contrast [Correct! Compare-and-contrast explanations can be used in any subject to explain how two items are alike and different.]
· Process [Try again! Process expositions explain how to do something, such as write a story or paint a mural.]
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Task: Create an outline of your expository presentation.

Goal: Show that you can craft an effective structure for an interesting and informative presentation.

You may want to review an example of an expository presentation outline before you begin.
See the example: Microsoft Word* | PDF
Key Concept

What characteristics make a presentation interesting and informative? You have everything you need to create an expository presentation to explain how you:

· Defined a decision based on a complex topic

· Gathered information from a variety of sources and survey data

· Developed alternative choices that could be made

· Evaluated possibilities for each alternative choice

· Made a choice among the alternatives

Although slides are very similar to paragraphs, creating a presentation is different than writing an essay. Effective presentations use few words to convey the most important ideas and concepts. How can you decide what ideas and concepts you should communicate to explain your decision? One effective strategy is to first create an outline of the presentation.
An outline is a general overview of the structure of your presentation. Presenters create outlines to help them decide what main concepts to emphasize and what supporting comments to include. An outline helps you make sure that your expository essay will be interesting and informative. The graphic organizers you used to develop alternatives can help you create an outline.
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Words to Remember

This page gives basic definitions for some important terms that can help you learn about outlining a presentation. You can get a more complete definition of each term from Fact Monster*.

New Words

Type or graphics that work together to create a desired effect; also, study two (or more) people, groups, places, events, ideas, actions, or objects to identify distinctive characteristicsOutline: A general overview or summary of the basic structure of information.
Structure: An arrangement of specific parts in ordered relationships to form a whole.

Review Words

Audience: The people who read a publication or view a work of art, performance, or presentation.
Cause: A person, group, event, idea, action, or object that produces a specific result or outcome.

Classify: Arrange people, groups, places, events, ideas, actions, or objects so that each one is assigned to a category.

Compare: Study two (or more) people, groups, places, events, ideas, actions, or objects to identify shared characteristics.

Concept (or Idea): A thought that combines specific information into a general statement.

Contrast: Type or graphics that work together to create a desired effect; also, study two (or more) people, groups, places, events, ideas, actions, or objects to identify distinctive characteristics.

Conclusion: A judgment, decision, or solution reached for specific reasons.

Data: Information collected by observation or measurement.

Divide: Separate people, groups, places, events, ideas, or things so that each one is placed into a category.

Effect: A specific result or outcome produced by something said or done by a person, group, event, idea, or thing.

Expository: A type of writing that explains a topic or informs an audience.

Fact: Information widely believed to be true and supported by objective data.

Graphics: Using pictures and other visual elements to communicate information.
Information: Anything that can be used to create knowledge. For example, words, numbers, images, audio, and video can all contain information.
Logical: Capable of thinking in a clear and consistent way to draw correct conclusions.

Objective: Able to put aside personal feelings and opinions.
Opinion: Beliefs that may or may not be supported by facts.

Organize: Combine separate pieces of information into a logical whole.

Presentation: An explanation of a topic given in the presence of an audience.
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Learning from the Web

An outline is a general overview of the structure of an essay or presentation. Presenters create outlines to help them decide what main concepts to emphasize and what supporting comments to include. Explore some Web sites about creating an outline. Learn how to craft an effective structure to help you create an interesting and informative presentation.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about outlining an expository presentation, keep those in mind too.

Guiding Questions

· How can you use a word processing application to create an outline?

· How can you distinguish main points from supporting points?

· What ideas and concepts were most important in your decision making?

Web Sites

· Organize Your Ideas* from Fact Monster*

· Outline* from Essay Info*

· Why and How to Create a Useful Outline* from the Online Writing Lab*

· Sample Outline* from the Online Writing Lab*
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What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about outlining an expository presentation. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

How to Outline an Expository Presentation

An outline is used to plan the structure of presentation before you create the slides. The structure of an expository presentation consists of two basic elements—the main points you need to explain your topic; and the supporting points that explain the main points.

You can use a graphic organizer to help you create an outline. Main points are usually the most important concepts you identified in the graphic organizer. Supporting points are smaller concepts or facts and data you used to develop the bigger concepts.

You can use the following steps to create an outline:

1. Identify main points you need to make a decision

2. Determine the most logical order of main points

3. Give each main point a short, descriptive label

4. Identify the supporting points you need to explain each main point

5. Determine the most logical order of supporting points for each main point

6. Give each supporting point a short, descriptive label

You should usually avoid repetition of main or supporting points in the outline. If the outline repeats ideas, the presentation will be repetitive and readers may lose interest. Remember that the purpose of an outline is to help make your presentation as interesting and informative as possible.
An effective outline is easy to read because it uses few words to convey a lot of information. The shorter and more descriptive you make the labels for your main and supporting points, the easier the outline is to read. Try to follow a similar structure for all of your labels. For example, you might label all your main points with headlines between three and five words long and label all supporting points with complete sentences that are less than one line long.

Formatting an Outline

Outlines follow a specific format. The main and supporting points are divided by a system of numbers and letters, followed by a period. The top level of the outline is usually preceded by Roman numerals I, II, III… The second level is usually preceded with capital letters A, B, C…

How many main points you have depends on your topic and the type of expository writing you plan to use. However, all expository presentations should begin with an introduction and end with a conclusion. The introduction should briefly state your topic and the main points you will present to explain your topic.

Here is a sample outline format for an expository presentation:

I. Title

II. Introduction

A. Main Point #1

B. Main Point #2

C. Main Point #3

III. Main Point #1

A. Supporting Point #1

B. Supporting Point #2

IV. Main Point #2

A. Supporting Point #1

B. Supporting Point #2

V. Main Point #3

A. Supporting Point #1

B. Supporting Point #2

VI. Conclusion

< Back to Exploration | Next to Task >

	Type of Page 
	Level 4 Content Page

	Supertitle
	Expository Presentation | Presentation Outline

	Headline Title
	Task


[left-hand nav TEXT]

Vocabulary

Exploration

Information

Task

Quiz

[TITLE HIGHLIGHT BOX 1 ON RIGHT]

Help Guide

[highlight Box TEXT]

Use the Intel® Education Help Guide to learn technology skills.
Word Processing

##Make outline#skillid=WP_4.11##
##Search the Help Guide#skillid=null##
What to Do

Complete the following task to show what you have learned about outlining an expository presentation. While you work through the task, think about whether you are achieving the goal. You may want to review an example of an expository presentation outline before you begin.
Task: Create an outline of your expository presentation.

Goal: Show that you can craft an effective structure for an interesting and informative presentation.

See the example: Microsoft Word* or PDF

1. Start a new word processing document. Always remember to type your name, the date, and a title at the top of the document.

2. Think of a title that describes your presentation. Type a title for the document, such as Outline of __________.

3. Use any graphic organizers you created earlier in the decision making process to help outline your expository presentation.

4. Use the outlining features of your word processing application to outline your presentation.

5. Remember to save your document frequently while you work.

6. Check with your teacher to make sure your outline is effective and correctly formatted.

7. Review the checklist and revise your outline to make sure it is complete.

8. Save your document.

9. Share your outline.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about outlining an expository presentation. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. What is the most important reason to outline an expository presentation before writing?

· Identify the main points you need to explain your topic [Try again. Identifying the main points is one of the steps in creating an outline, but it is not the purpose of creating an outline.]
· Make sure the essay will be interesting and informative [Correct! An outline helps plan a well-structured presentation that will be interesting and informative to readers.]
· Provide a general overview of the essay’s structure [Try again. An outline provides a general overview of a presentation’s structure, but that is not the reason it is important to create an outline.]
2. How can you use an outline to make sure readers do not lose interest in your presentation?

· Avoid repeating any main or supporting points [Correct! Repeating ideas in the outline will lead to writing a repetitive presentation that could lose the audience’s interest.]
· Give all main and supporting points short, descriptive labels [Try again. Short and descriptive labels are a good idea, but another answer is better.]
· Include an introduction and conclusion in the outline [Try again. Including an introduction and conclusion is a good idea, but another answer is better.]
3. Which of the following would be the best label for a supporting point in an outline?

· Pluto’s orbit [Try again. This short phrase provides no information about how Pluto’s orbit is related to any main point.]
· Pluto orbits the sun in an oval shape [Correct! This short sentence gives just enough information to relate Pluto’s orbit to a main point.]
· Pluto has an oval-shaped orbit that takes it closer to the Sun than Neptune at certain times, but it is usually further from the Sun than Neptune. [Try again. This lengthy sentence gives more details than are needed in an outline.]
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Task: Create a visually appealing presentation from your outline.

Goal: Show that you know how to apply graphic design principles to presentation tools.

You may want to review an example of a presentation before you begin.
See the example: Microsoft Powerpoint* | PDF
Key Concept

When you have a live audience, make the most of it! You can use a presentation to show and illustrate the main points of your decision. Your job is to interpret the presentation, give interesting details, and answer questions from the audience. However, a presentation can also be viewed by an audience as if it were a video.

Presentation tools provide the technology you need to create a presentation. Specialized applications help you create and deliver a presentation. Presentation applications are software programs that allow precise control over the appearance and timing of a presentation.

Graphic design provides the knowledge and skills to use technology tools effectively. Graphic design is the art of creating publications and presentations that capture and hold the attention of readers and viewers. Graphic design uses type and graphics to make publications and presentations more visually appealing.

A quality presentation looks good, is easy to read from a distance, and communicates a message. Can you produce a quality presentation? You can when you know the basic principles of graphic design.
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Words to Remember

This page gives basic definitions for some important terms that can help you learn about presentation design. You can get a more complete definition of each term from Fact Monster*.

New Words

Application: A computer program designed for a specific purpose.

Balance: Overall distribution of type and graphics on a page to create a desired effect.

Type or graphics that work together to create a desired effect; also, study two (or more) people, groups, places, events, ideas, actions, or objects to identify distinctive characteristicsGraphic Design: The art of using type and graphics to communicate information with a desired effect.

Peer: A person who is similar to another, as in age, grade, or career.

Presentation Application: A software application designed to create multimedia presentations.

Program: A set of instructions for a computer to perform.

Proximity: How close together type or graphics are arranged in a publication or presentation; usually used in design to create a desired effect.

Repetition: Type or graphics used more than once to create a desired effect.

Revise: Carefully review and improve the content of a creative work.

Software: Any computer program and any information included with the program.

Template: A computer file designed to open a copy of itself by default so its formatted content can be used and modified to create similar documents.

White Space: An area of a publication with no type or graphics.

Review Words

Alignment: Specific arrangement of type and graphics in a publication.

Audience: The people who read a publication or view a work of art, performance, or presentation.
Contrast: Type or graphics that work together to create a desired effect; also, study two (or more) people, groups, places, events, ideas, actions, or objects to identify distinctive characteristics.

Graphics: Using pictures and other visual elements to communicate information.

Organize: Combine separate pieces of information into a logical whole.

Outline: A general overview or summary of the basic structure of information.

Point of View: The way a person tends to think about people, places, and events based on individual experiences.

Presentation: An explanation of a topic given in the presence of an audience.

Structure: An arrangement of specific parts in ordered relationships to form a whole.

Type: A style of letters and numbers used in a publication or presentation.

Word Processing Application: A software application designed to create documents.
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Learning from the Web

How can you make your presentation capture and hold the attention of your audience? Explore some Web sites to learn about presentation tools and graphic design. Learn how to use graphic design to make your presentation more visually appealing.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about presentation design, keep those in mind too.

Some of these Web sites are quite advanced. Do not worry if you cannot understand everything that you read. Exploring every Web site listed is not necessary. Find at least one Web site in each of the three categories that you can explore.

Guiding Questions

· What are the main parts of a presentation?

· How does a presentation application help create these main parts?

· What are the most important points to remember about graphic design?

Web Sites

Presentation Tools

· The 10 Most Common PowerPoint Terms* from About*

· Choosing a Template and Creating a New Slide* from Internet4Classrooms*

· Adding, Moving, and Formatting Text* from Internet4Classrooms*

· The Standard Toolbar* from Internet4Classrooms*

· 10 PowerPoint Tutorials for Beginners* from About*

Graphic Design

· Top 9 Tips for Students* from About*

· 10 Tips for Designing Effective Presentation Visuals* from 3M*
· Principles of Design* from About*

· Examples of Principles of Design* from About*

Special Effects

· Animating Text* from Internet4Classrooms*

· Creating Transition Between Slides* from Internet4Classrooms*

· Add Transitions to PowerPoint Slides* from About*

· Apply an Animation Scheme to a PowerPoint 2003 Presentation* from About*
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Learn how to work with a presentation application.

Read more >
What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about presentation design. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Graphic Design

A quality presentation looks good, is easy to read from a distance, and communicates a message. Creative use of color and fonts can make a presentation more visually appealing. Special effects, such as animations and transitions, can add action and momentum to the presentation. Excessive or inappropriate colors, fonts, and effects can cause an audience to disengage from the presentation.

Six basic design principles can help you create a quality presentation. These principles are guidelines, not rules. Creative graphic designers often “break the rules” to create interesting effects. However, these six principles can help you design a presentation that captures your audience’s attention and is easy to read and understand.

The six principles of graphic design are:

· Alignment makes your presentation easy to see and read. Well-aligned type and graphics complement each other without obstructing other elements.

· Balance sets the tone for a presentation. An even distribution of type and graphics can make a presentation more soothing or serious. An uneven distribution of type and graphics can make the presentation more active or amusing.

· Contrast directs a viewer’s attention to a specific place or idea. Differences in size and appearance of type or graphics can create eye-catching contrast.
· Proximity uses space to show how type and graphics are related. Placing two elements close together suggests a close relationship or agreement. Placing elements far apart shows a weaker relationship or tension.

· Repetition helps a viewer follow the presentation. If every type and graphic looks different, a viewer will get lost quickly. If similar elements have the same look, viewers can follow along easily.

· White space gives a viewer’s eyes a rest. If every inch of a presentation is filled with type or graphics, the viewer may become overwhelmed. White space does not have to be white. It can be any color as long as the space is empty and a reader does not have to focus on it.
Presentation Dos and Don’ts

You can apply the principles of design to what you have learned about presentation tools. Misuse or excessive use of any design element can make a presentation look cluttered, unattractive, and difficult to read or even view. A poor visual design can scramble the message of any presentation, no matter how interesting and informative the content.

Some basic “dos and don’ts” can help you design a quality presentation:

What to Do When You Design a Presentation

· Focus on a single concept on each slide

· Use key phrases from your main points as titles

· Use fewer than five bullet points and keep the text simple

· Use key phrases from your supporting points as bullets

· Maintain a consistent look and feel by repeating colors and fonts

· Use contrasting colors for text and background

· Use fonts that are easy to read from a distance

· Align fonts and graphics so that they are easy to view

· Leave white space and balance the content of each slide

· Add multimedia that conveys information about the topic

· Add special effects when they serve a specific purpose

· Check spelling

· Use consistent punctuation

· Proofread the presentation

What Not to Do When You Design a Presentation

· Put more than one main idea on a slide

· Write long titles that require two lines or a small font

· Use more than five bullet points on a slide

· Try to include every detail on a slide

· Use too many colors or fonts

· Use colors or fonts that are difficult to read from a distance

· Feel like you need to fill up every inch of a slide

· Add multimedia that is unrelated or weakly related to the topic

· Add special effects that disrupt the flow of the presentation

· Think that spelling and punctuation are unimportant in a presentation
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Working with a Presentation Application

Presentation applications have a graphical user interface (GUI). A presentation GUI is very similar to the GUIs in applications you have probably used more frequently, such as word processing applications. The interface provides menus that list the actions a user can take. The GUI also provides icons that represent commands on the menus. Icons are grouped together in toolbars.

The Slide Show menu is one feature that presentation applications do not share with the GUIs of other types of applications. You can use the Slide Show menu to view the show as it will appear when delivered. You can also choose among several options for how the show is delivered. You can record narration for a show if you will not be presenting it in person. Finally, you can create special effects such as action buttons, animations, and transitions.
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What to Do

Complete the following task to show what you have learned about presentation design. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a presentation before you begin.

Task: Create a visually appealing presentation from your outline.

Goal: Show that you know how to apply graphic design principles to presentation tools.

See the example: Microsoft Powerpoint* or PDF

1. Open the word processing document that contains your presentation outline.

2. Start a new presentation.

3. Put the title of the presentation, your name, and the date on the title slide.

4. Use the Insert menu of your presentation application to create slides from the presentation outline you created in a word processing application.

5. Use the Edit and Format menus to clean up your presentation. Make sure all of your main points and supporting points are visible in the presentation. Use your knowledge of graphic design to make sure your presentation is visually appealing.

6. Remember to save your presentation frequently while you work.
7. Check with your teacher to make sure you have correctly inserted, edited, and formatted slides from your outline into your presentation.

8. Exchange presentations with a peer and review each other’s presentations. Your teacher may assign you a partner or may ask you to find a partner.

9. Discuss the improvements you could both make to your presentations. Point out the parts that are attractive and easy to read and the parts that may need to be revised. Try to offer your peer specific suggestions for improvement.

10. Revise you presentation based on feedback from the peer review. Remember to put aside personal feelings and opinions. Consider each suggestion carefully from the peer’s point of view.
11. Check the spelling and grammar of your presentation.
12. Double-check your work by reading your presentation carefully one more time.
13. Review the checklist and revise your presentation to make sure it is complete.
14. Share your presentation.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about presentation design. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. What part of a presentation application’s GUI is not shared by most other applications?

· File menu [Try again. Almost all software applications have a menu that at least includes commands for creating, opening, and saving files.]
· Insert menu [Try again. Most software applications have an Insert menu, although different elements can be inserted into different applications.]
· Slide Show menu [Correct! Presentation applications are based on slides that hold all of the content. The Slide Show menu controls how slides are displayed when you deliver a presentation.]
2. How can you make a presentation easier to read?

· Use contrasting colors for text and background [Correct! Contrasting colors make text easier to read because the text will stand out from the background.]
· Use different font styles, sizes, and colors [Try again. Using different font styles, sizes, and colors can attract a reader’s attention, but it can also make a slide difficult to read or even view.]
· Use key phrases from your main points as titles [Try again. Using key phrases from your main points for slide titles is a good idea, but another answer is better.]
3. How can you make a presentation more visually attractive?

· Do not use too many formatting features [Try again. Limited use of formatting features can make a presentation easier to read, but another answer is better.]
· Use different font styles and sizes [Correct! Different font styles and sizes can attract a reader’s attention.]
· Use one return after a paragraph [Try again. Using one return after a paragraph is a good idea, but another answer is better.]
< Back to Task | Next to Multimedia Management >

[PRORAMMING INSTRUCTIONS]
Please refer to the Quiz Functionality document for more information.

	Type of Page 
	Level 3 Content Page

	Supertitle
	Make Decisions with Data | Expository Presentation

	Headline Title
	Multimedia Management


[left-hand nav TEXT]

Vocabulary

Exploration

Information

Task

Quiz

[TITLE HIGHLIGHT BOX 1 ON RIGHT]

Look Ahead

[highlight Box TEXT]

Task: Find some images, audio, and video on the Internet and add the media to your presentation.

Goal: Show that you can legally and ethically find and use multimedia that enhances your presentation and helps explain your decision.

You may want to review an example of media citations before you begin.
See the example:
Microsoft Word* | PDF
Key Concept

You can use a multimedia presentation to explain your decision in a way that is entertaining as well as interesting and informative. A multimedia presentation uses words, numbers, images, audio, and video to explain a topic. Each type of media comes in many different formats. Do you know how to manage multimedia files?

Many Web sites contain images, audio, and video. Some sites are great sources of clip art multimedia. Most search engines allow you to look for images and video specifically. To search for images and video, you use keywords just like any other search, but you instruct the search engine to find images or videos only. Your hits are images or videos instead of Web pages.

Copyright laws protect the rights of people who create original works. You can make limited use of copyrighted work for certain purposes. You usually do not need permission for limited use in school projects. You usually do need permission if you want to show your presentation to an audience outside of school.

Most images, audio, and video on the Web are copyrighted. Do you know how you can and cannot use copyrighted works? Learn when you can use an image, audio, or video without permission. Find out how to get permission to use copyrighted multimedia in your presentation. Whenever you have any doubts about whether you need permission, you should get it.

Next to Vocabulary >

[PRORAMMING INSTRUCTIONS]
The content below is available for translation and located on the Technology Literacy File Sharing site under the Content and Files Tab > Explain > Make Decisions with Data Examples

	Microsoft* Word


	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/EP_MultimediaManagement_Example.doc

	PDF
	http://download.intel.com/education/common/country_code/resources/TechnologyLiteracy/Explain/DecisionsWithData/EP_MultimediaManagement_Example.pdf


	Type of Page 
	Level 4 Content Page

	Supertitle
	Expository Presentation | Multimedia Management

	Headline Title
	Vocabulary


[left-hand nav TEXT]

Vocabulary

Exploration

Information

Task

Quiz

Words to Remember

This page gives basic definitions for some important terms that can help you learn about managing multimedia. You can get a more complete definition of each term from Fact Monster*.

New Words

Compress: Change how data is stored so it takes up less space on a computer.

Copyright: Law that prohibits any creative work from being used without permission.

Download: Transfer a file from another computer to your computer.

Extension: A period and letters attached to the end of a filename indicating the file’s format.

Fair Use: Limited use of a copyrighted work for certain purposes, such as education.

Format: A specific way to store a particular kind of data in a computer.

Multimedia: Combining more than one type of information, such as words, numbers, images, audio, and video.

Public Domain: Creative works that may be used without permission because the copyright has expired.

URL (Uniform Resource Locator): The address of a Web page consisting of the protocol and domain name and sometimes the path and filename.

Review Words

Application: A computer program designed for a specific purpose.

Audience: The people who read a publication or view a work of art, performance, or presentation.

Graphics: Using pictures and other visual elements to communicate information.

Graphic Design: The art of using type and graphics to communicate information with a desired effect.

Multimedia: Combining more than one type of information, such as words, numbers, images, audio, and video.

Peer: A person who is similar to another, as in age, grade in school, or career.

Plagiarism: Copying or making slight changes in a written or created work and presenting it as a new or original work.

Point of View: The way a person tends to think about people, places, and events based on individual experiences.

Presentation: An explanation of a topic given in the presence of an audience.

Presentation Application: A software application designed to create multimedia presentations.

Program: A set of instructions for a computer to perform.

Revise: Carefully review and improve the content of a creative work.

Software: Any computer program and any information included with the program.

Type: A style of letters and numbers used in a publication or presentation.

Word Processing Application: A software application designed to create documents.
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Learning from the Web

Multimedia can help you make a presentation entertaining as well as interesting and informative. More importantly, images, audio, and video can communicate a lot of information very quickly. Explore some Web sites about managing multimedia. Learn how different formats are appropriate for different purposes and when you can use copyrighted media without permission.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about managing multimedia, keep those in mind too.

Some of these Web sites are quite advanced. Do not worry if you cannot understand everything that you read. Exploring every Web site listed is not necessary. Find at least one Web site in each of the three categories that you can explore.

Guiding Questions

· What kinds of multimedia can enhance your presentation?

· When does fair use allow you to use copyrighted images, audio, or video?

· When should you get permission to use copyrighted images, audio, or video?

Web Sites

Multimedia File Formats

· File Formats and Extensions* from Learn the Net*

· Image File Formats* from A Few Scanning Tips*

· How to Download Files* from Learn the Net*

· How MP3 Files Work* from How Stuff Works*

Copyright and Fair Use

· Copyright Questions and Answers* from CyberBee*

· Copyright Kids* from The Copyright Society of the U.S.A*

· Fair Use in the K–12 Digital Classroom* from Gayle’s Electronic Classroom*

Adding Multimedia to a Presentation

· Inserting an Image into a Slide* from Internet4Classrooms*

· Using Sound in a Slide Show* from Internet4Classrooms*

· Insert a Picture into a PowerPoint Slide* from About*

· Moving and Resizing Pictures and Text Boxes in PowerPoint* from About*
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What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about legally and ethically using different multimedia formats. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Multimedia File Formats

Not all computer files are the same. Every file is stored in a particular format. Different kinds of data usually use different formats. File extensions tell you what kind of format a file uses. When you download a file from the Web, you should pay attention to the format. All formats are good for some purposes but not for others.

· Images can be saved in many formats. Most of the images you find on the Web are GIF or JPEG (or JPG) files. GIF is better for storing simple graphics, while JPEG is better for storing photographs or complex graphics. PNG is another format that is becoming more popular. TIF (or TIFF) is the most common format for print publications.

· Audio, like images, can be saved in many formats. Most audio formats were developed for either the Mac or Windows operating system. However, players are available to support most formats on both platforms. One audio format that almost everyone is familiar with is MP3. MP3 is popular because it can store CD-quality music in relatively small files that can easily be played on a Mac and Windows operating system.

· Video also can be saved in many formats, usually developed for either the Mac or Windows operating system but playable on both platforms. AVI and Windows Media Video are two common formats for the Windows operating system. QuickTime is a popular video format for the Mac operating system. MPEG is a video format from the same organization that developed the MP3 audio format. Unlike image and audio formats, no video format appears to be the most popular format on the Internet.
Copyright and Fair Use

Copyright laws protect the works of authors, artists, musicians, and others who produce original creations. Copyrights prevent others from changing creative works without permission and claiming the works as their own. Copyright laws also prevent people from profiting from other people’s work without permission. You must assume that a work is copyrighted even when it is not marked with a copyright symbol ©.

Fair use allows limited use of copyrighted works without permission. While no clear and specific rules exist for fair use in all cases, you can follow some accepted guidelines for school projects. You can use copyrighted works without permission in your school projects.
The limits to using copyright works without permission for school projects are:
· You may use up to five images created by the same person.

· You may use a maximum of 15 images or 10 percent of the total images in a collection (whichever is less).

· You may use a maximum of 30 seconds of audio or 10 percent of the audio’s total running time (whichever is less). For music, this limitation applies to the words in a song as well as the sound.

· You may use a maximum of 3 minutes of a video or 10 percent of the video’s total running time (whichever is less).

· Fair use for a school project expires two years after the project is completed.

Fair use only applies to audiences within your school. It does not apply to a school project that is shared with an audience outside your school. For example, fair use would not apply if your teacher posted your multimedia presentation on your school’s Web site. You must get permission to use any copyrighted images, audio, or video before you share a school project with an outside audience.

You should always give credit to the creator of an image. You cite the source of an image, audio, or video just as you cite the author of a text. Sometimes, the creator of a work gives advance permission for specific uses. Most Web sites have copyright statements that explain their policies. They also provide contact information in case you need to get permission.
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Working with Multimedia Files

Not all computer files are the same. Every file is stored in a particular format. Different kinds of data usually use different formats. File extensions tell you what kind of format files use. When you download a file from the Web, you should pay attention to its format. All formats are good for some purposes but not for others.

Image Formats

· GIF (Graphics Interchange Format) is a good format for very simple graphics and graphics with transparent, or cut out, areas. GIF images are used for graphics that do not have many colors or much detail, such as logos and page banners. All modern web browsers display GIF files.

· JPG or JPEG (Joint Photographic Experts Group) provides adjustable quality images. JPG images can support many colors and are often used to show pictures in Web pages. This format enables you to compress images by removing data. All modern web browsers display JPG files. JPG is a good image format to use when both image quality and small file size are important.

· PNG (Portable Network Graphics) provides high quality images and supports transparent, or cut out, areas. It does not remove data during compression. Most web browsers can display PNG images. PNG is a good choice when image quality is important.

· TIF or TIFF (Tagged Image File Format) provides very high quality images. This format is a good choice for storing images and for print publications. Web browsers do not usually display TIF files.

Audio Formats

· AIFF (Audio Interchange File Format) is a very high quality audio format that was developed by Apple. It is not a common audio format on the Internet because files sizes are relatively large, but it is often used in recording sound because it can be easily converted to other formats.

· MP3 (MPEG-1 Layer 3.) is probably the most popular audio format on the Internet. It is popular primarily because it can store CD-quality music in relatively small-sized files. MP3 is also multiplatform, which means it works easily on a Mac and Windows operating system.

· WAV (Waveform) was an early and very common audio format for the Windows operating system, but it can also be used on a Mac. It is not a common audio format on the Internet because uncompressed WAV files can be very large.

· WMA (Windows Media Audio) is a relatively new audio format developed by Microsoft for the Windows operating system. It can provide high quality sound in compressed file sizes, but is not as common as MP3.

Video Formats

· AVI (Audio Video Interleave) is a common video format for the Windows operating system. Like the WAV audio format, its relative large file sizes have made it less popular as the Internet has become the most common way to distribute multimedia.

· MOV or QT (QuickTime Movie) was created by Apple and included with every Mac. Apple also developed a player for QuickTime that runs on Windows. You can play a QuickTime movie on a Windows operating system, if the player has been downloaded and installed.

· MPG or MPEG (Motion Picture Experts Group) is a video format from the same organization that developed the MP3 audio format. The MPEG standard has different versions. MPEG-1 is a relatively common video format on the Internet because its compression produces small files. In fact, MP3 is the audio layer in MPEG-1.

· WMV (Windows Media Video) is a relatively new video format developed by Microsoft for the Windows operating system. Microsoft also developed a player for Windows Media for the Mac operating system. You can play a WMV file on a Mac, if the player has been downloaded and installed.
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What to Do

Complete the following task to show what you have learned about managing multimedia. While you work through the task, think about whether you are achieving the goal. You may want to review an example of media citations before you begin.
Task: Find some images, audio, and video on the Internet and add the media to your presentation.

Goal: Show that you can legally and ethically find and use multimedia that enhances your presentation and helps explain your decision.

See the example: Microsoft Word* or PDF

1. Start a new word processing document. Always remember to type your name and the date at the top of a new document.

2. Use one of the Web sites or search engines below to find multimedia. The media should help to explain how you defined your decision, gathered information, developed alternatives, evaluated alternatives, and made a choice.

Clip Art Sources

· Discovery School's Clip Art Gallery* from Discovery School*

· Clipart for Kids* from Kidz Page*

· Classroom Clipart*

Image Search for Kids

· KidsClick! Picture Search Tools*

· Pics4Learning*

Image Search for Everyone

· Yahoo Image Search*

· Google Image Search*

Multimedia Links

· Clip Art and Media* from Microsoft*

· Online Speech Bank* from American Rhetoric*

· American Memory Project: Sound Recordings* from Library of Congress*

· American Memory Project: Motion Pictures* from Library of Congress*

· Graphics* from Internet4Classrooms*

3. Download the media to your computer. Ask your teacher for help if you are not sure where to save the files. Find at least three images and one audio or video clip.

4. Add the media to your word processing document. For each image or clip, you should:

· Cite the source of the media, including the URL

· Briefly explain how the media can help explain your decision

· Record the copyright status of each image, audio, or video you find

5. Remember to save your document often while you work.

6. Discuss the following points with your teacher:

· How the media you found can help explain your decision

· If you need to get permission to use any of the media

· How you can get permission from the creators of the media

7. Once you have any necessary permissions, insert the media into to your presentation. Use your knowledge of graphic design to make sure the media enhances your presentation and helps explain your decision.

8. Exchange presentations with a peer and review each other’s presentations. Your teacher may assign you a partner or may ask you to find a partner.

9. Discuss what you and your peer could do to improve your presentations. Point out the media that are most effective and the media that may need to be removed or replaced. Try to offer your peer specific suggestions for improvement.

10. Revise you presentation based on what you learned from the peer review. Remember to put aside personal feelings and opinions. Consider each suggestion carefully from the peer’s point of view.
11. Check the spelling and grammar of your presentation.
12. Double-check your work by reading your presentation carefully one more time.
13. Review the checklist and revise your presentation to make sure it is complete.
14. Share your presentation.
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about managing multimedia. Your answers are not recorded, and the quiz is not scored.
Please read all possible answers first, and then choose the best answer.

1. How can you tell in what format a computer file is stored?

· File extension [Correct! The letters after the period in a filename designate the format of the file.]
· File compression [Try again. The format may tell you how a file is compressed, but you cannot observe file compression directly.]
· Filename [Try again. A filename should describe the content of a file, but it does not tell you the format of the file.]
2. What does fair use allow you to do without permission?

· Use any copyrighted video in a school project [Try again. Fair use of copyrighted video is limited, even for school projects.]
· Use a limited clip from a copyrighted video in a school project [Correct! You may use up to 3 minutes of a video or 10 percent of the video’s total running time, whichever is less.]
· Use a limited clip from a copyrighted video for any purpose [Try again. Fair use usually only applies to education or nonprofit purposes.]
3. When should you cite the source of an image, audio, or video you use in a school project?

· You should always cite the source of an image, audio, or video [Correct! You should cite the source of any image, audio, or video, whether it is copyrighted or not.]
· You should cite the source of an image, audio, or video if it is copyrighted [Try again. You should cite the source of a copyrighted image, audio, or video, but another answer is better.]
· You should cite the source if you use the entire audio or video [Try again. You should cite the source after you get permission to use the audio or video, but another answer is better.]
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Task: Deliver your multimedia presentation to an audience.

Goal: Show that you can explain decision making by delivering an interesting, informative, and entertaining multimedia presentation.

You may want to review an example of a final presentation before you begin.
See the example:
Microsoft Powerpoint* | PDF
Key Concept

How can you make sure your presentation is a success? For many people, speaking in front of an audience can be challenging and intimidating. Delivering a multimedia presentation to an audience is a performance—and you are the star!

What is the secret to delivering an interesting, informative, and entertaining presentation? Of course, delivering a successful presentation has no secrets! Anyone can deliver a successful presentation by following some basic guidelines.

Preparation is the most important part of any performance. How can you prepare to deliver a multimedia presentation? First, you can review and revise the presentation, and that includes spell checking and proofreading your slides. Then, you can practice, practice, practice! Finally, you can make sure you know how to use all the equipment you will need to conduct your presentation.
If you are well-prepared when the big day comes, you just have to do what you practiced. You should not be uncomfortable because you are prepared for anything. Speak to your audience in a professional but conversational tone, as if you were just explaining the topic to your teacher.
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Words to Remember

This page gives basic definitions for some important terms that can help you learn about delivering a presentation. You can get a more complete definition of each term from Fact Monster*.

New Words

Conversational: A casual or informal manner of exchanging information or ideas.
Hardware: Any physical device that is part of computer or can be used with a computer.

Input: Data entered into a computer.

Output: Data produced by a computer.

Peripheral: Any device that can provide input to a computer or accept output from a computer.

Review Words

Application: A computer program designed for a specific purpose.

Audience: The people who read a publication or view a work of art, performance, or presentation.

GUI (Graphical User Interface): A set of menus and icons that makes an application easier for people to use.

Icon: A picture that represents a specific action for a computer to take.

Multimedia: Combining more than one type of information, such as words, numbers, images, audio, and video.

Presentation: An explanation of a topic given in the presence of an audience.

Presentation Application: A software application designed to create multimedia presentations.

Professional: Meeting standards of behavior appropriate for work places.

Program: A set of instructions for a computer to perform.

Software: Any computer program and any information included with the program.
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Learning from the Web

Explore some Web sites and delivering a multimedia presentation. Learn how to prepare and practice to make sure your presentation is interesting, informative, and entertaining.

While you explore the following Web sites, think about the guiding questions. You may want to take notes to help you answer the questions. If you think of other questions about delivering a presentation, keep those in mind too.

Guiding Questions

· How can you prepare to deliver a successful presentation?

· What should you try to accomplish during your presentation?

· What should you try to avoid during your presentation?

· What is a peripheral and what do all peripherals have in common?

Web Sites

Presenting

· 12 Tips for Delivering a Knockout Business Presentation* from About*

· How to Lose an Audience in 10 Easy Ways* from About*

Hardware Tools

· Multimedia Projectors* from Vivid Light Photography*

· How USB Ports Work* from How Stuff Works*

· How to Connect an LCD Projector* from Bernie School District*

· Setting up Your Projection Device* from Chimacum Middle School*
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What to Know

This page summarizes some of the information from the Web sites you explored. This information helps you learn what you need to know for this activity about delivering a presentation. You may want to take notes to help you remember the most important points. You can return to the Web sites for more exploration if you want to learn more.

Hardware Tools

Delivering a multimedia presentation to an audience requires a projection device connected to a computer. A projection device is an example of a peripheral, a device that can provide input to a computer or accept output from a computer.

· Projection. The most common type of multimedia projection device is the LCD (Liquid Crystal Display) projector. Other types common include DLP (Digital Light Processing) and RGB (Red, Green, Blue) projectors. You can also use a television monitor to display a presentation for a smaller audience. For any kind of projection device, the most important qualities are brightness and resolution. Brightness is measured in lumens, a standard measure of light. More lumens mean a brighter picture that is easier to see. Resolution is measured in pixels, an abbreviation of picture elements. More pixels mean a clearer and sharper image.

· Universal Serial Bus (USB). Projectors and other peripherals must be connected to a computer to provide input or accept output. In the past, peripherals used various types of connections, such as parallel ports, serial ports, and S-Video ports. Today, USB technology provides a single, high-speed port for any kind of peripheral. USB cables have an A connector that plugs into the computer and a B connector that plugs into the peripheral. As a result, incorrectly connecting a USB device to a computer is nearly impossible. USB devices are also plug-and-play and hot-swappable. Plug-and-play means that a peripheral is configured automatically when you plug the device into a computer. Hot-swappable means you can plug and unplug the peripheral while the computer is running.

Preparing to Deliver a Presentation

Do the following before delivering your slideshow presentation:

· Choose Slide Sorter from the View menu

· Make sure all your slides are logically ordered

· Make sure you can find all your main points quickly
· Run the slide show from either the View or Slide Show menu

· Make sure all special effects work as expected

· Check your visual design for places where the audience could lose interest

· Check your spelling and proofread each slide
· Practice delivering the presentation in front of a mirror or a friend or trusted adult

· Use the View menu to add any notes you need

· Give the presentation as if you were in front of your real audience

· Try to anticipate what questions your audience might ask

· Practice responding to questions

· Make sure that you can stop the presentation jump around among slides

· Time yourself and include time for questions and answers
· Make sure you know how to connect and use the projector

· Set the projector up in the room if you can

· Put the presentation file on the computer connected to the projector

· Make a backup copy of the presentation on a flash drive

· Print your notes pages in case the projector fails

Delivering a Presentation

Be sure to do the following on the day of your presentation:

· Wear appropriate clothing
· Be prepared to give your presentation at any time
· Speak to your audience in a professional but conversational tone
· Summarize the main points on your slides instead of reading from them or reciting them from memory
· Make eye contact with audience members
· Watch your audience to make sure they are understanding your presentation
· Watch the time and try to stay on the schedule you practiced
· If you get behind, do not try to catch up by talking faster
· If you need to make up time, omit some of the less important points
· Remember that audience attention is highest during the introduction and conclusion
· Remember that you audience is more interested in main points than in details
· Emphasize each main point to keep your audience interested
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What to Do

Complete the following task to show what you have learned about delivering a presentation. While you work through the task, think about whether you are achieving the goal. You may want to review an example of a final presentation before you begin.
Task: Deliver your multimedia presentation to an audience.

Goal: Show that you can explain decision making by delivering an interesting, informative, and entertaining multimedia presentation.

See the example: Microsoft Powerpoint* or PDF

1. View your presentation as a slideshow and make any adjustments needed.

2. Check spelling and proofread your presentation.

3. Practice delivering your presentation.

4. Make sure that you know how to connect and use a projection device.

5. Deliver your presentation to an audience.

6. Discuss your presentation with someone who was in the audience. Discuss the viewer’s reaction to your presentation. You may want to ask the following questions during your discussion.

· What parts had the most and least visual appeal?

· Were any parts difficult to read or understand?

· What did the viewer learn from your presentation?

· What parts of the presentation did the viewer find most and least interesting?

· What questions did the viewer have that were not answered in your presentation?
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Check Your Understanding

Did you learn the important ideas in this activity? This quiz helps you demonstrate what you learned about delivering a presentation. Your answers are not recorded, and the quiz is not scored.

Please read all possible answers first, and then choose the best answer.

1. What is the most important advantage of the Universal Serial Bus?

· A USB allows many different peripherals to be connected to the same port. [Correct! USB can replace the many different kinds of ports that various peripherals used to require.]
· A USB has different connectors for the computer and the peripheral. [Try again. This is an important advantage but it is not unique to USB; another answer is better.]
· A USB can project a brighter image that is easier to see. [Try again. Brightness is determined by the projection device, not by how it is connected to a computer.]

2. What part of a presentation application’s GUI can you use to make sure your slides are logically ordered?

· View [Correct! you can use the View menu to run the slideshow as it will be displayed for delivery, see all slides on one screen, and change the order of slides.]
· Insert menu [Try again. You can use the Insert menu to add slides or media to a presentation, but it does not help make sure slides are logically ordered.]
· Slide Show menu [Try again. You can use the Slide Show menu to view the presentation as it will be displayed for delivery, but you cannot use it to change the order of slides.]
3. Which of the following is something you should do when delivering a presentation?

· Make eye contact with the audience [Correct! Making eye contact helps establish a conversational tone, as if you were speaking only to one or two people.]
· Read your slides to the audience [Try again. You should never read your slides; your audience can read the slides themselves unless your presentation is poorly designed.]
· Talk faster if you get behind [Try again. If you need to make up time, you should omit some of the less important points you planned to make.]
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Thinking about Learning

What have you learned in this module? You explored the expository style of writing and how it can be used in presentations. You outlined and created an interesting and informative presentation that is attractive and easy to read. You learned how to manage different multimedia file formats and use multimedia legally and ethically. You created, prepared, and delivered an expository presentation to a live audience.

You have learned:

· How to use expository nonfiction in a presentation

· How to outline an interesting and informative presentation

· How to create an attractive and easy-to-read presentation from your outline

· How to enhance your presentation by adding multimedia legally and ethically

· How to deliver an interesting, informative, and entertaining presentation
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Checklist for Expository Presentation
A checklist can help you keep track of your work throughout the activity. Have you completed the task in each activity? Use the checklist to make sure you are ready to share your presentation with an audience. Ask your teacher for help if you have any questions about the checklist.
Activity 1: Expository Nonfiction

Task: Expository Analysis

· Look at an example of an expository presentation

· Open a new word processing document and type your name, date, and a title

· Write two or three paragraphs explaining how the presentation uses the expository style of writing, by:

· Citing specific instances of effective (or ineffective) expository writing

· Explaining what types of expository writing the presentation uses

· Explaining what you learned from the presentation

· Check the spelling and grammar in your paragraphs

· Save your analysis

Activity 2: Presentation Outline

Task: Expository Presentation Outline

· Open a new word processing document and type your name, date, and a title

· Create an outline using your graphic organizer you created earlier in the decision making process

· Use an outline format with:

· A title

· An introduction

· At least three main points in a logical order

· Supporting points for the main points in a logical order

· A conclusion

· Make sure that labels are short, descriptive, and written in a consistent manner

· Check that you have not repeated ideas

· Save your document

Activity 3: Presentation Design

Task: Presentation

· Open your presentation outline

· Start a new slideshow presentation and type your name and the date on the title slide

· Use the Insert menu to create slides from your presentation outline

· Use the Edit and Format menu to make sure your main and supporting points are clear

· Use graphic design principles to make your presentation visually appealing

· Exchange presentations with a peer and review each other’s work, making sure to:

· Provide positive feedback: point out the parts that are attractive and easy to read

· Provide specific suggestions for improvement: point out the parts that may need to be 
revised

· Review the peer review of your presentation

· Revise your presentation based on the feedback

· Check the spelling and grammar of your presentation

· Save your presentation

Activity 4: Multimedia Management

Task: Media Citations

· Open a new word processing document and type your name, date, and a title

· Find at least three images and one audio or video clip on the Web that helps to explain how you defined your decision, gathered information, developed alternatives, and made a choice

· Download the media to your computer

· Add the media to your word processing document

· For each image or clip:

· Cite the source

· Explain how the media helps explain your decision

· Record the copyright status

· Get permission for any of the images, audio, or video if necessary

· Insert the media into your presentation, using graphic design principles to enhance your presentation

· Exchange presentations with a peer and review each other’s presentations, making sure to:

· Provide positive feedback: point out the media that are most effective

· Provide specific suggestions for improvement: point out the media that may need to be 
removed or replaced

· Review the peer review of your presentation

· Revise your presentation based on the feedback

· Check the spelling and grammar of your presentation

· Save your presentation

Activity 5: Presentation Delivery

Task: Final Presentation

· Open your presentation

· Check the spelling and proofread your presentation

· Practice delivering your presentation, remembering to:

· Review your slide order

· Run the slideshow from View or Slide Show menu to make sure your slides are ready to present

· Practice in front of a mirror, a friend, or an adult

· Make sure you know how to connect and use a projector

· Set up a projection device

· Deliver your presentation to an audience, making sure to:

· Dress appropriately

· Summarize and emphasize the main points

· Make eye contact

· Make sure your audience understands everything

· Stay on schedule

· Answer questions

· Get feedback from someone in the audience by asking:

· What parts had the most and least visual appeal?

· Were any parts difficult to read or understand?

· What did the viewer learn from your presentation?

· What parts of the presentation did the viewer find most and least interesting?

· What questions did the viewer have that were not answered in your presentation?
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Rubric for Expository Presentation
The main purpose of a rubric is to help you do your best work. What column best describes your presentation? Is all of your work best described by column 4? If not, what could you improve?
	
	4
	3
	2
	1

	Outline
	The outline clearly shows the relationships among main points and supporting points. 
	The outline consistently distinguishes main points and supporting points, and shows relative importance of relationships.
	The outline distinguishes most main points and supporting points related to research questions, but does not show relative importance of relationships.
	The outline does not relate to research questions or does not distinguish main points and supporting points.

	Content
	The presentation thoroughly captures and holds the audience’s attention.

The presentation explains the decision in a smooth and logical order, and offers a new viewpoint or insight in a way that makes a lasting impression on the audience.
	The presentation adequately captures the audience’s attention.

The presentation explains the decision in a smooth and logical order, and offers a new viewpoint or insight; however, the content may not make a lasting impression on the audience.
	The presentation does not capture the audience’s attention throughout.

The presentation clearly states, adequately explains, and summarizes the decision; however, the content may not be engaging or may not be presented in a smooth and logical order.
	The presentation does not capture the audience’s attention.

The presentation does not clearly state, adequately explain, or summarize the decision.



	Design
	Slide layouts are consistent and easy to read, and use a variety of design principles to attract and hold interest.
	Slide layouts are consistent and easy to read, but may not use design principles to attract and hold interest.
	Slide layouts are consistent, but may be too plain to hold interest or too cluttered for the audience to read.
	Slide layouts are not consistent and may be too plain to hold interest or too cluttered for the audience to read.

	Multimedia
	Images, audio, and video enhancements are credited, support and illustrate main points, and enrich the audience’s learning experience.
	Images, audio, and video enhancements are credited and carefully selected to support and illustrate important main points.
	Images, audio, or video enhancements are not credited or sometimes distract the audience from the content.
	Presentation does not include images, audio, or video enhancements.

	Delivery
	Presenter maintains consistent eye contact, rarely refers to notes, and frequently interacts with the audience.
	Presenter makes frequent eye contact, sometimes refers to notes, and answers most questions.
	Presenter frequently refers to notes but makes some eye contact and answers some questions.
	Presenter does not make eye contact, reads from notes, or does not answer questions.

	Mechanics
	All multimedia and effects work properly, and technical problems do not occur.

All words are spelled and capitalized correctly.
	Most multimedia and effects work properly, and technical problems are resolved quickly.

Almost all words are spelled and capitalized correctly.
	Most multimedia and effects work properly, but technical problems interrupt the presentation.

Several words are misspelled or capitalized incorrectly.
	Multimedia or effects do not work properly, or technical problems make the presentation difficult to understand.

Many words are misspelled and capitalized incorrectly.

	File Management
	Files are clearly named, consistently saved to the correct location, and well-organized in folders.
	Files are clearly named and consistently saved to the correct location, but they are not well-organized in folders.
	Work is not lost, but files are not clearly named or not consistently saved to the correct location.
	Work is lost because files are not clearly named or not consistently saved to the correct location.
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Reflection on Expository Presentation
How can you make sure you really understand something? One of the best ways is to explain it to someone else. You might talk to another student, a teacher, or someone in your family.

Be prepared to discuss:

· Why most presentations are examples of expository nonfiction

· What you learned about presentation tools and graphic design

· What you learned about managing multimedia legally and ethically

· How you prepared to deliver your multimedia presentation
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